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LETTER FROM THE EDITORS
Dear Reader,   

Welcome to Lessons in Conservation, the official journal of the Network of Conservation Educators and 
Practitioners (NCEP). NCEP is a collaborative project of the American Museum of Natural History’s Center for 
Biodiversity and Conservation (CBC) and partners from around the world. This journal is designed to introduce 
NCEP’s open-access teaching and learning resources (our “modules”) to a broad audience. NCEP modules are 
written for undergraduate and professional level education. The modules featured in this issue—and many more 
on a variety of conservation related topics—are freely available for download on our website, ncep.amnh.org.

In this issue, we explore the intersection of technology and conservation. In the opening editorial, our guest 
editor Dr. Anthony Giordano sets the stage for this exploration through a review of the changing and growing role 
of technology in the conservation field. Anthony’s personal reflections also highlight just how much technology 
has changed conservation practice—and the lives of conservationists. With the expansion of acoustic and visual 
monitoring tools; the growing application and accessibility of spatial tools such as GPS, GIS, and remote sensing; 
and the increasing power of genetic techniques for biodiversity research, and potentially to engineer organisms 
around us; it is fundamental to promote technological literacy among our students. Students should be familiar 
with these technologies, including not only how to use them, but also whether, when, and where to use them, and 
how to manage the massive amounts of data they produce. 

This issue features six student-facing educational resources including four exercises that allow instructors to 
familiarize students with these challenges. These exercises encompass software that can assist with marine 
spatial planning and modeling species distributions, new technologies for acoustic monitoring of bats, and 
genetic monitoring of marine areas using environmental DNA. Through active learning techniques, the exercises 
help students learn about the biodiversity of Caribbean and Hawaiian islands, urban settings, and even important 
conservation monitoring approaches by applying them to imaginary creatures. Importantly, in addition to having 
students manipulate and analyze real and realistic data, the exercises also foster reflection and critical thinking 
on the remarkable potential and realistic limitations of these technologies. 

NCEP materials are meant to be modifiable for each teacher’s specific 
classroom or training needs; adaptable Microsoft Word versions of 
these modules are available for download at ncep.amnh.org along with 
accompanying teaching notes, exercise solutions, and links to other 
relevant open educational resources. We welcome any feedback on our 
materials and encourage those who are interested in becoming more 
involved to contact us for further information. We are grateful to many 
people at the CBC and NCEP for their time and input to the development 
of this issue. 

We hope you enjoy this issue of Lessons in Conservation and encourage 
you to visit our website to start using the full collection of NCEP 
resources in your classroom! 

Questions and feedback are welcome at ncep@amnh.org.
 

Anthony J. Giordano

Co-Editor

Ana Luz Porzecanski

Co-Editor

http://ncep.amnh.org
http://ncep.amnh.org
mailto:ncep%40amnh.org?subject=
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More Than Bells & Whistles: A Perspective on the Role of 
Technology and Innovation in Expanding the Conservation 
Toolbox
Anthony J. Giordanoi,ii

iS.P.E.C.I.E.S. – The Society for the Preservation of Endangered Carnivores and their International Ecological Study, Ventura, CA, USA; iiAmerican Mu-
seum of Natural History, New York, NY, USA

On a hillside not far from the coast of Jalisco (Mexico), I slowly made my way through the dense understory of 
a tropical dry forest. It was the mid-1990s, and I was part of a team of volunteers collecting population data on 
a unique carnivore community in the country’s Agave State. The Biosphere Reserve was (and still is) habitat for 
bobcats and coyotes, ocelots and jaguarundis, foxes and coatimundis, and of course, jaguars and pumas—the real 
reason the younger me was there. One of about five or six volunteer field assistants, every morning I set out in a 
new direction as the group rotated activities, each day hoping I was the one who would return with the newest 
ecological insights. That morning, I had already hiked seven kilometers from our research station across very 
uneven terrain. My objective at that moment was to check a new sampling unit in an ecological study: the latest 
advancement in wildlife survey technology. Rounding a trail bend, my eyes fell to the fresh animal tracks emerging 
from a narrow path in the forest. They were fresh jaguar tracks; of that, I had no doubt. Looking up, I saw the unit 
was only about 40 meters away, and the tracks led right to it. Flush with renewed enthusiasm as I approached, I 
couldn’t help but notice how out of place this plastic contraption was among the dusty thorns and fallen leaves. 

Far from stealthy, this new system was quite an ingenious design, one that was increasingly being used to 
monitor mammal populations around the world. Mounted trailside on a 12 meter tall tree with smooth bark was 
a camera in casing so clunky, it appeared ready for deep sea exploration. Under the camera sat a rectangular 
digital transmitter with a blinking red indicator light. Across the trail was a receiver with a window displaying 
the large, analog numerals typical of the day’s digital technology, its alignment squared up perfectly with the 
transmitter. These integrated devices were becoming widely known by biologists as an “active camera-trap,” a 
sampling platform that could record the passage of an animal remotely if it broke or “tripped” the beam between 
the transmitter and receiver (Kucera and Barrett 1993; Sweitzer et al. 1996; Hernandez et al. 1997a,b; Kucera and 
Barrett 2011). Placed on trails in just the right spot, camera-traps could finally yield photos of the most cryptic, 
endangered, or low-density mammals in far-flung tropical forests that too regularly eluded wildlife biologists 
(Griffiths and van Schaik 1993; Karanth 1995). Because each photo was an unequivocal record of that species 
in time and space, combined they constituted the key ingredients of a successful population or community-
level ecological analysis. That was the prevailing theory at least. As I removed the roll of film and swapped it 
with a fresh undeveloped cartridge, careful to wipe off any dirt, my mind turned to the possible images that sat 
unexposed in my hand. 

Back at the reserve’s headquarters later that afternoon, I was reluctant to throw my film into the community heap 
forming on the table. I had put it in a clearly marked bag of course, to indicate which camera-trap the film had 
come from, so there was no danger it would get lost in the shuffle. Having seen the tracks earlier that morning, I 
was confident that my camera-trap recorded something special. My anxious glances to the pile must have given 
me away, because one of the principal investigators right then asked me if I wanted to accompany them the next 
day to process the film. Despite a 200 km round-trip across rural Mexico (or because of it?), I was game. I just 
had to be among the first to know.

The next day, we were off to pick up supplies and develop the film. I sat in the back of the 4WD pick-up truck, 
steadying myself during hairpin turns along the road’s cliffside. Early commercial camera-traps were as cost-
ineffective (e.g., US $500–600) as they were unwieldy (Cutler and Swann 1999; Swann et al. 2004), and since 
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each of the 20 or so units burned through about 6–8 batteries every two to three weeks, batteries were at the top 
of our shopping list. A few hours before sunset we stopped to retrieve the photos, ready to head back. As I recall, 
I snatched the small Kodachrome folder of 4” x 6” photo prints from the counter and got halfway back to the 
truck in the time it took me to say thanks to the store owner. 

We had hardly pulled the truck forward before I was snapping photo prints onto the plastic dashboard console 
in front of me, one atop the other. The first photo was of the trailside directly in front of the camera, the dry 
forest in the background and small, dense thorn scrub bushes and grasses at the forefront. No animal in the 
frame—the photo was empty. Confused, I quickly snapped down another photo on top of that one. Same thing—
empty. So was the next photo. And the one after that. Surely we recorded something, I thought. My heart began 
to sink after I made it through about three-quarters of the roll and then, Photo 32. Taking up most of the frame 
was the distorted muzzle of some creature, its left eye completely out of focus in the top right corner. A curious 
coyote, no doubt; a contention further supported by the jagged teeth marks that would later be noted on the 
camera’s otherwise smooth external plastic casing. I noticed the date and time across the bottom of the photo in 
big orange digital numerals, which indicated it was taken the evening before I retrieved the film. Quickly flipping 
through the last four photos—one of which contained the tip of the coyote’s tail—I reluctantly accepted that the 
camera ran out of film before my jaguar walked past it on the hillside early that morning.

To say that this experience was common for early camera-trappers would probably be an understatement. All that 
effort, both in the field and out, for so little return. Although eventually my own camera-trapping efforts would 
lead to photos of not only jaguars, but more than a hundred species of carnivores on four continents, I racked up 
many kilometers both on foot and by car to develop photos of nothing. I was part of a small but growing group 
of early users passionate about the potential and promise of these devices to survey rare and cryptic mammals, 
which too often differed from the reality of how they functioned on the ground. Rarely did I stop to think that 
commercial camera-traps weren’t really made for us, i.e., wildlife and conservation biologists conducting scientific 
research. They were largely marketed as “game cameras” or “trail cameras” for hunters (Meek and Pittet 2014) 
who maybe only had need for one or a few, whereas scientists needed a minimum of 20, 50, even 100 of these 
cameras if we were to produce worthwhile science. Nor did I think about what this reality meant for end users 
deploying the device “off-book,” trekking them through some of the most unforgiving environments on the planet. 
If units failed or operated otherwise encumbered, thousands of precious dollars of investment in equipment and 
logistics could be for naught. 

I’m happy to say that camera-traps went on to ultimately transform the study of elusive mammals and other 
vertebrates, becoming one of the most powerful and innovative tools on the frontlines of conservation monitoring 
(Hance 2011; O’Connell et al. 2011). Today there are more “trail camera” or camera-trap models, with more features 
and accessory applications, than one can possibly imagine, a fact that sometimes makes choosing the proper unit 
for your study a dizzying affair (Swann et al. 2011). As a veteran scientist still using camera-traps 25 years later 
to build occupancy and spatially explicit wildlife population models, it is an unwitting part-time job for me every 
year to stay on top of the latest features and values being offered. Of course, these days nearly all commercial 
camera-traps are digital infrared models with the capacity to take thousands of photos and batteries lasting four 
to six months. And the best models among them are unlikely to miss anything walking nearby, firing off 10 photos 
or 10 seconds of video before an animal can leave the frame. But the evolution of the camera-trap brought with 
it challenges both familiar and novel. For example, instead of a full roll of film with little to show for it, memory 
cards can now store thousands of photos… of mostly nothing. With that revolutionary capacity, the unsettled 
question remains of how best to process and sort hundreds of gigabytes of photos and video. 

One emerging answer is through the use of automated image and pattern recognition software (Meek et al. 2019; 
Green et al. 2020). Machine learning, or first generation artificial intelligence, which has the potential to draw 
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from diverse training algorithms and deep data reference libraries, can not only filter out empty photos, but can 
correctly identify the species present in a photo or video (Meek et al. 2019; Green et al. 2020). Part science fiction 
and part reality, the day when the two become one—at least for additional practical uses of this technology—is not 
far off.

The evolution of the camera-trap is only one progressive technology story to be told in the diverse world of 
biodiversity science and conservation. Applications for accurate, non-military use of Geographical Positioning 
System (GPS) Technology for example became broadly possible around the same time as early camera-traps 
were proliferating in wildlife research and conservation [Source: National Archives and Records Administration, 
U.S. Global Positioning System Policy]. One consequence of this was an explosion of additional applications for 
monitoring of wildlife populations and other environmental variables. Reasonably accurate Global Navigation 
Satellite Systems (GNSS), which today can mark a location to within meters, contributed to the surge in 
popularity of desktop Geographical Information Systems (GIS) software (e.g., Booth 2000). When combined with 
parallel advances in remote sensing capacity, high accuracy mapping of critical habitats, landscape features, and 
biodiversity hotspots became possible (e.g., Biging et al. 1995; Gould 2000; Horning et al. 2010). In this issue, 
Galante et al. (2020) provide a useful introduction for students on how to use QGIS, a free open-source GIS 
program, to model suitable habitat for a cryptic mammal species. 

Eventually, more satellites enabled a broader GNSS network, and a proliferation spatial analytical tools for 
terrestrial environments led to more options for precision conservation planning (Wang et al. 2010; Rose et al. 
2015). A similar suite of software tools, including novel applications like SeaSketch, are now available to those 
planning the conservation of marine protected areas and sustainable fisheries (Gosnell et al. 2020, this issue). 
These advances in GNSS and GIS had similar consequences for telemetry and tracking technology, permitting 
breakthroughs in the study of species movements both large and small. Like camera-traps, tracking devices today 
have countless features and improvements. Just a sample of these include: longer battery life; spatial data in real 
time via different satellite networks; an ability to withstand extreme variation in temperature and pressure; and 
tiny devices that can even be tethered to a bumblebee (Kuhn et al. 2009; Hagen et al. 2011; Recio et al. 2011; 
Dressler et al. 2016; Taylor et al. 2017).

Imagine now, the power of further cross-pollinating these advances with other proven and promising tools: for 
example, combining advances in tracking and GIS with the capabilities of Unoccupied Aerial Vehicles (UAVs) (e.g., 
Ivosevic et al. 2015; Christie et al. 2016; Horning 2018) and LiDAR (Light Detection and Ranging) remote sensing 
– a technology that has revolutionized our ability to map the surface of the earth (e.g., Davies and Asner 2014; 
Garabedian et al. 2017). What emerges is a set of effective and innovative tools that can facilitate wildlife survey 
and research prospects in new habitats. Such an integrated system can also simultaneously track the movements 
of multiple species while monitoring daily deforestation and mining activities. With the help of SMART (Spatial 
Monitoring and Reporting Tool) data, it could also lead the enablement of effective anti-poaching responses, 
and predict where those same resources are needed tomorrow (Marvin et al. 2016; Krester et al. 2017). Advances 
in automated acoustic monitoring might ultimately hold similar potential for conservation law enforcement 
(Astaras et al. 2017; Hill et al. 2018). For the past decade, acoustic sensors have been used successfully to survey 
threatened and endangered bats, frogs, primates, and birds (Digby et al. 2013; Heinicke et al. 2015; Russo and 
Voight 2016) and are also being used to document changes in the expanse and intensity of anthropogenic noise 
(anthrophony) in urban, wilderness, and marine landscapes, enabling scientists to better understand noise 
impacts on biodiversity (Nowacek et al. 2007; Buxton et al. 2017; Gibb et al. 2019). The exercise by Clark et al. 
(2020) in this issue highlights acoustic monitoring technology and introduces it to students in the context of 
urban bats.

The data being collected by these technologies are leading to a new challenge, one the scientific community hasn’t 
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faced previously: what to do with all these data?! Having finally crossed the threshold of “big data” in ecology, we 
hope that our innovations to store, process, and analyze all of it will be equal to the task—perhaps by enlisting 
some combination of cloud-based servers (Arts et al. 2015; Chapron 2015), or machine learning (see Peters et al. 
2014, as well as work being done by the Center for Biodiversity and Conservation on Machine Learning projects). 
Of course, it is critical that we also ensure such data is used and shared responsibly and ethically (Rambaldi 
et al. 2006). Conversely, there has been an unfortunate and corresponding decrease in financial investment in 
the most timeless repositories of taxonomic data: the great museums and herbariums of the world (Kemp 2015; 
Editorial in Nature 2017). Our new emphasis on big data should not come at the expense of hallmark taxonomic 
and systematic institutions, whose collections constitute the bedrock of evolutionary and ecological disciplines. 
On the contrary, progress in conservation has depended on, and will continue to depend on, discoveries at these 
institutions for years to come. Rather than being in opposition to big data, what if those collections became 
big data? What if we created a three-dimensional digital universe for earth’s biodiversity, based on museum 
collections? 

Digital libraries hold the same promise for the incredible molecular advances we’ve seen in recent decades as 
they do for natural history collections. As with many innovations, the development of powerful genetic tools 
for biodiversity research and conservation were derived from advances in the human health arena. What 
emerged was the field of molecular ecology, a discipline that aimed to evaluate the genetic relationships 
among populations and entire species, and the changes to its tools happened very fast. As the discovery of 
Taq polymerase gave rise to more cost-effective DNA amplification via Polymerase Chain Reaction (PCR) (Saiki 
et al. 1988), so did the initial popularity of allozyme electrophoresis and mtDNA haplotype analyses yield to 
analysis of short, repetitive nucleotide sequences of DNA known as microsatellites (Litt and Luty 1989; Richard 
et al. 2008). A technique to recover and amplify low-quality, degraded DNA from sloughed epithelial cells in the 
digestive tract (Albaugh et al. 1992) made it possible to sample low-density species noninvasively, making remote 
genotyping and sex identification of individual animals via scat samples possible and further proliferating the 
number of microsatellite studies (Taberlet et al. 1996; Reed et al. 1997; Wasser et al. 1997). Hardly more than a 
decade later, the increasing use of hundreds to thousands of Single Nucleotide Polymorphisms (SNPs) offered 
greater genetic resolution than microsatellites (Morin et al. 2004), and eventually began to supplant them in 
conservation and ecological genetic studies. Parallel advances have facilitated accurate species identifications 
via low concentrations of environmental DNA (eDNA) gathered from the water in which those organisms swim 
(Jerde et al. 2019), including a rare, apex predator in the open ocean (Truelove et al. 2019). New eDNA techniques 
are promising for informing conservation management; see the exercise by Douglas et al. (2020) in this issue. 
Whole genome sequencing of individual non-target organisms, formerly costing millions of dollars, is also now 
cost-effective (Ekblom and Galindo 2011; McMahon et al. 2014), and a new device has emerged that can now help 
one do it all on the go (Lu et al. 2016). Most recently, the wonder and risks of new genetic engineering tools like 
CRISPR-Cas9 (Jinek et al. 2012) have intensified the global debate about genetically modified organisms, even as 
they potentially represent the most effective method devised so far to control invasive species. 

Looking to the future, I am both excited and optimistic, as the prior examples are just a sample of the innovations 
relevant to safeguarding earth’s biological diversity. We are standing on the precipice of some very formidable 
challenges. Extinction and climate change are inescapably entwined, and loom large in the Anthropocene. For 
countless species, their prospects are worse than ours. Yet, even as humanity grows closer to a threshold of 
runaway warming, global habitat change, and escalating conflict with fellow species, we also grow closer to the 
point that could tip balance the towards realizing a sustainable planet. No, of course technology alone won’t save 
the world. The will and commitments of our governments and institutions, responsible consumption, behavior, 
and corporate governance, and a socio-political climate that acknowledges the importance of empirical evidence, 
all have very important roles to play. But the potential for parallel, advancing technologies to converge, mutually 
enhancing their respective capacities to tackle climate change, illegal wildlife trafficking, deficits in biodiversity 

https://www.amnh.org/research/center-for-biodiversity-conservation/research-and-conservation/machine-learning-for-conservation
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“I believe, then, that the cod fishery, the herring fishery, the pilchard fishery, the mackerel fishery, and probably 
all the great sea fisheries, are inexhaustible; that is to say, that nothing we do seriously affects the number of the 
fish. And any attempt to regulate these fisheries seems consequently, from the nature of the case, to be useless.”
 - Thomas Huxley, 1883 address to the International Fisheries Exhibition in London.

“I don’t have a crystal ball and I don’t know what the future will bring, but this is a clear trend. There is an end in 
sight, and it is within our lifetimes.”
 - Boris Worm, 2006 (Dean 2006), commenting on model predictions that the world fisheries might be exhausted 
by 2048 (Worm et al. 2006).

While neither of the above quotations may be totally correct in their perspectives on fisheries management, they 
clearly display how our view of managing ocean resources has changed over the past ~150 years. In addition 
to fisheries, marine systems also harbor other resources and provide various services that sustain life on earth. 
Managing those resources in a sustainable and optimal manner is an ongoing quest that, to succeed, generally 
involves scientists from various fields, resource managers, and key stakeholders1 from both the business and 
public spheres. In this exercise we consider the evolution of these strategies and allow students to use marine 
spatial planning2 tools to design networks3 of marine protected areas (MPAs)4 and consider their impact on 
ecological and human communities.

Building Marine Reserve Networks to Fit Multiple Needs: An 
Introduction to Marine Spatial Planning Using SeaSketch
J. Stephen Gosnell,i,ii Will McClintock,iii and Minkyung Leei

i Natural Sciences, Baruch College, New York, NY, USA; ii Graduate Center, City University of New York, NY, USA; iii University of California, Santa Barbara, 
CA, USA

Marine spatial planning is growing in use as a tool to aid management efforts in coastal and ocean systems. 
In this exercise, we briefly review the history and rationale behind marine spatial planning and consider its 
relationship to and use in ecosystem-based management. We then outline an activity that introduces students to 
marine spatial planning through the use of SeaSketch (training-barbuda.seasketch.org). SeaSketch is a web-based 
program that allows users to create, analyze, and compare how marine protected areas and networks contribute 
to achieving conservation goals. Building on the use of SeaSketch to engage stakeholders in the creation of 
reserve networks off the island of Barbuda, students use a SeaSketch training environment to create networks of 
marine protected areas that meet habitat protection goals and consider how these networks impact local species 
and human fishing value. After creating and analyzing individual networks, students engage in small- and large-
group discussions to consider and compare alternative plans and decide on final choices. At each of these levels, 
students can compare their chosen plans to the zoning regulations that were approved in Barbuda.

ABSTRACT

INTRODUCTION

LEARNING OBJECTIVES
After completing this exercise, students will be able to:
1. Discuss the need for marine management strategies.
2. Define and compare various marine management strategies and tools, including marine spatial planning, 

ecosystem-based management, and geographic information systems.
3. Create reserves and networks in SeaSketch and analyze their contribution to habitat protection, species 

coverage, and impact on fishing value.
4. Use numerical outputs to justify design choices and compare multiple plans.
5. Contextualize analyses by deciding on best design choices and discussing necessary trade-offs in marine 

spatial planning.

https://www.seasketch.org/#projecthomepage/533da388a498867c56c6c05e/about
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Humans rely on marine ecosystems for a variety of valuable resources. From artisanal efforts to industrial 
operations, wild-caught and aquaculture fisheries provide an important source of food, employment, and cultural 
heritage to millions worldwide. In 2015, global annual consumption of “fish” (including both finfish and shellfish) 
reached an average of greater than 20 kg/person, and fish accounted for ~17% of the protein humans consumed 
in 2015 (FAO 2018). More than 59 million people are directly engaged with fisheries through employment or 
subsistence-related activities (FAO 2018). Marine systems are also home to other valuable activities such as 
water-based recreation, tourism, and energy extraction. Offshore operations accounted for nearly 30% of global 
oil production in 2015 (United States Energy Information Administration 2016), and recent estimates suggest 
energy from off-shore wind projects could meet the power needs of the entire United States (United States 
Department of Energy & United States Department of the Interior 2016). Marine systems also provide a number 
of other invaluable (and sometimes unvalued) ecosystem services5. For example, coastal oyster reefs and salt 
marshes may aid in reducing the wave surge of storms and in removing nitrogen from coastal waters (Beck et al. 
2011; Grabowski et al. 2012; Kellogg et al. 2013). As a whole, the world’s oceans also play a key role in regulating 
global climate, having absorbed over 90% of the excess energy resulting from increases in the greenhouse effect 
and 30% of the excess CO2 humans have released into the atmosphere (Hoegh-Guldberg et al. 2014).

Given the variety of services provided by marine communities and associated value, it is no surprise that many 
marine areas are heavily impacted by human activity (Halpern et al. 2015). Overfishing has been documented 
in all major marine areas; ~33% of fish stocks currently appear to be over-exploited, and almost another 
60% of fish stocks are currently harvested at maximum sustainable yields (FAO 2018). Other activities such 
as energy extraction, shoreline development, and pollution may also lead to habitat damage and degradation 
that eventually lead to a loss of marine communities and the ecosystem services they provide (Halpern et al. 
2008, 2015). On a global scale, the continued increase in atmospheric CO2 and resulting absorption by ocean 
waters has led ocean pH to drop (Breitberg et al. 2015). This effect, known as ocean acidification, may result 
in calcifying species such as oysters and corals being unable to produce shells and skeletons (O’Donnell et al. 
2010); acidification can also disrupt species interactions (Dixson et al. 2010). These combined effects have led 
to massive degradation and loss of marine systems (Halpern et al. 2008, 2015). Coastal communities have been 
some of the most heavily impacted, with the majority of oyster reefs (>80%) and mangroves (>50%) and large 
portions of coral reefs (20%) and seagrass habitats (>29%) lost worldwide (Grabowski et al. 2012).

In response to the loss of marine resources and habitats and the services they provide, regulations have been 
enacted to conserve and restore populations and areas. Over time these regulations have evolved in how they 
coordinate activity among various fisheries and other industries and in how they consider the ability of different 
areas to support various activities. Regulations historically focused on single fisheries or industries. For fisheries, 
these regulations were often set based on recent catch data and included limits on catch, gear, and season (Lear 
1998; Lackey 2005). For example, size limits may have first been used for fisheries management in North America 
to manage the harvest of Canadian lobsters (Anderson 1998). When regulated, other industries such as off-shore 
drilling were managed by local or federal authorities through leases of submerged lands or licenses. 

Unfortunately, isolated sets of regulations may miss interactions that occur among various fisheries and other 
non-harvest industries (e.g., energy extraction, tourism) and may themselves have unintended consequences for 
the rest of the marine community (Worm et al. 2009). Beyond impacts on targeted species, for example, fisheries 
may directly impact other species through bycatch, or incidental take (Dayton et al. 2003; Pikitch et al. 2004). In 
the United States, some bycatch rates have recently been estimated at 17% (National Marine Fisheries Service 
2011), and past global estimates have ranged from 8% to 27% (Kelleher 2005). Harvest of one species may also 
lead to changes in the strength or intensity of species interactions or availability of resources for another species, 
which can in turn impact entire communities (Zabel et al. 2003; Lafferty 2004; Daskalov et al. 2007; Baum 

A Transition to Ecosystem Based Management and Marine Spatial Planning in Marine Systems
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and Worm 2009; Madin et al. 2010; Loh et al. 2015). Habitat destruction and degradation may also result from 
fishing strategies such as trawling (Hiddink et al. 2006, 2017), and from infrastructure and activity related to 
both energy extraction (Holdway 2002) and tourism (Harriott et al. 1997; Davenport and Davenport 2006). These 
interactions may mean regulations focused on single fisheries or industries do not produce optimal productivity 
or sustainability outcomes. 

Just as not accounting for interactions among groups could lead to sub-optimal regulations, failing to consider 
spatial differences in the ability of a region to support fisheries or other industries may lead to unnecessary 
conflict and mismanaged systems. Although early fisheries regulations were often established at a regional (e.g., 
state, country) level, they frequently did not account for differences among coastal habitats or populations. For 
example, harvested populations may differ in biological traits relevant to management across their range [e.g., 
urchins (Rogers-Bennett et al. 1995), abalone (Leaf et al. 2007), sheephead (Caselle et al. 2011), grass rockfish 
(Wilson et al. 2012)]. Not taking these differences into consideration may lead to over- or under-fishing a stock. 
Fishing and other industries may also be concentrated in specific habitat types; ignoring the distribution patterns 
of these habitats and activities may increase negative interactions among competing groups, resulting in adverse 
or at least undesirable outcomes. 

For these reasons, management strategies that specifically considered spatial differences in harvest potential 
or other activities in addition to interactions among fisheries and other spatially-coinciding industries began 
to emerge. These new approaches included marine spatial planning strategies. Marine spatial planning allows 
managers to explore how various activities may be distributed to optimize use of resources (White et al. 2012). 
Early examples of this from fisheries management included closing specific geographical areas to certain types 
of gear in order to minimize conflicts among fisheries (Anderson 1998). As stock assessment efforts grew and 
matured, specific regulations were also varied across the range of a species (Ciannelli et al. 2008; Costello et al. 
2010; Dunn et al. 2011). 

Fisheries aside, marine spatial planning is also useful for coordinating multiple activities co-occurring in marine 
areas. For example, infrastructure for energy extraction may constrain movement of SCUBA diving and sightseeing 
operators (White et al. 2012), whereas shipping lane placement may negatively impact whale movements, health, 
and survivorship (Redfern et al. 2013). Recognizing and accounting for these interactions can lead to more 
effective management strategies by minimizing conflict and maximizing total productivity. For example, spatially-
explicit models that integrate the value of each geographical or ecological portion of a coastal region to the 
various industries present have demonstrated that flounder fisheries, lobster fisheries, whale-watching activities, 
and off-shore energy farms may be optimally co-established in Northeast bays (White et al. 2012). Given the large 
number of parameters these models must consider, optimization algorithms are often used to fully consider all 
possible options and their trade-offs. 

The integration and consideration of interactions among various industries is a form of ecosystem-based 
management (EBM)6. Overall, EBM seeks to ensure the optimal and sustainable use of the full range of resources 
and services in an ecosystem or among ecosystems. Successful outcomes of the EBM approach can include 
an improved understanding of how changes in fisheries practices for a single species might impact harvest 
of other fisheries or optimization of the sustainable use of diverse resources (Leslie and McLeod 2007; Levin 
and Lubchenco 2008; May et al. 2008). Due to differences in potential resource availability among different 
geographical areas, effective EBM necessitates a spatial component. 
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One increasingly common marine spatial planning strategy for balancing resource use with protection of 
populations and habitats is the designation of marine protected areas (Hooker and Gerber 2004). MPAs are 
a geographically-specified area of the ocean where use regulations have been established, usually to provide 
protection for natural or cultural resources. These regulations may include restrictions on fishing, energy 
extraction, tourism, or other activities. Where all commercial fishing has been eliminated, MPAs are often known 
as no-take MPAs, marine reserves7, or marine sanctuaries. By reducing fishing and other human pressures, these 
areas may allow locally harvested populations to increase, which as a consequence can have positive direct and 
indirect spill-over benefits for adjacent fisheries (Gaylord et al. 2005; Lester et al. 2009; Buxton et al. 2014; da 
Silva et al. 2015). Due to the dispersal and movement patterns of many marine species, multiple MPAs are often 
designated to form a network in a given area (Gaines et al. 2010). Increases in local fisheries populations may 
also lead to an increase in the recreational value of these areas (Sala et al. 2016; Viana et al. 2017). For these and 
other reasons, the designation of MPAs is a common tool in EBM.

Despite their clear benefits, the creation of MPAs is not always without controversy and may even be contentious 
(Klein et al. 2008). MPAs need to be placed in areas that can support strong populations of multiple species. Not 
surprisingly, these areas are often of high value to fishermen. Similar issues may arise if areas are designated as 
no- or limited-access for tourist operators. Successful conservation strategies must balance trade-offs among 
groups through compromise, as an imbalance of cost and regulation with biological benefits and gains can lead 
to a lack of short- and long-term community, economic, or political support for a management strategy (Bennett 
et al. 2019). Considering stakeholder input, information on spatial differences, and potential economic impacts 
can therefore be a valuable part of the MPA designation process, leading to stronger local awareness and support 
(Beddington et al. 2007; Klein et al. 2008; Costello et al. 2010). For example, efforts to reduce the effects of a 
marine reserve designation in Australia on a local lobster fishery led only to slight changes in reserve design while 
decreasing use impacts by a third (Stewart and Possingham 2005). 

Geographic information systems (GIS)8 that store spatially-explicit data and allow visual mapping play a key role 
in the creation and development of marine protected areas (McClintock 2013). GIS-based tools can also act as a 
critical link to unite scientists and other stakeholders (Brown and Weber 2013). Due to the proliferation of data, 
increases in computing power, and greater access to technology, new GIS-based tools can allow stakeholders to 
propose networks of marine reserves or regulations and actually compare their choices to those generated by 
multiple users. For example, various stakeholder groups can generate prospective marine reserve networks and 
compare how each protects various fishery stocks and habitats or how they displace fishing activity. The freedom 
to fully design and compare individual solutions is critical to promoting transparency regarding alternative 
management strategies and to enabling the public to better understand potential trade-offs. Trade-offs occur 
when an overall goal or goals of one stakeholder group cost another group or groups. Creation of a marine reserve 
in one area, for example, may increase habitat protections while reducing access to optimal fishing locations.

The process for involving multiple stakeholders in considering MPA placement has been well-documented for MPA 
designation and management in California (USA). Over the past 15 years, California has established some form 
of marine protected areas for ~16% of its shoreline. These regulations were determined based upon input from 
scientists; local, state, and federal agencies; the fishing community at-large; and the general public (Osmond et al. 
2010). In later parts of the process, stakeholders were able to use MarineMap software (Merrifield et al. 2013) to 
design marine reserve networks and compare their impacts on fisheries and ability to meet stated conservation 
goals. In the following exercise, we will explore how GIS-based tools can increase stakeholder participation by 
using SeaSketch, the descendant and current iteration of MarineMap.

Marine Protected Areas in EBM and Marine Spatial Planning
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SeaSketch is a web-based application that allows users to create, share, and compare spatially-based solutions 
to management questions. The software is based on the geodesign approach, wherein users are allowed to 
easily map various potential solutions on an interactive map and obtain relevant data on outcomes (McClintock 
2013). The web-based implementation also makes involving and empowering stakeholders extremely easy, and 
SeaSketch is now currently used by almost 5000 users in over 200 active projects (map of current projects 
available at www.seasketch.org/projects). 

SeaSketch was used to involve a large proportion of the island of Barbuda (population ~ 1800) in the 
development of new marine zoning policies (Pomeroy et al. 2014). Sponsored by the Waitt Institute, the Barbuda 
Blue Halo Initiative used SeaSketch to consider how well reserve plans developed by the local government, 
fishermen, and the general public met the goals of protecting the local marine resources while simultaneously 
supporting the livelihood of local fishermen and other industries. In less than two years, the project moved from 
initial surveys of the local habitat and recognition of stakeholder needs to an approved zoning plan. In this 
exercise, students will use a SeaSketch training environment to create their own plans to satisfy basic reserve 
requirements (e.g., preserving 10% of various habitats in no-fishing reserves) while attempting to minimize 
impacts on fishing activity. 

The video of the presentation introducing SeaSketch to the larger GIS community at the 2012 ESRI User 
conference makes an excellent introduction to the program and its capabilities (available from youtu.be/
d4z6m56pAIc). The Waitt Institute also has produced several videos on the Blue Halo Initiative in Barbuda: 
• youtu.be/I0SUymbJi8U, ~ 2 min length; 
• youtu.be/qoTTnSWZ1sk, ~ .5 min (shorter version of first video); 
• youtu.be/ahRkXxhIPao, ~ 2.5. min length. 

Note: These management efforts took place prior to the devastating impacts of Hurricane Irma on the island in 
September 2017. 

The goals for the Blue Halo Initiative were based on protecting one-third of major habitat types around the island 
from fishing in large protected areas. Target levels for habitat protection are typically set by determining how 
much area is required to allow populations of key species to persist while also considering how habitat protection 
will influence other activities (e.g., lead to fishing displacement). Since conservation benefits of reserves increase 
with size while benefits to fisheries tend to asymptote or decrease at larger sizes, target levels represent a 
tradeoff among goals for MPAs (Airame et al. 2003; White et al. 2008). Large protected areas (as opposed to 
a greater number of smaller areas that cover the same percentage of habitat) are necessary so that sites have 
a clear “core” area where human impacts are minimized (Gaines et al. 2010). For this exercise, you will produce 
no-take marine protected areas, or reserves, that contain at least 10% of prime habitats; SeaSketch will offer 
feedback on the size of selected areas. The 10% protected habitat can be shared among a network of reserves. 

After creating these networks, you will consider disparate impacts on key species in the island (conch, lobster, 
gray snapper) and overall impacts on fishing activity. After considering and justifying your own plans, you will 
engage in a larger class-based discussion where you will each present and compare plans before deciding on a 
final zoning design.

SeaSketch and the Blue Halo Initiative 

EXERCISE OVERVIEW

Background

http://www.seasketch.org/projects
http://youtu.be/d4z6m56pAIc
http://youtu.be/d4z6m56pAIc
http://youtu.be/I0SUymbJi8U
http://youtu.be/qoTTnSWZ1sk
http://youtu.be/ahRkXxhIPao
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SeaSketch has created a sandbox environment focused on the Blue Halo Initiative where educators and students 
can use the software (available at training-barbuda.seasketch.org or from links found at www.seasketch.org/
training/). A training manual has also been created (available at s3.amazonaws.com/SeaSketch/140822+SeaSke
tch+Training+Manual.pdf) that can be referenced as needed. Below we cover the basic steps involved in reserve 
and network creation and analysis. Throughout the exercise, make sure the top left of the page states Barbuda 
Training Project and not Blue Halo Barbuda (Figure 1), as the Blue Halo project page will not contain all layers 
required for the exercise. It is important to note that the training project contains an estimate of how MPA 
placement disrupts fishing patterns. This estimate was produced by aggregating data compiled by surveying 
Barbuda fishermen on the relative value of locations where they fished. The data are for educational purposes 
only and should not be redistributed.

Figure 1: Selecting the “Sign In” button from the training site will allow a new user account to be created. Ensure you are working from 
the Barbuda Training Project maps for all exercise activities.

Actual projects that utilize SeaSketch allow users to share maps and plans with others via discussion boards or 
forums as shown in the video demonstrating SeaSketch. For the sake of simplicity, in this exercise you will all 
share one account created by your instructor. 

Log-in to the training site (training-barbuda.seasketch.org) using the single account created by your instructor 
to aid in viewing and comparing class outcomes. If logged in to the main SeaSketch site, you can also navigate to 
the training tab and follow links to Barbuda training. Once logged in, you will be shown a base map of Barbuda 
(Figure 2). 

Using SeaSketch

Account Creation and Naming Convention Notes 

SeaSketch Basics

http://training-barbuda.seasketch.org
https://www.seasketch.org/training/
https://www.seasketch.org/training/
https://s3.amazonaws.com/SeaSketch/140822+SeaSketch+Training+Manual.pdf
https://s3.amazonaws.com/SeaSketch/140822+SeaSketch+Training+Manual.pdf
http://training-barbuda.seasketch.org
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 The goal of the exercise is to create reserves or networks that: 
• preserve at least 10% of each of several important habitat types (continuous reef, patch reef, hard bottom, 

sand, seagrass) in sanctuaries within the 3-nautical mile boundary surrounding Barbuda. To view these, make 
sure that Habitat is selected within Data Layers; the habitat-type legend can then be viewed under Legend & 
Ordering.

• include protection for key ecological and economic species—queen conchs (Lobatus [Strombus] gigas), 
Caribbean spiny lobster (Panulirus argus), and gray snapper (Lutjanus griseus). You must ensure that the 
sanctuary you create includes areas where these species have been surveyed or exist (possible by layering Dive 
Survey and/or Habitat data over final network design).

• minimize impact on total fishing value. 

After creating an individual plan, you will compare your design to those of your classmates. Throughout this 
exercise, you will prepare a short submission (numbered responses to questions) detailing your findings. 
Information that should be included in the submission and questions that should be answered are noted below in 
bullets and aggregated in Appendix 1. 

You can visually display various data layers representing habitat and ecological data onto the map by selecting 
checkboxes; of key use to the exercise are Fishing Value layer, Habitat, and Dive Survey data. Before creating 
any sanctuaries or reserves, make sure you are comfortable moving around the map and adding multiple layers. 
Layer order and markings can be manipulated in the Legend and Ordering tab. Once you are comfortable working 
with the map you can create your first marine protected area. We recommend becoming familiar with the process 
before focusing on goals for habitat and fishing impact. In the Barbuda Blue Halo project, the MPAs where fishing 
regulations are in place are called sanctuaries9. For this training exercise, sanctuaries should be set to exclude all 
fishing (i.e., marine reserves). The option to only allow lobster and/or conch fishing is also present in the Barbuda 
Training Project. However, if groups differ in fishing restrictions, then comparison of “protected” habitat will be 
complicated. 

To create a new sanctuary or network after logging in, select the My Plans tab. Next, select Create New > 
Sanctuary. A protected area can then be placed in island waters by clicking on the screen to create adjacent 
corners for the MPA; a double-click will close the resulting polygon. Any area outside a 3-mile nautical boundary 
will be removed, and if land was included in the polygon the final sanctuary will follow the coastline. Once created 
you can name the site and indicate if conch or lobster fishing is allowed (Figure 3). To make sure you do not 
overwrite existing plans, name areas and networks using your initials (e.g., JSGArea1, MLNetwork2). 

Once the sanctuary is created, you can view how it meets habitat coverage and other goals by selecting the site 
and choosing View Attributes and Reports. Data on size, habitat coverage, and impact on fishing displacement 
are provided for the site (Figure 4). The minimum width of the sanctuary is also shown; the recommended 
minimum width is 2–3 miles. Smaller sanctuaries may increase edge effects in these systems and consequently 
not offer enough core area for species protection. Clicking on the “X” will allow you to select or create additional 
sanctuaries (Figure 4).

Multiple marine sanctuaries can be combined into networks and analyzed for total impact. Networks are created 
by selecting Create New > Collection. Once named, individual sanctuaries can be placed in a collection by right-
clicking on the sanctuary and choosing Place in collection. Data on entire networks is also provided by selecting 
the collection and View Attributes and Reports (Figure 5). Specific sanctuaries can also be copied (right-click on 
chosen network > copy) and placed in multiple networks (right-click on chosen network > place in a collection).

EXERCISE
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Figure 2: The base map of Barbuda is displayed when users login to SeaSketch. Data layers may be added by selecting checkboxes.

Figure 3: Once outlined, new sanctuaries can be named and saved. 
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Figure 4: Once saved, information on the size, coverage, and impact of a sanctuary on fishing are provided via the View Attributes 
and Reports tab. Clicking on the “X” will allow you to select or create additional sanctuaries.

Figure 5: Collections can also be visualized by selecting the checkbox next to their name. Once selected, data is provided by the View 
Attributes and Reports tab.
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Create a network that meets these goals. If you are working in teams, you should each complete your own plan. 
Use your plans to respond to the numbered prompts and questions below. 

1. To begin the exercise, create your initial network of sanctuaries. You can use the provided map layers, but do 
not use the assessment tools provided by SeaSketch. You should start your report by copying and pasting 
images of your network into a Word document (or a similar program). You should also justify your network 
design by writing about what made you choose these areas.

Next, analyze the sanctuaries or networks you have created to consider how they meet the conservation goals. 
Habitat coverage and impacts on fishing level are provided under the View Reports and Attributes tab. To consider 
the coverage for the specific species (gray snapper, lobster, and conch), ensure the sanctuary or collection of 
interest is selected under the My Plans tab and then return to the Data Layers tab. Select appropriate species 
under Diver Surveys to consider spatial overlap (Figure 6). Impacts on fishing displacement are also provided and 
may be visualized using the Fishing Value layer.

Using this information, revise your sanctuaries and networks to meet habitat coverage and species protection 
goals while reducing the impact on local fishermen. The shape and coverage of a specific sanctuary can be edited 
by right-clicking on the Sanctuary and selecing Edit under the My Plans tab. Edges of the sanctuary may then be 
moved as needed before the area is updated by saving.

2. Once designs are finalized, copy and paste resulting images of your revised network and associated report 
tables (to ensure minimum habitat protection has been met) into your Word document. 

3. Explain why you selected each protected area.
4. Discuss the process you went through in reaching the final design. How many times did you have to update 

your initial plan before arriving at your final result, and what were the key factors driving your decision to 
change your plan?

5. Compare your plan to the final zoning proposal for Barbuda (adopted in August of 2014) (Figure 7), focusing 
on sanctuaries, and discuss how you see compromise occurring (or not). Additional information on the 
development of the zoning configuration and the specific sanctuaries that comprise the final approved plan 
is also available at seasket.ch/ywryFYjx2z. Note: the final Barbuda plan had more requirements than our 
exercise, such as the need to protect one third of many habitats.

Individual Plan Development

http://seasket.ch/ywryFYjx2z
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Figure 6: The ability of a protected area to protect certain species or impacts on fishing can be visually inspected by adding the 
respective sanctuary or network to the map and then adding species data or Fishing Value layers.

Figure 7: The final zoning proposal for Barbuda, which was adopted in August of 2014, can be viewed with the Barbuda Ocean Zones 
layer. 
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Figure 8: The Tradeoff Analysis tab considers how protecting conch and lobster in sanctuaries impacts fishing and ecological 
outcomes.

Small Group Discussion
After you have finalized your own plans, form small groups (3–4 students) to compare your decisions to those 
of classmates. Since you and your classmates all used one account, all plans should be available for viewing. 
Internet browsers may need to be refreshed to ensure all plans are loaded.

Discuss why you made specific decisions. If so desired, other layers and trade-off analysis may be employed 
here. For example, does your group note trade-offs between how much total habitat is conserved and how much 
fishing is displaced? The Tradeoffs tab under View Attribute and Fishing Reports offers a quantitative assessment 
of trade-offs regarding conch and lobster fishing (Figure 8). For example, whereas protecting areas where adult 
lobsters can be fished may reduce fishing value, protecting nursery areas may actually increase both fishing 
productivity and ecological value in an area.

6. List three trade-offs you observed between various plans presented by your group members. Were you 
surprised at the ways each person constructed their networks or in the multitude of ways goals could be met? 

7. As a group, decide which plan was the best. Remember, you can view multiple plans simultaneously on a 
single screen by selecting the appropriate layers. In your submission, explain how the group decided on a best 
plan. Did everyone agree? What was different about the best overall design plan selected by the group and 
your own design? 

In your small group, if your instructor is including a classroom discussion, prepare a short (2–3 minute) 
description of your final plan and how you arrived at it.
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Each group will present their “best” plan to the entire class. As a class, discuss differences among the plans and 
select an overall final design. Then answer the following questions. 

8. What do you think about the final design chosen by the class? Do you think the final design was the best at 
meeting the stated goals?

9. How does the final class plan compare to the zoning regulations adopted in Barbuda (adopted in August of 
2014) (Figure 7)? Note: the final Barbuda plan had more requirements than our exercise, such as the need to 
protect one third of many habitats.

10. Now that you have gone through this process, how would you start the sanctuary design process differently in 
the future? Comment on how you initially constructed your networks (e.g., based on habitat or species layer) 
and what approach you would use in the future based on your experience and discussions.

11. Given the parameters you had to consider, simply searching for placement options may not lead to the 
optimal outcome being found (and may be very time consuming). Algorithms can be used to find optimal 
solutions to these issues. Comment on why having people create their own designs may still be useful despite 
the existence of algorithms. How could you combine the two approaches?

12. Finally, comment on how you think geodesign tools such as SeaSketch will change the process of creating 
marine reserves and carrying out marine spatial planning. How do these tools impact stakeholder involvement 
and participatory design? Do you think that allowing stakeholders to be involved in actual sanctuary or 
reserve designation is a good thing? What might be some of the benefits and challenges?
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1. Stakeholder: People or groups who will be impacted by a conservation action or regulation.
2. Marine spatial planning: Management strategy that distributes activities or regulations across an area based 

on spatial differences in order to achieve better use of resources.
3. Network: A group of MPAs designed to work together to promote long-term persistence of populations.
4. Marine protected area (MPA): An area of the ocean where regulations have been put in place to provide 

protection for natural or cultural resources.
5. Ecosystem services: The benefits people obtain from ecosystems (Millennium Ecosystem Assessment).
6. Ecosystem-based management (EBM): Holistic management approach that considers how all ecosystem 

services provided by an area can be optimally managed (as opposed to single-species or single-sector 
management).
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7. Marine reserve: A marine protected area where no take (fishing) is allowed.
8. Geographic information systems (GIS): A system that organizes data in a spatially-explicit manner so that it 

can be mapped (often in layers) and analyzed.
9. Sanctuary: Term used for marine protected area in SeaSketch software.
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Individual Plan Development:
1. To begin the exercise, create your initial network of sanctuaries. You can use the provided map layers, but do 

not use the assessment tools provided by SeaSketch. You should start your report by copying and pasting 
images of your network into a Word document (or a similar program). You should also justify your network 
design by writing about what made you choose these areas. 

2. Once designs are finalized, copy and paste resulting images of your revised network and associated report 
tables (to ensure minimum habitat protection has been met) into your Word document. 

3. Explain why you selected each protected area.
4. Discuss the process you went through in reaching the final design. How many times did you have to update 

your initial plan before arriving at your final result, and what were the key factors driving your decision to 
change your plan? 

5. Compare your plan to the final zoning proposal for Barbuda (adopted in August of 2014) (Figure 7), focusing 
on sanctuaries, and discuss how you see compromise occurring (or not). Additional information on the 
development of the zoning configuration and the specific sanctuaries that comprise the final approved plan 
is also available at seasket.ch/ywryFYjx2z. Note: the final Barbuda plan had more requirements than our 
exercise, such as the need to protect one third of many habitats.

APPENDIX 1: EXAMPLE STUDENT WORKSHEET FOR SEASKETCH EXERCISE
Answer the following questions and/or provide requested images (also found in the text) as you work through 
the SeaSketch assignment. Submissions should include answers to numbered questions that include text and 
required images. Answers should be complete and concise (~1 paragraph for numbered questions that require 
text responses).

Classroom Discussion:
8. What do you think about the final design chosen by the class? Do you think the final design was the best at 

meeting the stated goals? 
9. How does the final class plan compare to the zoning regulations adopted in Barbuda (adopted in August of 

2014) (Figure 7)? Note: the final Barbuda plan had more requirements than our exercise, such as the need to 
protect one third of many habitats.

10. Now that you have gone through this process, how would you start the sanctuary design process differently in 
the future? Comment on how you initially constructed your networks (e.g., based on habitat or species layer) 
and what approach you would use in the future based on your experience and discussions.

11. Given the parameters you had to consider, simply searching for placement options may not lead to the 
optimal outcome being found (and may be very time consuming). Algorithms can be used to find optimal 
solutions to these issues. Comment on why having people create their own designs may still be useful despite 
the existence of algorithms. How could you combine the two approaches?

12. Finally, comment on how you think geodesign tools such as SeaSketch will change the process of creating 
marine reserves and carrying out marine spatial planning. How do these tools impact stakeholder involvement 
and participatory design? Do you think that allowing stakeholders to be involved in actual sanctuary or 
reserve designation is a good thing? What might be some of the benefits and challenges?

Small-Group Discussion:
6. List three trade-offs you observed between various plans presented by your group members. Were you 

surprised at the ways each person constructed their networks or in the multitude of ways that goals could be 
met? 

7. As a group, decide which plan was the best. Remember, you can view multiple plans simultaneously on a 
single screen by selecting the appropriate layers. In your submission, explain how the group decided on a best 
plan. Did everyone agree? What was different about the best overall design plan selected by the group and 
your own design? In your small group, prepare a short (2–3 minute) description of your final plan and how you 
arrived at it. 

http://seasket.ch/ywryFYjx2z
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What’s in the Water? Using environmental DNA for Marine 
Monitoring and Planning
Kristin E. Douglas,i Patrick Shea,ii Ana Luz Porzecanski,i and Eugenia Naro-Macieliii
i Center for Biodiversity and Conservation, American Museum of Natural History, New York, USA; ii Graduate Center, City University of New York, USA;  
iii Liberal Studies, New York University, New York, USA

ABSTRACT
Coral reefs, the most biodiverse of all marine ecosystems, are of high ecological, cultural, and financial 
importance, yet they are declining on a global scale due to several anthropogenic factors. Current threats to 
coral reefs highlight the urgent need for effective research, monitoring, and management of these ecosystems. 
In this case study-based exercise, students will compare and contrast biodiversity information about Hawaiian 
reefs between traditional diver surveys and eDNA-based applications, consider the benefits and limitations of 
each method for coral reef fish monitoring, and use these data to designate potential marine protected areas 
(MPAs). As part of this process, they will practice identifying species based on genetic sequencing data using 
the Basic Local Alignment Search Tool (BLAST) of the National Center for Biotechnology Information. Lastly, 
students will be introduced to different approaches to protection of marine systems in Hawai‘i, including the 
Papahānaumokuākea Marine National Monument, and reflect on the diversity of approaches to managing 
seascapes.

LEARNING OBJECTIVES
After completing this case study-based exercise, students will be able to: 
1. Describe the general characteristics of selected coral reef fishes in Hawai‘i.
2. Describe what eDNA is, and identify its applications to marine biodiversity conservation.
3. Identify species based on DNA sequence data.
4. Discuss the added value and limitations of using eDNA for biomonitoring.
5. Reflect on the factors that can influence marine protected area design, and the different forms protected 

areas can take.

INTRODUCTION
Coral reefs, the most biologically diverse of marine ecosystems, hold great economic, ecological, cultural, and 
recreational significance (Gombos et al. 2010; Hawai‘i, NOAA 2014). The global decline of coral reefs due to 
overfishing, coastal development, and ocean warming underscores the widely recognized need for effective 
research, monitoring (of both abiotic and biotic factors), and management of these systems. Hawai‘i’s coral reefs, 
which are home to a remarkable number of endemic reef fish species, have not escaped these threats. 

One important tool to protect coral reef ecosystems is via effectively managed marine protected areas, or MPAs. 
MPAs are designated marine areas designed to protect the natural and/or cultural resources of that particular 
place. In Hawai‘i, MPAs are referred to as “Marine Life Conservation Districts” or MLCDs, which can either limit 
or prohibit fishing altogether within an area. In this exercise’s first section, you will explore decision-making using 
a site-based approach to protected area selection. In the second section, you will explore other approaches 
to protecting marine ecosystems that are currently in place in Hawai‘i. For more information on MPA planning 
and design beyond the scope of this exercise, see NCEP’s modules: Marine Protected Areas and MPA Networks 
and Building Marine Reserve Networks to Fit Multiple Needs: An Introduction to Marine Spatial Planning Using 
SeaSketch.

SECTION 1. SELECTING MARINE SITES FOR PROTECTION
Hawai‘i’s Coral Reef Fishes 
In this exercise, you will participate in a fictional meeting of scientists in Hawai‘i aiming to designate sites for 
protection. Although there are many different considerations that are important when trying to designate 

https://ncep.amnh.org/index.php/Detail/objects/163
https://ncep.amnh.org/index.php/Detail/objects/1045
https://ncep.amnh.org/index.php/Detail/objects/1045
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protected areas, your working group will be focusing on ensuring that priority coral reef fish species are included 
in the site selection process.

Coral reef ecosystems are complex and have highly diverse biological communities. Fish play key roles in coral 
reef ecosystems, from herbivorous parrotfish controlling algal overgrowth on corals, to cleaner wrasses removing 
parasites from larger fish and other vertebrates. Many factors can influence reef fish diversity and community 
composition, including wave disturbance, fisheries characteristics, the presence or absence of top predators of 
the food web, and habitat quality and complexity (Grigg 1994; Friedlander et al. 2002, 2003). Threats, such as 
overfishing, habitat degradation from coral bleaching and coastal development, and negative interactions with 
invasive organisms also shape fish communities. 

In light of some of these threats and ecological considerations, your working group identified 13 priority fish 
species vital to reef health and ecosystem functioning, and/or species that are culturally significant or important 
food resources (Figure 1; Gombos et al. 2010; Hawai‘i, NOAA 2014):

1. Achilles tang / Pāku‘iku‘i (Acanthurus achilles) 
2. Eyestripe surgeonfish / Palani (Acanthurus dussumieri)
3. Convict surgeonfish / Manini (Acanthurus triostegus)
4. Bluefin trevally / Ulua ‘ōmilu (Caranx melampygus)
5. Pacific bullethead parrotfish / Uhu (Chlorurus spilurus)
6. Yellowfin goatfish / Weke‘ula (Mulloidicthys vanicolensis)
7. Bluespine unicornfish / Kala (Naso unicornis)
8. Whitesaddle goatfish / Kūmū (Parupeneus porphyreus)
9. Sixfinger threadfin / Moi (Polydactylus sexfilis)
10. Ember parrotfish / Uhu pālukaluka (Scarus rubroviolaceus)
11. Green jobfish / Uku (Aprion virescens)
12. Island trevally / Papa Ulua (Carangoides orthogrammus)
13. Scalloped hammerhead shark / Manō Kihikihi (Sphyrna lewini)

Conducting Ecological Assessments
Your working group will be making recommendations for protecting sites that include the above fish, but before 
you do so, you need to know which sites have these fish! Assessing the ecological conditions (including correctly 
identifying species in specific areas) is an important part of the process when prioritizing sites for protection (Bik 
et al. 2012; Bohmann et al. 2014). A common way to characterize fish communities in reef systems is to do a visual 
survey, such as a stationary point count (Figure 2). In this type of survey, divers count and classify the fish based 
on morphological features within a defined area. However, the divers may not observe cryptic (secretive), small, 
or nocturnal (active at night) species that are present in the environment. Therefore, scientists are starting to 
incorporate standardized DNA-based methods to aid in fish species detection and identification on coral reefs for 
surveying biodiversity.

Environmental DNA
Thanks to recent advances in DNA-based technologies, scientists can now identify species and assess biodiversity 
by analyzing environmental DNA (eDNA)—traces of genetic material present in an environmental sample. The 
process of analyzing eDNA (outlined in Figure 3 below) uses genetic techniques to identify organisms in a water 
sample based on the DNA they shed into the environment. This alternative method can be applied to many 
conservation scenarios, including biomonitoring and invasive species detection. For more examples of eDNA 
applications for marine conservation, see Box 1. 
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Figure 1: Collage of the 13 priority fish species. Top row (L-R): Achilles tang; eyestripe surgeonfish; convict surgeonfish; bluefin 
trevally. Middle row (L-R): Pacific bullethead parrotfish; yellowfin goatfish; bluespine unicornfish; whitesaddle goatfish; sixfinger 
threadfin. Bottom row (L-R): ember parrotfish; green jobfish; island trevally; scalloped hammerhead shark. Photo credits: top row: 
NOAA Photo Library (CC BY 2.0); Makuahine Pa'i Ki'i/Flickr (CC BY 2.0); brian.gratwicke/ Wikimedia Commons (CC BY 2.0); Paul 
Asman and Jill Lenoble/Wikimedia Commons (CC BY 2.0). Middle row: Rickard Zerpe/ Wikimedia Commons (CC BY 2.0); NOAA Photo 
Library; zsispeo/Flickr (CC BY-NC-SA 2.0); NOAA Photo Library; NOAA Photo Library. Bottom row: Derek Keats/Flickr (CC BY 2.0); 
Mark Rosenstein/iNaturalist (CC BY-NC-ND 4.0); Rickard Zerpe/Flickr (CC BY 2.0); ErikvanB/Wikimedia Commons (CC BY-SA 4.0).

In marine studies, environmental samples are typically filtered collections of seawater that can contain a complex 
mix of genetic material from skin cells, scales, secretions, or excretions from organisms that were present 
around the time the sample was collected (Barnes and Turner 2016). The genetic material in these samples is 
concentrated by running the seawater through special filter paper (Figure 4), which is then preserved and brought 
to a lab for DNA extraction. The extracted DNA (millions of DNA fragments in a single sample!) can be processed 
in different ways. For example, if researchers are interested in better understanding what species are present in 
an area, they might employ metabarcoding to determine what DNA is present in a water sample. Metabarcoding 
uses PCR to amplify a genetic fragment that is found within many species, but each species has a unique version 
(a unique “fingerprint” or “barcode”). These genetic fragments from many different organisms are sequenced (the 
nucleic acid order is determined) at the same time.

Then with the use of a computer, researchers can identify species by comparing the sequences from the water 
sample to a database of sequences from known organisms (Figure 5). This identification step relies on databases 
of sequences, known as “reference libraries,” such as GenBank (www.ncbi.nlm.nih.gov/genbank/), which is an 
open-access database of millions of genetic sequences from thousands of organisms. If there is no available 
reference sequence for a species, a positive identification of that species cannot be made (there is nothing for the 
eDNA sequence to be compared to!). Knowing the taxa (species or groups of species) that are present in a sample 
can help researchers to monitor organisms (biomonitoring), including detecting invasive species and priority 
species (Box 1).

http://www.ncbi.nlm.nih.gov/genbank/
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Figure 2. Left: An example of a fish and habitat data collection sheet from a Stationary Point Count (SPC) survey. Right: A diver using 
the SPC underwater visual census (UVC) method to survey coral reef fishes at a particular site. In this method, divers remain still at 
a fixed point underwater as they record the number, size, and species names of all fishes observed during a set period of time within 
a predetermined “cylinder” of the water column. Image credits (L-R): NOAA Coral Reef Ecosystem Program (CREP); NOAA photo by 
Paula Ayotte.
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Sample 
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Figure 3. The overall workflow of aquatic eDNA studies. Water is collected and passed through a filter to “trap” the DNA found in the 
sample. DNA is then extracted from the filter, and a targeted section of the DNA is amplified to make many copies using Polymerase 
Chain Reaction (PCR). Once these copies have been made, the DNA is sequenced. Next, the sequences are reviewed for quality and 
organized using computer software, and then matched against known sequences linked to individual species that are stored in an 
online database. Image credit: Nadav Gazit/AMNH.
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Figure 4. Filtering seawater samples in a 
lab. Photo credit: NOAA fisheries. 

Figure 5. What is eDNA? DNA barcodes are akin to genetic fingerprints for a species. The process of DNA barcoding involves samples 
collected directly from the species of interest and builds a genetic database of known species against which new samples can be 
compared. Metabarcoding is a process where genetic information from many different organisms is sequenced at the same time, 
and species are identified comparing these to a database of known sequences. Environmental DNA uses metabarcoding to identify 
the genetic material of organisms in an environmental sample. Image credit: Natalie Renier and Eric S. Taylor, WHOI Creative (www.
whoi.edu/oceanus/feature/round-up-the-unusual-suspects/). 

Barcoding
Scientists find diagnostic DNA sequences 
called barcodes that they use like fingerprints 
to identify individual species.

Metabarcoding
Metabarcoding is a technique to efficiently 
find many barcodes from many different 
organisms at one time.

eDNA
Scientists collect “environmental DNA” in 
water samples and use metabarcoding to 
identify what animals have been there.

https://www.whoi.edu/oceanus/feature/round-up-the-unusual-suspects/
https://www.whoi.edu/oceanus/feature/round-up-the-unusual-suspects/
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Environmental DNA can be used to monitor individual species of management 
interest, such as the crown-of-thorns seastar (COTS; Acanthaster planci), which 
decimates reefs as it feeds directly on corals. During the most recent COTS outbreak 
in the Great Barrier Reef, ecological monitoring failed to detect early outbreak stages, 
leading to 42% loss of all coral cover. Researchers have since developed a digital 
droplet PCR-based method for early detection of outbreaks, providing managers with 
more time for intervention against this ecologically disruptive species (Uthicke et al. 
2018). Photo credit: Johan J.Ingles-Le Nobel/Flickr (CC BY-ND 2.0).

Environmental DNA can be used to survey groups of species. In a species-rich sea off 
the coast of Japan, researchers using eDNA detected 62.5% of fish species that were 
observed by visual census, while also detecting another 23 species not documented 
by visual census (Yaramoto et al. 2017). When comparing the 6-hour collection of 
water samples to the 14-year period of visual census, eDNA shows considerable 
advantages in time investment compared to conventional methods. Image credit: 
Yamamoto et al. 2017.

Environmental DNA can be used for broad biodiversity assessments. Researchers 
in the Red Sea detected a diverse set of small, often well-hidden species while 
characterizing the rich animal community of these reefs (Carvalho et al. 2019). 
The ability to distinguish among elusive and seemingly identical species provides 
researchers and managers with valuable new information. Photo credit: Derek Keats/
Flickr (CC BY 2.0). 

Detecting Priority Taxa for Conservation: The Case of Hawaiian Coral Reef Fishes 
Fishes represent one of the success stories for eDNA in terms of detecting target taxa and estimating relative 
abundance (Takahara et al. 2012; Kelly et al. 2014; Valentini et al. 2016; Yamamoto et al. 2017). However, despite 
its utility, eDNA technology is not yet widely used to support marine protected area selection. Visual surveys 
conducted by divers are still the go-to method for collecting census data on fish species. 

The Hawaiian Islands offer a natural laboratory for detecting target fish and investigating patterns of coral 
reef fish diversity through eDNA approaches because previous research and monitoring in Hawai‘i (Grigg 1994; 
Friedlander et al. 2002, 2003) provide a comprehensive baseline against which to fine-tune eDNA analysis. 

As mentioned earlier in this exercise, you have been invited to a fictional meeting in Hawai‘i to conduct marine 
reserve planning. While there are many working groups at this meeting considering a wide variety of dimensions 
within marine reserve planning, your working group is focused on ensuring that the 13 priority coral reef fish 
species identified are included in the site selection process. Your working group is tasked with designing a marine 
protected area system that:

1. Enhances species representation by ensuring that all 13 priority species are included at least once; and 
2. Minimizes the total number of sites in the reserve system due to budgetary constraints.
 
The basic procedure you will follow below (Parts B and C) is a simplified example of a more complex process of 
marine reserve planning and site selection, which is often carried out with the help of software programs and is 
typically influenced by the priorities and constraints of the decisionmakers involved. 

Box 1: Example Applications of eDNA in Marine Conservation
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Part A: Learning about Hawaiian Coral Reef Fishes
The instructor will first assign priority fish species. Students will work in pairs or in groups to familiarize 
themselves with their assigned target species by researching and summarizing in table format information that 
addresses: Where do they occur? What is their conservation status on the US Endangered Species list or the 
IUCN Red List, if applicable? What are their habitat preferences? Why were they targeted for monitoring and 
management? 
 
These sites may be useful in your research:
• fishbase.org: A global fish species database with taxonomy, geographical distribution, biometrics and 

morphology, behavior and habitats, ecology and population dynamics as well as reproductive, metabolic, and 
genetic data.

• iucnredlist.org: A comprehensive inventory of the global conservation status of biological species, including 
information similar to FishBase.

• obis.org: Ocean Biogeographic Information System, a web-based portal for information about the distribution 
and abundance of ocean species.

 
The first species has been filled out for you:

Acanthurus achilles
 
(Achilles tang)
 
Pāku‘iku‘i

1. Central & Western Pacific, limited in eastern Pacific, concentrated in south-central Pacific; concentrated in 
Main Hawaiian Islands, but also present in Northwestern Hawaiian Islands.

2. IUCN Least Concern; listed by Hawai‘i DLNR as a Regulated Species under O‘ahu Aquarium Fishing Rules.
3. Benthopelagic, occurring mostly in groups in clear seaward reefs, often in shallow water (<5m) exposed to 

wave action. 
4. Exploited extensively as ornamental catch in aquarium trade; popular food fish in western Hawai‘i.

Reason for Priority Status: control of turf algae; catch for the aquarium trade.

Part B. Designating Sites for Protection Using Visual Survey Data
At the meeting, researchers from the National Oceanic and Atmospheric Administration (NOAA) have provided 
your working group with occurrence data for the 13 priority fish species from a survey effort conducted during 
their coral reef ecosystem monitoring program (Table 1). To create this occurrence data table, NOAA divers skilled 
in taxonomic identification performed stationary-point-count visual surveys (Figure 2) at the nine sites flagged as 
potential locations for protected designation (Figure 6). 

Review the occurrence data from the following nine sites (A through I) outlined in Table 1. Can you achieve the 
two above goals of minimizing the total number of sites while also making sure all species are represented in your 
final site selection?

Which sites would you select for MPA designation and why?

Part C: Using eDNA Data
A PhD student from a local university is in attendance at the meeting, just back from spending the field season 
collaborating with NOAA scientists on reef monitoring projects. Eager to test out her lab’s newly acquired 
thermocycler (a machine used to amplify segments of DNA via PCR) and sequencer, she collected water samples 
at each of the nine sites while the visual fish surveys were occurring. She then isolated the DNA and promptly 
sent the samples back to her lab for amplification and sequencing analysis. She hasn’t had a chance to fully 
analyze the resulting data yet—at this point, she just has sets of sequences from each of the sites—but she’s 
happy to share these data with your working group (see Appendix I: eDNA Hawai‘i Fish Sequences). Could her 
data give us new information?

http://fishbase.org/search.php
http://www.iucnredlist.org/
http://www.iobis.org/
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Site A

Site B

Site C

N

Site D
Site E

Kauaʻi

Oʻahu
Maui

Big Island

Site F

Site G

Site H

Site I

100 miles

Pacific Ocean

Pacific Ocean

Figure 6. Locations of fictional sites A through I, identified as possible locations for protected designation throughout the Hawaiian 
Archipelago. Sites A-D are located in the Northwestern Hawaiian Islands, while sites E-I are located in the Main Hawaiian Islands. 
Names of several Main Islands are provided for reference. Global view (inset image) shows archipelago location in the Central 
Pacific. Image credit: Google Earth.

FISH SPECIES SITE
A B C D E F G H I

Achilles tang (Acanthurus achilles) Y N Y N N N Y N Y

Eyestripe surgeonfish (Acanthurus dussumieri) N N Y Y N Y Y Y Y

Convict surgeonfish (Acanthurus triostegus) Y N N Y Y N Y Y Y

Bluefin trevally (Caranx melampygus) Y Y Y N N N N N N

Bullethead parrotfish (Chlorurus spilurus) Y N Y N Y Y N N N

Yellowfin goatfish (Mulloidicthys vanicolensis) N Y N Y N Y N N N

Bluespine unicornfish (Naso unicornis) Y N N Y N N Y N N

Whitesaddle goatfish (Parupeneus porphyreus) N N N N Y N N N N

Sixfinger threadfin (Polydactylus sexfilis) N Y N N N Y N N N

Ember parrotfish (Scarus rubroviolaceus) Y N N N Y Y N Y N

Green jobfish (Aprion virescens) Y N N Y Y N Y Y Y

Island trevally (Carangoides orthogrammus) Y N N N N N Y Y N

Scalloped hammerhead (Sphyrna lewini) N Y Y Y N Y N N Y

Total number of species present at each site 8 4 5 6 5 6 6 5 5

Table 1. Characteristics of the nine fictional marine sites, as determined by stationary point count (SPC) visual survey. The 
occurrence of each priority fish species at every site is entered as “Y” if the group is found there, and “N” if not. 

In order to determine if the eDNA is helpful, you will use the reference sequence data derived from eDNA samples 
to identify the fish species present at each site. The National Center for Biotechnology Information’s (NCBI) Basic 
Local Alignment Search Tool (BLAST) is a useful tool for this task: BLAST identifies regions of similarity between 

BLAST the Sequences!
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sequences and compares the provided sequence with sequence databases to calculate the statistical significance 
of matches. To get started, visit: blast.ncbi.nlm.nih.gov/Blast.cgi (Figure 7).

Figure 7. The National Center for Biotechnology Information (NCBI) Basic Local Alignment Search Tool (BLAST) landing page. Click on 
“Nucleotide BLAST” to access the Standard Nucleotide BLAST page. 

Using the provided reference sequence data in Appendix I, identify all of the fish species present from the water 
sample collected from each of the nine sites to create a new occurrence table (Table 2). Note: water samples 
may not include DNA from every species that is present at the site, it is just an inventory of the DNA that was in 
the sample. The absence of a species’ DNA in a sample doesn’t necessarily mean the absence of that species at 
a site; the species could be there, but just not detected in that sample. In this way, eDNA results can represent 
a minimum list of species that are actually present at the site. On the other hand, the presence of DNA from 
a particular species is a good indicator that that species is actually present—with the understanding that 
contamination could be possible in the collection and lab process, and therefore researchers should follow strict 
laboratory methods and perform re-sampling to confirm results.

Each group of students will receive a set of reference sequences found in the water sample from one of the nine 
sites. As a group, perform a BLAST on each of the eDNA sequences found at your site to determine which species 
were present in the sample, one sequence at a time (Figure 8). Results may take a few moments to load, but this 
step should only take a few minutes. 

Once you BLAST your sequence, a new results page will display (Figure 9). You’ll know it’s a match if the Percent 
Identity is 100% (or whichever reference sequence returns the highest percent identity). In order to confidently 
obtain a species-level ID for an eDNA sequence, there should be at least a 97–98% similarity to a reference 
sequence. At lower levels of similarity (<97%), you may identify the genus of the organism, but likely not the 
species. Use this information to complete your site’s column in Table 2. 

https://blast.ncbi.nlm.nih.gov/Blast.cgi
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Figure 9. Results page. Locate the “Percent Identity” column to select the best match (100% or whichever reference sequence returns 
the highest percentage). 

It is possible that you may get more than one species with a 100% Percent Identity for a reference sequence. This 
could be due to many reasons. For example, the gene region that you are testing may be similar across multiple 
species. For the purpose of this exercise, make note of any time multiple species get 100%—but if one of these 
results is a priority species, record it as an occurrence in Table 2. If you were going to investigate these results 

Figure 8. Enter each sequence individually in the “Enter Query Sequence” box. Then, click the “BLAST” button at the bottom of the 
page. All other default settings can be maintained.
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FISH SPECIES SITE
A B C D E F G H I

Achilles tang (Acanthurus achilles)

Eyestripe surgeonfish (Acanthurus dussumieri)

Convict surgeonfish (Acanthurus triostegus)

Bluefin trevally (Caranx melampygus)

Bullethead parrotfish (Chlorurus spilurus)

Yellowfin goatfish (Mulloidicthys vanicolensis)

Bluespine unicornfish (Naso unicornis)

Whitesaddle goatfish (Parupeneus porphyreus)

Sixfinger threadfin (Polydactylus sexfilis)

Ember parrotfish (Scarus rubroviolaceus)

Green jobfish (Aprion virescens)

Island trevally (Carangoides orthogrammus)

Scalloped hammerhead (Sphyrna lewini)

Total number of species present at each site

Table 2. Characteristics of the nine fictional marine sites, as determined by eDNA data. Mark the occurrence of each priority fish 
species with a “Y” if the species is found there, and “N” if not. 

further, then a possible approach could be to compare the amount of DNA associated with each of those 100% 
matches (which is data not included in this exercise). Alternatively, you may only be able to identify the sequence 
at the genus level.

Once you’ve identified which species are present at your site, complete a new occurrence table as a class (Table 
2).

Part D: Discussion Questions
1. What are some pros and cons of representing a target species only once among these sites? How would your 

analysis be affected if, for example, there was a rare or threatened species at site G?
2. In some case(s), no definitive species match was found in the database. Why might this be the case?
3. In real life, sequencing data is never as clean and clear as the sequencing data presented here. Typically, 

sequencing machines do not read eDNA sequences perfectly, occasionally mistaking a C for a T, for instance 
(though this is often <1% of the time). Additionally, there will even be some variability of the barcode among 
individuals of the same species! How can sequences without 100% identity to a reference still be useful for 
biodiversity assessment?

4. Are there additional biological factors beyond fish presence information that you think should be considered 
to provide a sound scientific basis for reserve selection? 

Do you reach a different conclusion about which sites to prioritize when using eDNA data only? What differences 
did you find between the two datasets? Why might this be the case?

Finally, what sites would you prioritize if you had access to both datasets, and why?
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SECTION 2. BROADENING PERSPECTIVES: AN EXPLORATION OF OTHER APPROACHES TO PROTECTING 
MARINE ECOSYSTEMS
The first section of this exercise took a site-based approach to designating an MPA and your working group 
was focused specifically on identifying sites based on a suite of fish species. However, protected areas can fall 
under many types of conservation and management methods, and MPAs as we have defined them here are just 
one approach to mitigating threats to marine ecosystems and conserving biodiversity. For example, around the 
main islands of Hawai‘i, there are more than eight types of marine managed areas. These areas can range from 
species-specific conservation areas like the federally managed Hawaiian Islands Humpback Whale National 
Marine Sanctuary, to state managed areas with very specific fishing regulations, like Lay Net Fishing Prohibited 
Areas (Figure 10). To explore the locations and different types of marine managed areas in Hawai‘i, check out the 
interactive map produced by the Hawaii Statewide GIS Program: histategis.maps.arcgis.com/apps/webappviewer/
index.html?id=87c5df3d6519482fa860769e33475a26. 

The largest area of marine conservation in Hawai‘i is also the world’s largest: Papahānaumokuākea National 
Monument. To protect a significant part of the unique biological and cultural diversity found here, the 
Papahānaumokuākea National Monument was first established in 2006 and was later expanded to its current 
size—582,578 square miles of the Pacific Ocean—in 2016 (Figure 10). 

This large-scale approach to marine ecosystem protection differs from the criteria laid out in this exercise. Instead 
of minimizing the area under protection while maximizing the number of priority fish protected, a more holistic 
approach was used to argue for the National Monument designation. Papahānaumokuākea is a sacred place; 

Figure 10. Map showing the different types of marine managed areas in Hawai‘i, including the original extent of 
Papahānaumokuākea Marine National Monument and its 2016 expansion. Image credit: NOAA and the State of Hawai‘i (adapted).
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its islands, reefs, atolls, and waters hold great traditional and spiritual importance for Native Hawaiians. Over 
7,000 marine species reside here, including, but not restricted to, the priority species listed in this exercise. The 
Monument is administered jointly by four co-trustees, including federal and state agencies as well as the Office 
of Hawaiian Affairs, a public agency responsible for improving the well-being and representing the interests of the 
Native Hawaiian community. Access to the Monument is limited to specific purposes (e.g., conducting cultural 
practices, habitat restoration, or scientific work). The grand size of Papahānaumokuākea’s protected waters is 
atypical; marine spatial planning and reserve design often operates on a much smaller scale, where connectivity, 
adjacency, complementarity, and metapopulation structure are key elements of reserve design, as is linking 
reserves into a network—as you’ve practiced here in this exercise.

Although most government-managed marine conservation areas are still more focused on specific species or 
practices at individual sites, the more holistic approach of Papahānaumokuākea National Monument builds off of 
a long history of sophisticated, complex coastal and marine resource management systems that Hawaiians have 
been practicing (and continue to practice) since before Western contact. The Hawaiian kapu system—a system 
of rules and regulations embedded in society norms—includes marine customary stewardship practices, such as 
guidelines for fishing activity. Other traditional practices include harvest management focused on maintaining 
habitats and basic processes of important food resources (e.g., not interfering with fish spawning), instead of 
focusing on specific amounts of fish (Friedlander et al. 2013). Additionally, at the local level, land and marine 
resources were and are still managed together under a land unit that stretches from mountain to sea (ahupua‘a). 

Currently, many communities are reviving traditional knowledge to strengthen their influence on marine resources 
(Friedlander et al. 2013). Recent surveys in Hawai‘i show that community-managed areas (using customary 
stewardship practices) can be just as effective as no-take MPAs that are government managed (Vaughan et 
al. 2016), and that a mix of traditional and modern scientific approaches can be used successfully and cost-
effectively to monitor many aspects of fish ecology, such as lunar spawning cycles and seasonal spawning peaks 
(Schemmel et al. 2016). Communities, researchers, and agencies are actively collaborating to explore better ways 
to harmonize customary and state management (Vaughan et al. 2016). 

The success of areas designed, governed, and protected in diverse ways is being recognized outside of Hawai‘i 
as well. The International Union for Conservation of Nature (IUCN), the international body that categorizes 
protected areas and tracks endangered species, has recently recognized that many areas outside national and 
regional protected area networks also contribute to effective biodiversity conservation. This new approach, 
called “other effective area-based conservation measures” (OECMs), recognizes areas where effective long-term 
conservation is implemented by diverse actors, including local communities, Indigenous Peoples, and the private 
sector (IUCN-WCPA 2019). In Hawai‘i, OECMs may help provide better recognition to sites where traditional 
coastal management practices are making a difference for coral reef and coastal conservation.

Reflection Questions
1. List other considerations (beyond diversity of species) that might impact reserve selection. What might 

account for the emphasis on minimizing the number of sites in conservation planning, in this exercise? 
2. If you wanted to consider other approaches to protecting the marine sites you investigated in the first section 

of this exercise, what questions would you ask? What other information would you need?
3. Can you think of some ways that eDNA techniques could contribute to the alternative management 

approaches described in this section?
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RECOMMENDED READING
For further reading on MPA design, refer to NCEP’s modules: Marine Protected Areas and MPA Networks and 
Building Marine Reserve Networks to Fit Multiple Needs: An Introduction to Marine Spatial Planning Using 
SeaSketch.

Papers on Hawaiian customary marine knowledge and management: 
• Vaughan, M.B., B. Thompson, and A.L. Ayers. 2016. Pāwehe Ke Kai a‘o Hā‘ena: creating state law based on 

customary Indigenous norms of coastal management. Society & Natural Resources 30:31–46. 
• Friedlander, A., J.M. Shackeroff, and J.N. Kittinger. 2013. Customary marine resource knowledge and use in 

contemporary Hawai‘i. Pacific Science 67(3):441–460.  

Video on “Hawaiian Culture, Responsibilities of an Ahupua'a, Waimea Valley” by the Hi'ipaka LLC. This video 
covers the functions of an ahupua’a, and provides specific information for one area Waimea, O’ahu, where the 
shoreline is designated as a Marine Life Conservation District.
www.youtube.com/watch?v=ygD5ozXMZsc

NOAA Fisheries blog: “Sea Tales: Monitoring Coral Reef Ecosystems Throughout the Hawaiian Archipelago”
www.fisheries.noaa.gov/science-blog/sea-tales-monitoring-coral-reef-ecosystems-throughout-hawaiian-
archipelago

NOAA Fisheries: Survey Methods 
origin-apps-pifsc.fisheries.noaa.gov/cred/survey_methods.php

Marine National Monuments in the Pacific: NOAA Fisheries
www.fisheries.noaa.gov/pacific-islands/habitat-conservation/marine-national-monuments-pacific

More information on Papahānaumokuākea Marine National Monument and its co-management:  
www.papahanaumokuakea.gov/new-about/management/
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APPENDIX I: eDNA HAWAI‘I FISH SEQUENCES
Reference sequence data from each of the nine sites.

Site A — Eight Sequences
CACCGCGGTTATACGAGAGGCTCAAGTTGACAGACAACGGCGTAAAGCGTGGTTAAGGAAAACATACAACTAAAGCGGAA 
CCTCCTCCTAGCTGTTATACGCTTCCGAGGAAGTGAACCCCAACTACGAAAGTGGCTTTATCTAACCTGAACCCACGAAAGC 
TAAGAAA

CACCGCGGTTATACGAGAGACCCAAGTTGTTAGACGCCGGCGTAAAGAGTGGTTAGGGAAACTCATTCAACTAGAGCCGAA 
CACCTTCAAAGCTGTCATACGCACCCGAAGGTAAGAAGCCCAACTACGAAAGTGGCTTTATGTTAACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGGGTGACTCAAGTTGTTGGTCATCGGCGTAAAGAGTGGTTAAGACAAACTATATATTAAAGCCGAACG 
CCCTCAGAGCCGTTATACGCTTCCGAGGGTAAGAAGTCCAATCACGAAAGTGGCTTTATTGTGTCTGATCCCACGAAAGCTA 
TGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATATTTTACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGGTCAGAAGCCCAATCACGAAAGTGGCTTTAAACTAACTGAACCCACGAAAGC 
TAGGACA

CGACGAGGGCTTAACTGTCTCCTTTCCTAAGTCAATGAAATTGATCTCCCCGTGCAGAAGCGGGGATACACTCATAAGACG 
AGAAGACCCTATGGAGCTTTAGACACTAAAACAGCTCATGTTAAAACCCCTCCCACAAGAGGCCAAACTAGATGACCCCTG 
TCCTATTGTCTTTGGTTGGGGCGACCACGGGGCAACAAAAAACCCCCG

CACCGCGGTTATACGAAAGGCCCAAGTTGAAAAACATTCGGCGTAAAGGGTGGCTAAGGACCTATTTCAAACTAGAGCTGA 
ATTTCTTCAAAGCTGTTATACGCTCATGAAAACTAGAAAATCAACCACGAAAGTGGCTCTAATCCCTCCTGACACCACGAAA 
GCTATGACA

CACCGCGGTTATACGAGAGGCTCAAGTCGACAGACAACGGCGTAAAGAGTGGTTAAGGAAAATATTTAACTAAAGCGGAA 
CACCCTCATAGCTGTTATACGCTTCCGAGGGCATGAACCTCAACTACGAAGGTGGCTTTATACTACCTGAACCCACGAAAGC 
TAAGAAA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA
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Site B — Seven Sequences
CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGAGAGGCCCAAGTTGATAGGTACCGGCGTAAAGGGTGGTTAGGGATAACTATAAAATAAAGCCGAAT 
ATCTTCAACGCTGTTATACGCCCTCGAAGATTCGAAGCCCCATTACGAAAGTAGCTTTACCTTCCCCCGAACCCACGAAAGC 
CAGGGTA

CACCGCGGTTATACGAAAGGCCCAAGTTGAAAAACATTCGGCGTAAAGGGTGGCTAAGGACCTATTTCAAACTAGAGCTGA 
ATTTCTTCAAAGCTGTTATACGCTCATGAAAACTAGAAAATCAACCACGAAAGTGGCTCTAATCCCTCCTGACACCACGAAA 
GCTATGACA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGATAATCGGCGTAAAGAGTGGTTAAGTAATACATTTCACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGATCAGAAGCCCAATCACGAAAGTGGCTTTAAACCAACTGAACCCACGAAAGC 
TAGGGCA

CACCGCGGTTATACGAGAGGCTCAAGTTGACAGACAACGGCGTAAAGCGTGGTTAAGGAAAACATACAACTAAAGCGGAA 
CCTCCTCCTAGCTGTTATACGCTTCCGAGGAAGTGAACCCCAACTACGAAAGTGGCTTTATCTAACCTGAACCCACGAAAGC 
TAAGAAA

CACCGCGGTTATACGAGAGGCCCGAGTTGACAGTCCACGGCGTAAAGGGTGGTTAGGGGATTCTATTAAACTAAAGCCGA 
ACGCTTACAAAGCTGTTATACGCGCACGAAAGTATGAAGATCAACAACGAAAGTAGCTTTATTATACCTGAACCCACGAAAG 
CTAAGAGA

CACCGCGGTTATACGAGTGACTCACATTAACACACCACGGCGTAAAGAGTGATTAAAGAATGACCTCAAACTTACTAAAGTT 
CAGACCTCATAAAGCCGTTATACGCATCCATGAGTAGAATAAACAACAACGAAAGTGACTTTATAAATATAAGAAACCTTGAT 
GTCACGACAGTTGGGACC

Site C — Five Sequences
CGACGAGGGCTTAACTGTCTCCTTTCCTAAGTCAATGAAATTGATCTCCCCGTGCAGAAGCGGGGATACACTCATAAGACG 
AGAAGACCCTATGGAGCTTTAGACACTAAAACAGCTCATGTTAAAACCCCTCCCACAAGAGGCCAAACTAGATGACCCCTG 
TCCTATTGTCTTTGGTTGGGGCGACCACGGGGCAACAAAAAACCCCCG

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATATTTTACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGGTCAGAAGCCCAATCACGAAAGTGGCTTTAAACTAACTGAACCCACGAAAG 
CTAGGACA

CACCGCGGTTATACGAGAGGCTCAAGTTGACAGACAACGGCGTAAAGCGTGGTTAAGGAAAACATACAACTAAAGCGGAA 
CCTCCTCCTAGCTGTTATACGCTTCCGAGGAAGTGAACCCCAACTACGAAAGTGGCTTTATCTAACCTGAACCCACGAAAG 
CTAAGAAA

CACCGCGGTTATACGAGTGACTCACATTAACACACCACGGCGTAAAGAGTGATTAAAGAATGACCTCAAACTTACTAAAGTT 
CAGACCTCATAAAGCCGTTATACGCATCCATGAGTAGAATAAACAACAACGAAAGTGACTTTATAAATATAAGAAACCTTGAT 
GTCACGACAGTTGGGACC

CACCGCGGTTATACGAGAGACCCAAGTTGACAGATAATCGGCGTAAAGAGTGGTTAAGTAATACATTTCACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGATCAGAAGCCCAATCACGAAAGTGGCTTTAAACCAACTGAACCCACGAAAG 
CTAGGGCA
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Site D — Six Sequences

Site E — Four Sequences

CACCGCGGTTATACGGGTGACTCAAGTTGTTGGTCATCGGCGTAAAGAGTGGTTAAGACAAACTATATATTAAAGCCGAACG 
CCCTCAGAGCCGTTATACGCTTCCGAGGGTAAGAAGTCCAATCACGAAAGTGGCTTTATTGTGTCTGATCCCACGAAAGCT 
ATGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGTTAGACGCCGGCGTAAAGAGTGGTTAGGGAAACTCATTCAACTAGAGCCGA 
ACACCTTCAAAGCTGTCATACGCACCCGAAGGTAAGAAGCCCAACTACGAAAGTGGCTTTATGTTAACTGAACCCACGAAA 
GCTAGGGCA

CACCGCGGTTATACGAGTGACTCACATTAACACACCACGGCGTAAAGAGTGATTAAAGAATGACCTCAAACTTACTAAAGTT 
CAGACCTCATAAAGCCGTTATACGCATCCATGAGTAGAATAAACAACAACGAAAGTGACTTTATAAATATAAGAAACCTTGAT 
GTCACGACAGTTGGGACC

CACCGCGGTTATACGAGAGACCCAAGTTGACAGATAATCGGCGTAAAGAGTGGTTAAGTAATACATTTCACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGATCAGAAGCCCAATCACGAAAGTGGCTTTAAACCAACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGAGAGGCCCAAGTTGATAGGTACCGGCGTAAAGGGTGGTTAGGGATAACTATAAAATAAAGCCGAAT 
ATCTTCAACGCTGTTATACGCCCTCGAAGATTCGAAGCCCCATTACGAAAGTAGCTTTACCTTCCCCCGAACCCACGAAAGC 
CAGGGTA

CGACGAGGGCTTAACTGTCTCCTTTCCTAAGTCAATGAAATTGATCTCCCCGTGCAGAAGCGGGGATACACTCATAAGACG 
AGAAGACCCTATGGAGCTTTAGACACTAAAACAGCTCATGTTAAAACCCCTCCCACAAGAGGCCAAACTAGATGACCCCTG 
TCCTATTGTCTTTGGTTGGGGCGACCACGGGGCAACAAAAAACCCCCG

CACCGCGGTTATACGGGTGACTCAAGTTGTTGGTCATCGGCGTAAAGAGTGGTTAAGACAAACTATATATTAAAGCCGAACG 
CCCTCAGAGCCGTTATACGCTTCCGAGGGTAAGAAGTCCAATCACGAAAGTGGCTTTATTGTGTCTGATCCCACGAAAGCT 
ATGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGAAAGGCCCAAGTTGAAAAACATTCGGCGTAAAGGGTGGCTAAGGACCTATTTCAAACTAGAGCTGA 
ATTTCTTCAAAGCTGTTATACGCTCATGAAAACTAGAAAATCAACCACGAAAGTGGCTCTAATCCCTCCTGACACCACGAAA 
GCTATGACA
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Site F — Five Sequences

Site G — Six Sequences

CACCGCGGTTATACGAGTGACTCACATTAACACACCACGGCGTAAAGAGTGATTAAAGAATGACCTCAAACTTACTAAAGTT 
CAGACCTCATAAAGCCGTTATACGCATCCATGAGTAGAATAAACAACAACGAAAGTGACTTTATAAATATAAGAAACCTTGAT 
GTCACGACAGTTGGGACC

CACCGCGGTTATACGAGAGACCCAAGTTGACAGATAATCGGCGTAAAGAGTGGTTAAGTAATACATTTCACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGATCAGAAGCCCAATCACGAAAGTGGCTTTAAACCAACTGAACCCACGAAA 
GCTAGGGCA

CACCGCGGTTATACGAGAGGCCCAAGTTGATAGGTACCGGCGTAAAGGGTGGTTAGGGATAACTATAAAATAAAGCCGAAT 
ATCTTCAACGCTGTTATACGCCCTCGAAGATTCGAAGCCCCATTACGAAAGTAGCTTTACCTTCCCCCGAACCCACGAAAGC 
CAGGGTA

CACCGCGGTTATACGGGTGACTCAAGTTGTTGGTCATCGGCGTAAAGAGTGGTTAAGACAAACTATATATTAAAGCCGAACG 
CCCTCAGAGCCGTTATACGCTTCCGAGGGTAAGAAGTCCAATCACGAAAGTGGCTTTATTGTGTCTGATCCCACGAAAGCT 
ATGGCA

CACCGCGGTTATACGAAAGGCCCAAGTTGAAAAACATTCGGCGTAAAGGGTGGCTAAGGACCTATTTCAAACTAGAGCTGA 
ATTTCTTCAAAGCTGTTATACGCTCATGAAAACTAGAAAATCAACCACGAAAGTGGCTCTAATCCCTCCTGACACCACGAAA 
GCTATGACA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA

CGACGAGGGCTTAACTGTCTCCTTTCCTAAGTCAATGAAATTGATCTCCCCGTGCAGAAGCGGGGATACACTCATAAGACG 
AGAAGACCCTATGGAGCTTTAGACACTAAAACAGCTCATGTTAAAACCCCTCCCACAAGAGGCCAAACTAGATGACCCCTG 
TCCTATTGTCTTTGGTTGGGGCGACCACGGGGCAACAAAAAACCCCCG

CACCGCGGTTATACGAGAGGCTCAAGTCGACAGACAACGGCGTAAAGAGTGGTTAAGGAAAATATTTAACTAAAGCGGAA 
CACCCTCATAGCTGTTATACGCTTCCGAGGGCATGAACCTCAACTACGAAGGTGGCTTTATACTACCTGAACCCACGAAAGC 
TAAGAAA

CACCGCGGTTATACGAGAGGCCCGAGTTGACAGTCCACGGCGTAAAGGGTGGTTAGGGGATTCTATTAAACTAAAGCCGA 
ACGCTTACAAAGCTGTTATACGCGCACGAAAGTATGAAGATCAACAACGAAAGTAGCTTTATTATACCTGAACCCACGAAAG 
CTAAGAGA

CACCGCGGTTATACGAGAGACCCAAGTTGTTAGACGCCGGCGTAAAGAGTGGTTAGGGAAACTCATTCAACTAGAGCCGA 
ACACCTTCAAAGCTGTCATACGCACCCGAAGGTAAGAAGCCCAACTACGAAAGTGGCTTTATGTTAACTGAACCCACGAAA 
GCTAGGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATATTTTACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGGTCAGAAGCCCAATCACGAAAGTGGCTTTAAACTAACTGAACCCACGAAAGC 
TAGGACA
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Site H — Five Sequences

Site I — Five Sequences

CACCGCGGTTATACGAAAGGCCCAAGTTGAAAAACATTCGGCGTAAAGGGTGGCTAAGGACCTATTTCAAACTAGAGCTGA 
ATTTCTTCAAAGCTGTTATACGCTCATGAAAACTAGAAAATCAACCACGAAAGTGGCTCTAATCCCTCCTGACACCACGAAA 
GCTATGACA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATATTTTACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGGTCAGAAGCCCAATCACGAAAGTGGCTTTAAACTAACTGAACCCACGAAAGC 
TAGGACA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGATAATCGGCGTAAAGAGTGGTTAAGTAATACATTTCACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGATCAGAAGCCCAATCACGAAAGTGGCTTTAAACCAACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGGGTGACTCAAGTTGTTGGTCATCGGCGTAAAGAGTGGTTAAGACAAACTATATATTAAAGCCGAACG 
CCCTCAGAGCCGTTATACGCTTCCGAGGGTAAGAAGTCCAATCACGAAAGTGGCTTTATTGTGTCTGATCCCACGAAAGCTA 
TGGCA

CACCGCGGTTATACGAGTGACTCACATTAACACACCACGGCGTAAAGAGTGATTAAAGAATGACCTCAAACTTACTAAAGTT 
CAGACCTCATAAAGCCGTTATACGCATCCATGAGTAGAATAAACAACAACGAAAGTGACTTTATAAATATAAGAAACCTTGAT 
GTCACGACAGTTGGGACC

CACCGCGGTTATACGAGAGACCCAAGTTGACAGACAATCGGCGTAAAGAGTGGTTAAGTACTATACCCTACTAAAGCCAAA 
CACCTTCAAAGCTGTTATACGCACCCGAAGGTTAGAAGCCCAATCACGAAAGTGGCTTTAAACTTACTGAACCCACGAAAG 
CTAGGGCA

CACCGCGGTTATACGAGAGACCCAAGTTGACAGATAATCGGCGTAAAGAGTGGTTAAGTAATACATTTCACTAAAGCCAAAC 
ACCTTCAAAGCTGTTATACGCACCCGAAGATCAGAAGCCCAATCACGAAAGTGGCTTTAAACCAACTGAACCCACGAAAGC 
TAGGGCA

CACCGCGGTTATACGAGAGGCTCAAGTCGACAGACAACGGCGTAAAGAGTGGTTAAGGAAAATATTTAACTAAAGCGGAA 
CACCCTCATAGCTGTTATACGCTTCCGAGGGCATGAACCTCAACTACGAAGGTGGCTTTATACTACCTGAACCCACGAAAGC 
TAAGAAA

CACCGCGGTTATACGGGTGACTCAAGTTGTTGGTCATCGGCGTAAAGAGTGGTTAAGACAAACTATATATTAAAGCCGAACG 
CCCTCAGAGCCGTTATACGCTTCCGAGGGTAAGAAGTCCAATCACGAAAGTGGCTTTATTGTGTCTGATCCCACGAAAGCTA 
TGGCA
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ABSTRACT

BATS! THE BASICS 

Bats have existed on earth for at least 50 million years and during that time, different species have evolved to fit 
in diverse environments and ecological niches. Bats are the only group of mammals with “true powered flight,” 
meaning they can flap their wings and propel themselves through the air (versus glide). Scientists believe that it 
is this unique ability that’s facilitated their speciation and wide distribution around the globe. Yet while bats are 
seemingly everywhere, their numbers are also declining, often due to human actions. This synthesis covers the 
basic biology and ecology of bats, the ecosystem services they provide, the threats they face globally, and how 
conservation actions can mitigate these threats.

Of the 6,500 or so different mammal species on the earth, approximately 1,406 are from one group—bats! (Burgin 
et al. 2018; Simmons and Cirranello 2019). That means over 20% of known mammal diversity are bats. 

Bats are like other mammals in that they are endotherms (or regulate their body temperature internally through 
metabolic processes) and they have hair (though some baby bats are notably hairless). Also, like other mammals, 
bats have mammary glands and feed their young with milk (fun fact—their nipples are in their armpits!) (Wilson 
1997). What makes bats truly unique from other mammals though, is their ability to fly. Bats are collectively 
known as the order Chiropetra, which means “hand wings” because their forelimb digits (like our fingers) have a 
membrane between them that creates wings (Taylor and Tuttle 2019). Other mammals, such as flying squirrels 
and sugar gliders, have mastered the ability to glide through the air after jumping from high places thanks to 
membranes connecting their forelimbs and hindlimbs, but bats are the only group of mammals that have “true 
powered flight,” meaning they can flap their wings and propel themselves through the air (Taylor and Tuttle 2019). 

Although bats do have good eyesight (about the same as human eyesighti), some bats also have the ability 
to echolocate—they emit high-pitched sounds and sense the echoes of the sound off of the objects in the 
environment—which greatly improves their ability to fly during the night. This "bio sonar" allows bats to hunt prey 
in low (or no) light, detect obstacles, and navigate home to their roosts (where they sleep, take care of young, and 
where they might hibernate). Because they fly at night, bats are less likely to compete with or be hunted by most 
birds, which fly more frequently during the day. (Interestingly, there are four known bat species that hunt during 
the day, but they are only found on islands where predators are most likely absent; Rehm 2018). This reduction 
in competition and predation pressure has provided an opportunity for bats to thrive. Scientists believe that it is 
bats’ unique ability to fly that’s facilitated their speciation (the formation of new species through evolution) and 
their wide distribution around the globe (Taylor and Tuttle 2019). 

But where are all these bat species? Have you seen a bat in the wild before? Even if you haven't, that doesn’t 
mean they aren’t nearby; bats are basically everywhere, with the exception of some remote islands and the polar 
regions. However, even though bats as a group are found on six of the seven continents, their diversity is not 
evenly spread out and some distribution patterns are evident—for example, the greatest number of species of bats 
(known as “species richness”) are found in the tropics (Figure 1; BCI 2019a).

iSome might argue that bats see “better” than humans because, unlike humans, many bats can see into the UV range of light (see Gorresen, 
P.M., P.M. Cryan, D.C. Dalton, S. Wolf, and F.J. Bonaccorso 2015. Ultraviolet vision may be widespread in bats. Acta Chiropterologica 
17(1):193–198).
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Despite this pattern of more bat species found in tropical regions, bats can be found in diverse habitats such as 
arid deserts, temperate forests, and even cities! Nor are they restricted to caves, as you might think. Bats can 
roost in other natural structures such as rock and cliff crevices and trees, but also in human-constructed mines, 
roofs and attics, stadiums, bridges and more (BCI 2019a). 

Bats have existed on earth for at least 50 million years and during that time, different species have evolved 
to fit in differing environments and ecological niches. The difference between species includes not only their 
appearance, but also their diets and behaviors. For example, the bumblebee bat (scientific name, Craseonycteris 
thonglongyai, and also called the Hog-nosed Bat and Kitti’s Hog-nosed Bat) is considered the smallest bat in the 
world; it is smaller than your thumb and weighs less than a US penny (2.5 g) (Figure 2A; Taylor and Tuttle 2019; 
BCI 2019b). It is only known to roost within 43 different caves in Southeast Asia (Myanmar and Thailand), and 
feeds exclusively on insects (an insectivore) within a 1 km radius of its roosting cave (Taylor and Tuttle 2019). In 
comparison, another bat found in Southeast Asia, the large flying fox (scientific name, Pteropus vampyrus, and 
also called the Malayan flying fox, kalang, or kalong) is one of the largest bats in the world with a wingspan of up 
to five feet (~1.5 m), and it roosts in trees and eats fruits (a frugivore) (Figure 2B; Taylor and Tuttle 2019). 

Bats can vary in color and color patterns, and have a wide variety of shapes (morphologies) of their face and ears 
(Figure 3). All of these differences are the result of evolution over large time scales (i.e., hundreds of thousands of 
years), leading to adaptations to different types of landscapes and communities of species (like the types of food 
and predators in an area). To get an inside look on how scientists study bat evolution, check out this video: www.
amnh.org/explore/videos/shelf-life/shelf-life-14-into-the-island-of-bats.

According to Taylor and Tuttle (2019), until relatively recently, bats have traditionally been placed into two groups 
based on differences in their appearance and biology: the microbats (like the Bumblebee Bat) and the megabats 

Figure 1. Map of bat species richness. Bats are not found in Antarctica, the Arctic, and gaps in distributions elsewhere are often are 
associated with high mountain ranges and desert regions. Image credit: C.N. Jenkins/Instituto de Pesquisas Ecológicas (map based 
on IUCN March 2018 data) biodiversitymapping.org/wordpress/index.php/mammals/.

Chiroptera (Bats)

Species
120
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https://www.amnh.org/explore/videos/shelf-life/shelf-life-14-into-the-island-of-bats
https://www.amnh.org/explore/videos/shelf-life/shelf-life-14-into-the-island-of-bats
https://biodiversitymapping.org/wordpress/index.php/mammals/
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Figure 2. Compare the wingspans! A large flying fox’s (B) wingspan is almost as long as 10 bumblebee bats (A)! Photo credit: (A) Jerry 
Oldenettel/Flickr (CC BY-NY-SA 2.0), (B) Momotarou2012/Wikimedia Commons (CC BY-SA 3.0).

Figure 3. Bats don’t all look or act the same. (A) Honduran White Bats (Ectophylla alba) are all white with yellow snouts and ears 
and they roost in “tents” they make from large leaves. (B) Spotted Bats (Euderma maculatum) have pink wings, ears nearly as long as 
their bodies, and are known to roost on cliffs along the Grand Canyon among other places. (C) Pale Spear-nosed Bats (Phyllostomus 
discolor) have a fleshy appendage on their noses called a “nose-leaf” which may help with echolocation and they roost in hollow 
trees or in caves. Photo credit: (A) Leyo/Wikimedia Commons (CC BY-SA 2.5 ch), (B) Bureau of Land Management/Fickr (CC BY 2.0), 
(C) Karin Schneeberger alias Felineora/Wikimedia Commons (CC BY 3.0).

A B C

A
~17 cm

~1.5 m
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(like the Large Flying Fox). The microbats are smaller (hence “micro”), are often predators that hunt mainly insects 
(but can also hunt other prey such as rats, birds, frogs, other bats, or might also be omnivorous or herbivorous), 
have smaller eyes with short snouts, and sometimes have large ears and fleshy appendages on their noses to 
help with echolocation. The megabats are bigger (“mega”), more likely to feed on fruit or nectar, and have larger 
eyes and elongated snouts. Megabats normally have better eyesight and sense of smell than microbats, to help 
them locate their fruit or nectar food source, and are less reliant on echolocation. Instead of making echolocation 
noises with their larynx as most microbats do, most megabats don’t echolocate at all, or they use tongue-clicking 
or even click their wings to help with navigation (Taylor and Tuttle 2019). 

However, researchers that use genetics to study bats have found that the story is a bit more complicated. In fact, 
some microbats are actually more closely related to megabats than to other microbats! These researchers have 
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suggested two new categories for bats, Yinpterochiroptera and Yangochiroptera, though the common grouping of 
“micro” and “mega” is often still used in non-scientific literature. The relationship between, and evolution of, these 
groups is still being studied, but one thing is for sure—even though some microbats look remarkably like flying 
rodents and some megabats look like primates (e.g., lemurs), bats are not closely related to these groups. Bats 
are actually more closely related to carnivores, hoofed mammals, whales, and pangolins—quite a wide range of 
different evolutionary relatives (Taylor and Tuttle 2019)! 

Regardless of category, all bats require habitat that provides adequate food, water, and places to roost. 
Depending on where a species lives and what they eat, some bats might need to change locations or behaviors 
throughout the year to find and manage the resources they need. For example, some insect-eating bats breed in 
temperate climates but lose their food source during the winter (flying insects that aren’t present in the winter); 
therefore, these bats might either migrate to warmer climates where insects are available year round or might find 
roosting locations that can protect them while they hibernate (i.e., when they reduce their metabolism and living 
off fat stores in their body during winter). In these temperate regions, roosts are also important in the summer 
for rearing young and resting during the daytime. Some roosts can house several species of bats and be used 
year after year, while others might be temporary and only used seasonally. As mentioned earlier, not all roosts 
are large communal caves (like Bracken Cave, see Box 1). In addition to roosting inside or on natural (tree/cliff) 
crevices and human-constructed structures, some bats have been found roosting inside termite nests, colonial 
spider webs, pitcher plants, and even crocodile burrows! A few species even make their own roosts—for example, 
the Honduran White Bats (Ectophylla alba) create shelters by biting and manipulating large leaves to make tents 
(see Figure 3A above; Taylor and Tuttle 2019). 

BATS ARE PART OF THE ECOSYSTEM AND SO ARE WE! 

Pest Control

Bats’ relationships with each other, other species, other groups, and their surrounding environment all contribute 
to their role in their ecosystems. Bats are part of the food web: for example, insectivore bats act as the primary 
predators of night-flying insects, but they themselves also are important prey for animals such as hawks, snakes, 
and other mammals like racoons (Taylor and Tuttle 2019; BCI 2019c). Some bats that live in the tropics contribute 
to the ecosystem in other ways, like pollinating plants and dispersing seeds, which helps plants reproduce and 
helps establish food sources and shelter for other species (BCI 2019c). For example, bats are the main pollinator 
of the great baobab tree, found in the savannahs of East Africa. This species of tree is often called the “African 
Tree of Life” because so many other species depend on it—and in turn, all of those species rely on bats to maintain 
great baobab tree populations (BCI 2019c). More food for thought—have you ever eaten a mango, guava, or 
banana? All of these fruits come from plants that are pollinated by bats (US Forest Service 2019)!

There are other ways that bats help form or shape an ecosystem. For example, the floors of communal roost 
caves are coated in excrement known as guano. Guano provides nutrients for other species—nutrients that 
the cave normally wouldn’t have available. In caves where bats and, consequently, guano are present, complex 
communities form, including species such as beetles, cockroaches, centipedes, and other invertebrates 
(Deharveng and Bedos 2019). If bats were to leave these caves, these ecosystems might not be able to sustain 
themselves.

Humans also benefit from having bats in their ecosystems. “Ecosystem services” are the benefits that humans 
obtain from their ecosystems (IPBES 2019), such as the air we breathe, water we drink, and food we eat. So, what 
are the ecosystem services that bats provide?

The majority of bat species are insectivores and they eat insects such as moths, beetles, flies, and mosquitoes, 
in both land and aquatic ecosystems (Taylor and Tuttle 2019). Some of the insects they eat are considered 
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Bracken Cave in Texas has the largest colony of bats in the world, housing approximately 
10 million Brazilian Free-tailed Bats (Tadarida brasiliensis). Recently scientists clocked the 
Brazilian Free-tailed Bats reaching top speeds of 100 miles per hour (161 km per hour)! These 
bats also reach altitudes of 10,000 ft (3048 m) on migratory flights that can be up to 310 miles 
(498 km) a night. If you are interested, check out a short news clip to see what it looks like 
to be in or near Bracken Cave when bats emerge: https://www.sciencefriday.com/segments/
catching-a-texas-batnado/. 

Most female bats only have one baby (called a pup) a year but invest a lot of time and energy 
into rearing their pup (sometimes with the help of other females in the communal roost).

Some bats, like the “mouse-eared bats” from the genus Myotis, have been recorded to live to 
more than 40 years old.

Wing shape can affect a bat’s flight and hunting abilities: short and wide wings result in agility 
and allow for greater maneuverability at slower speeds. This is good for hunting insects, 
especially in dense areas of trees. Longer and narrower wings lead to faster and more efficient 
flight, which helps with catching fast-flying insects in open areas.

Like amphibians, bats can exchange gas through their skin (i.e., expel carbon dioxide and take 
in oxygen)—up to 10% of total exchange has been observed in the Wahlberg’s Epauletted Fruit 
Bat (Epomophorus wahlbergi).

Fringe-lipped Bats (Trachops cirrhosus) catch frogs on the ground and can identify and avoid 
toxic-bodied species by listening and identifying frogs’ mating calls. Other species of bats are 
fish hunters and grab prey from the under the water’s surface with their large feet.

Most bats don’t drink blood. Only three species of “vampire” bats exist, and they don’t attack 
prey and suck blood. Instead, these bats make a painless incision on the skin of a sleeping 
animal and then lap up the blood that drips out with their tongue. 

Vampire bats are also famous for possibly exhibiting a behavior called altruism (meaning an 
individual helps another at its own expense). The Common Vampire Bat (Desmodus rotundus) 
has been seen returning to roosts and regurgitating blood to other bats, most often to a bat 
it’s related to but also unrelated individuals. Turns out that those who receive meals are more 
likely to pay back the favor and donate meals in the future! To learn more about vampire 
bats and their evolution, check out this video: www.amnh.org/explore/videos/research-and-
collections/molecular-adaptation-in-vampire-bats.

Facts derived from Taylor and Tuttle 2019; Photo credits: (A) National Park Service/public 
domain, (B) Manuel Werner/Wikimedia Commons (CC BY-SA 3.0), (C) Bernard Dupont/
Wikimedia Commons (CC BY-SA 2.0), (D) Karin Schneeberger alias Felineora/Wikimedia 
Commons (CC BY 3.0), (E) Uwe Schmidt/Wikimedia Commons (CC BY-SA 4.0).

Box 1: Bat Facts! Did You Know…?

A. Brazilian Free-tailed 
Bat

B. Greater Mouse-
eared Bat

C. Wahlberg’s 
Epauletted Fruit Bat

D. Fringe-lipped Bat

E. Common Vampire 
Bat

agricultural pests, meaning they damage crops and reduce farmers’ ability to produce high quality food and plant 
products. How much does this matter? Well, for one example, there is an especially pesky moth, called the corn 
earworm moth, that loves to eat commercial plants such as corn, tomatoes, cotton, artichokes, watermelons, and 
more when it is a larva (caterpillar) (Figure 4; BCI 2019c). According to a study done by Josiah Maine and Justin 
Boyles in 2015, worldwide, the cost of crop damage caused by this moth is estimated to be more than one billion 
US dollars (USD) a year! Luckily for the farmers of south-central Texas, each evening millions of Brazilian Free-
tailed Bats emerge from nearby caves like Bracken Cave (see Box 1) and from under bridges (like Congress Avenue 

https://www.sciencefriday.com/segments/catching-a-texas-batnado/
https://www.sciencefriday.com/segments/catching-a-texas-batnado/
http://www.amnh.org/explore/videos/research-and-collections/molecular-adaptation-in-vampire-bats
http://www.amnh.org/explore/videos/research-and-collections/molecular-adaptation-in-vampire-bats
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Bridge in Austin, Texas) to feast on insects, including the corn earworm moth (BCI 2019c; Medellin et al. 2017). In 
2006, Cutler Cleveland, a researcher from Boston University, and his colleagues estimated that for cotton farmers 
in this region alone, this natural pest control was equivalent to USD $741,000 a year. Now consider all of farms 
across North America—scientists estimate that the agricultural benefits bats provide is worth over 3.7 billion US 
dollars each year (Boyles et al. 2011). Not only are bats reducing direct crop damage by eating the pests, their 
service also reduces farmers’ need to apply harmful pesticides, lowering overall monetary and environmental 
costs (BCI 2019c).

Pest control from bats also benefits all of us with protection from pests like mosquitos. Mosquitos are annoying, 
to be sure, but they also can be determintal or even deadly if they carry and spread diseases like malaria, 
zika, and dengue fever, so the reduction in mosquitos that bats provide is also service to human health. 
While mosquitos are not a large part of insectivore bats’ diets, a study determined that when bats predate on 
mosquitos, fewer mosquito eggs are laid—meaning that bats could still help to keep mosquito numbers down 
(Reiskind and Wund 2009).

Figure 4. Control of the corn earworm 
moths! Adult moths are a favorite food of 
many insectivore bats and that’s a good 
thing because if there are fewer moths, 
that means that there are fewer eggs laid 
and fewer larvae (caterpillars) that emerge 
and eat commercially important crops. 
Photo credits: (A) Corn earworm larva: 
Scot Nelson/Flickr (public domain), (B) 
Corn earworm moth: Lon&Queta/Flickr (CC 
BY-NC-SA 2.0), (C) Brazilian free-tailed bat 
eating moth: ©MerlinTuttle.org.

Pollination and Seed Dispersal
When you think of pollinators, you probably think of bees. It’s true that bees are exceptionally important 
pollinators, but nectar-feeding bats also serve this ecological role. Bats are attracted to flowers that have nectar 
and stay open at night. When they burrow their heads in the flower to lap up the sugary snack, their faces get 
covered in pollen from the male organs of the flowers (stamens); they end up transferring that pollen on the next 
flower they visit (on the female organ, the pistil). This process can lead to fertilization which can lead to seeds and 
fruits developing—seeds and fruits that support many other species and help the plants propagate. It is estimated 

©MerlinTuttle.org

A

C
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that over 500 plant species are pollinated by bats (though not necessarily exclusively), and some of those species 
are commercially important crops and products such as agave (the source for tequila), balsa wood, bananas, 
cloves, guava, peaches, and durian (see Figure 5; Taylor and Tuttle 2019; BCI 2019c).

In the tropics, another group of bats (fruit-eating bats) might actually eat the fruits that are produced by plants 
pollinated by nectar-feeding bats! After digesting these fruits, bats will excrete the seeds that were inside the 
fruit in their guano. Moreover, because these bats can fly long distances and defecate while in flight, they often 
deposit seeds far away from the parent plant. This allows for seeding plants to grow away from the competition 
of their parent, and also for the spread of a plant species into new or open areas. Many of the seeds dispersed 
by bats are considered “pioneer” plants, meaning they are hardy and able to grow in areas that might be hotter 
or drier than other nearby areas (like clearings that have relatively few other plants). In some areas, the seeds 
dropped by bats can account for up to 95 percent of new plant growth in a cleared area (BCI 2019c). Once these 
pioneer plants start to grow, the surrounding conditions become less harsh (e.g., shading decreases heat and 
increases moisture), which allows for other less hardy plants to take root and grow, providing more complex 
habitat for other animals. This dispersal of seeds is a critical service for the ecosystem and for humans because 
it assists with the restoration of forests damaged or destroyed by deforestation. Regenerating healthy forest 
ecosystems is a complex process and it’s difficult for humans to accomplish without the help of seeds being 
dispersed by bats and other groups of species like primates, birds, and rodents. 

Note that not all humans are benefited by frugivore bats living nearby. Fruit farmers, for instance, may consider 
bats a pest species because they eat their crops. We’d call this an ecosystem disservice. Unfortunately, the loss of 
bats' natural habitats and food sources (through events such as forest clearing or droughts) intensifies damage to 
crops by fruit-eating bats. There are strategies to help prevent, reduce, or mitigate crop loss due to bats, including 
restricting the clearing of existing habitat for new agriculture and trying to prevent access to existing fruit crops, 
through covering fruits with netted bags, covering trees with netted tents, or covering entire orchards with 
nets supported by frames. These solutions require cooperation at many levels, including farmers, communities, 
governments, and corporations tackling large systemic issues such as climate change and deforestation.

Figure 5. The Dawn Bat (Eonycteris spelaea) is the only effective pollinator of the flowers of the durian tree (A) and the pollination 
of the tree leads to the durian fruit (B)—often considered one of the smelliest fruits in the world. Although not a particularly popular 
fruit in the US, the sweet tasting fruit is very popular in Asia; Thailand alone produces almost 600 million US dollars worth of durian 
each year (Bumrungsri et al. 2009; Ghanem and Voigt 2012). Photo credits: (A) ©MerlinTuttle.org, (B) DXLINH/Wikimedia Commons 
(CC BY-SA 3.0).

©MerlinTuttle.org

A B



56 SYNTHESIS

LESSONS IN CONSERVATION VOLUME 10 JANUARY 2020

Bat Products and Ecotourism

THREATS TO BATS AND HUMAN-BAT INTERACTIONS

Predators

Guano is nutrient rich and therefore considered a valuable natural fertilizer. It can be harvested and sold for 
agricultural purposes—the guano from one cave can yield up to USD $100,000 each year (Taylor and Tuttle 
2019)! Guano is a renewable resource only if harvested sustainably. Harvesting practices that are insensitive 
to bat populations (such as modifying the cave) can be detrimental to bat colonies, leading to their decline or 
abandonment of the caves (Elliot 1994; Hutson et al. 2001). For example, in places like Cuba and Borneo, many 
bat species only roost in “hot caves” that have temperatures up to 40°C (104°F) and relative humidity near 100% 
(Wendel 2015; AMNH 2016). Part of what makes these caves so hot and humid is their shape and dimensions, 
but also the thousands of bats inside and the heat generated by decomposing guano. If the guano is harvested, 
the temperature of the caves could drop and make the cave too cold for the bats, which could lead to a colony 
collapsing. However, not all bats specialize to live in “hot caves” and guano harvesting can provide substantial 
economic benefits for local communities when done responsibly and in consideration of the needs of the 
particular bat species (Taylor and Tuttle 2019). 

Bat products are also advancing medicine. Vampire bats (see Box 1) have anticoagulants in their saliva (named 
“draculin” after the popular character Dracula) that prevent the blood from clotting while they drink (Apitz-Castro 
et al. 1995). Researchers are studying draculin to see how it could be used in medicines to help reduce the risks of 
blood clots which cause strokes (Morgan 2011). 

Finally, a not so well-known or widespread benefit of bats is ecotourism. In a 2013 study, Kenneth Bagstad and 
Ruscena Wiederholt found that over 242,000 annual visitors come to see bats such as the Brazilian Free-tailed 
Bat (see Box 1) at 25 major roosts across six states in the Southwestern US. The authors estimate that tourist 
visitation is worth over $6.5 million US dollars in economic value each year. One of the locations studied was 
Austin, Texas, where thousands of visitors come to view some of the largest-known urban bat colonies emerging 
during summer evenings from their roosts under bridges. Not able to travel to Austin to check it out? Watch this 
short video for an inside look: www.pbs.org/video/the-bat-bridges-of-austin-texas-eaxyxv/.

Most bat species are declining in numbers everywhere they are found (BCI 2019d). In addition to loss of life from 
natural predators, bats are threatened by habitat loss, disturbance while hibernating, disease, wind turbines, 
climate change, and even intentional killing by humans.

Bats are part of the food web—they are predators of other species and they themselves are eaten by other 
species. Birds of prey, cats, and even snakes that hang from tree branches are known to wait outside of roosts 
and snatch the bats as they emerge in the evenings (Figure 6; Taylor and Tuttle 2019). Large swarms of bats 
leaving a cave all at once might seem like a feast to these predators, but this is also a good strategy for bats to 
ensure “safety in numbers”—the probability of any one bat being caught is reduced by the sheer number of other 
bats that are available for the predator.

Free-roaming cats (both pets and feral cats) are efficient predators and often considered an invasive species 
(because humans have assisted them to live in areas that they don’t exist naturally, allowing cats to prey on 
species that did not naturally evolve to avoid or defend against them). Have a pet cat? To help wildlife in your 
area, consider neutering your cat to help reduce the number of feral cats and keeping your pet cat inside. Want a 
cat? Consider adopting a cat that might otherwise be free-roaming.

Hibernation is also a time when bats are prone to mortality events. Some predators have specialized in raiding 
bat roosts and eating the bats while they hibernate. For example, raccoons in North America prey on hibernating 

https://www.pbs.org/video/the-bat-bridges-of-austin-texas-eaxyxv/
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Diseases 

Figure 6. (A) A black rat snake eating a brown bat. (B) A feral cat in New Zealand and some of the remains of 107 dead short-tailed 
bats. Photo credits: (A) Zack Bittner/Flickr (CC BY-NC-SA 2.0), (B) Department of Conservation (NZ) (CC BY 4.0).

bats and wood mice in the Netherlands have been observed cracking open the skulls of hibernating bats, like 
nut shells, and eating their brains (Moseley et al. 2013; Haarsma and Kaal 2016)! The bats—in a basically non-
animated state of hibernation—are unable to fly away, defend themselves, or warn others of the threats.

In North America, another threat that attacks hibernating bats is the cold-loving fungus, Pseudogymnoascus 
destructans, which causes the disease White-nose Syndrome (WNS) (BCI 2019d). This disease is called White-
nose Syndrome because a tell-tale sign that a bat has contracted the disease is a white fuzzy growth, often on 
their noses (Figure 7). An infection can lead to bats waking up early from their hibernation state and subsequently 
starving because they don’t have the enough reserves stored up in their body to sustain a calorie costly non-
hibernation metabolism (Frick et al. 2016). While this fungus is commonly found in Europe and Asia, bats there 
seem to be resistant to its effects. This is most likely because those species evolved with the fungus present, 
allowing individuals who were resistant to survive and, generation after generation, pass on their successful 
and fungus-resistant genes. Meanwhile, in North America, bat species were not exposed to this fungus and 
did not acquire resistance over evolutionary time. The fungus was first recorded in North America in New York 
in 2006; as of 2019, WNS has been identified in 33 US states, and is estimated to have affected at least 15 
different species, killing up to seven million bats (Taylor and Tuttle 2019). Given that more than half of US bats 
hibernate in caves and mines, and it is these species that are especially susceptible to this disease, WNS could 
be considered the largest threat to North American bats. In some populations in North America, fungus-resistant 
bats appear to be surviving and scientists hope that this natural resistance passes on to new generations, thereby 
preventing the total collapse of colonies and even the extinction of species bats (Langwig et al. 2017; Taylor and 
Tuttle 2019). Unfortunately, the fungus is still spreading to new colonies, and infected bats are being recorded 
each year in areas that the disease wasn’t previously known to occur. If you’d like to learn more about WNS 
including the current extent of the disease, check out the White Nose Syndrome Response Team website www.
whitenosesyndrome.org/ or you also could check out this video called “Battle For Bats: Surviving White Nose 
Syndrome” vimeo.com/76705033.

The WNS outbreak is considered an ecological disaster for North American bats and could have far-reaching 
effects on their ecosystems, but normally, bats are not especially susceptible to diseases. For example, fruit bats 
in Africa and Asia can act as natural reservoirs for certain viruses and diseases because they themselves are 
not affected or are only slightly affected by the infection (Schneeberger and Voigt 2016). Unfortunately, some 
of these pathogens are much more deadly when they pass into human hosts. Ebola, Marburg virus, Nipha virus, 
and other viruses have the potential of spreading from bat hosts to humans or other mammals. The transmission 
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Figure 7. Bats infected with WNS. Photo credit: Government of Alberta/Flickr (CC BY-ND 2.0).

of these viruses is still poorly understood, but there is evidence that diseases can be transmitted to humans 
through interaction with the body fluids of bats (blood, feces, and saliva) (Schneeberger and Voigt 2016). Rabies 
is another example and the only example of a viral disease associated with bats in North America and Europe 
(Schneeberger and Voigt 2016). Like other mammals, bats can contract rabies but it isn’t considered a significant 
source of mortality, and it is rarely transmitted to humans (Taylor and Tuttle 2019). Even if a human is exposed to 
rabies, the probability of getting infected with rabies is virtually to zero if people are treated appropriately with a 
post-exposure vaccine after a bat scratch or bite (Schneeberger and Voigt 2016).

Although people do fear the rare possibility of disease transmission, there are ways to live safely with bats. First 
and foremost, experts say the best preventive measures include not handling bats (dead or alive) or their bodily 
fluids. If there was an instance where you did need to interact with a bat (for example, bats roosting inside your 
home), there are safe ways to deal with these situations that reduce both risks to you and the bats. If you’d like 
to learn more, check out the informative informational guide from PREDICT One Health Consortium: How to Live 
Safely with Bats downloadable at www.ecohealthalliance.org/living-safely-with-bats. 

Loss of Habitat
As with most animals, the largest threat to bats is loss of habitat. Bats have very specific needs, especially 
in relation to roosting habitat, and human activities such as clearing land for agriculture, pastures, human 
developments like cities, and mining operations have all played a part in destroying or degrading areas where bats 
roost (BCI 2019d). Habitat loss can also lead to the reduction of food sources, especially for fruit-eating bats in 
the tropics. This can lead to human-wildlife conflict: if their natural habitat no longer supports them, these bats 
may depend more heavily on local farmers’ fruit crops. Bats also need adequate water sources. Bats don’t land to 
drink but instead swoop down over open water and scoop up a mouthful of liquid (Taylor and Tuttle 2019). These 
swooping motions require open space above the water, sometimes 13 to 100 feet (4 to 30 meters) in length, and 
landscape alterations that lead to the reduction of open waterways is another threat to bats and their habitat.

Fragmentation of habitat may also require bats to change the way they use their habitat. For example, some bats 
might avoid open areas that make them susceptible to predators and prefer to stay within densely wooded areas. 
Habitat fragmentation constrains these species to smaller areas, which might not provide all the resources they 

https://www.ecohealthalliance.org/living-safely-with-bats
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Climate Change

Wind Farms

Hunting and Other Human-Bat Interactions

need. Roads are one way that habitats are fragmented and they also can introduce additional threats such as 
pollution (including noise and light pollution) as well as a source of mortality via vehicle collisions (Altringham and 
Kerth 2016). In some situations, roadkill might be high enough to lead directly to population decline (Altringham 
and Kerth 2016).

The loss of habitat for bats can also lead to health risks for humans. With deforestation and human expansion 
into bat habitats, especially in the tropics, people and bats are interacting in formerly remote areas; more 
interaction could lead to increased risk of disease transmission (EcoHealth Alliance 2019).

Habitat loss is also due to the degradation of the habitat. When habitat is degraded, for example due to climate 
change, bats may not have the resources they need for foraging, roosting, or successful reproduction. Remember 
Bracken Cave (Box 1)? Like other cave-roosting species, the Brazilian Free-tailed Bats are dependent on a cave 
with very specific temperature ranges. Higher temperatures appear to be affecting this cave and scientists have 
noticed some bats leaving (Taylor and Tuttle 2019). If warming trends continue, it’s possible that caves like 
Bracken might not be able to sustain the numbers of bats that they currently do. Where will the bats go? How will 
that affect pest control and other ecosystem services bats provide in that area? 

Climate change has also led to intensified weather events, such as droughts, that can reduce or otherwise 
impact food and water sources. As mentioned above, in the tropics, these stressful conditions can drive bats into 
agricultural areas, which in turn can lead to human-wildlife conflict as farmers attempt to protect their crops. 

Climate change is a problem that affects the entire earth system (including ecological, economic, and human 
systems); it’s a “systemic” problem that doesn’t have just one solution. However, there are big questions we 
humans must address, including how we produce energy and reduce the amount of carbon that we put into the 
atmosphere, to help mitigate our changing of the earth’s climate.

Wind energy is considered a clean alternative to fossil fuels and can help with mitigating climate change—but its 
production is not environmentally neutral. For example, wind turbines (Figure 8) are a threat to bats (and some 
other flying species) (Arnett et al. 2016). In the US, scientists estimate that hundreds of thousands of bats are 
killed because of wind turbines (BCI 2019d). Mortality events are related to direct collisions with the blades, but 
bats also might suffer inner ear damage and other internal injuries such as ruptured blood vessels caused by the 
rapid pressure change (Arnett et al. 2016; BCI 2019d). 

So, do bats just accidently run into wind turbines? Interestingly, it looks like collisions aren’t by chance, and 
bats might actually be attracted to wind turbines, either as possible locations for roosts or because the turbines 
attract insects, which the bats feed on (Arnett et al. 2016). With the continued growth of the wind energy 
sector, scientists and companies are actively researching methods to monitor and mitigate bat deaths caused 
by turbines. For example, one study conducted in Pennsylvania found that turning wind turbines off when wind 
speed was low led to 44–93% fewer bats dying each night while only reducing power production by <1% of the 
total amount of power produced in a year (Arnett et al. 2011). 

In parts of Africa, Southeast Asia, and some Pacific islands, bats are hunted for both local consumption and for 
commercial markets (e.g., restaurants) (Mildenstein et al. 2016). Bats are also hunted by people for a variety of 
reasons besides for food, including their perceived medicinal properties or human health threats, for decoration 
(e.g., teeth used for necklaces), and for sport (often urban residents and tourists seeking adventure) (Mildenstein 
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Figure 8. Wind farms can cover large expanses of land 
and lead to bat (and bird) mortality. Photo credit: 
USFWS/Joshua Winchell/Flickr (CC BY 2.0). 

et al. 2016). Bats might also be hunted for retaliatory reasons. As previously mentioned, fruit farmers frustrated 
with the loss of crops may resort to shooting bats they see near their farm (Aziz et al. 2016). 

Hunting pressure affects approximately 13 percent of bat species (at least 167 species) and is more common 
for large-bodied megabats (Mildenstein et al. 2016). Although pretty widespread, the effects of hunting on bat 
populations are poorly understood. Experts suggest more research is needed, in addition to education programs 
to reduce the negative impacts of hunting on bat populations and possible disease spread events (Mildenstein et 
al. 2016). 

Humans also directly impact bat species by disturbing roost sites. Inappropriate guano mining or thoughtless 
tourism may disturb bats during hibernation, causing them to rouse (and subsequently lose too much of their 
stored up energy, weaken, and have a reduced likelihood of surviving the winter) (BCI 2019d). Human visits to 
roost sites could also have the indirect effect of introducing and spreading the WNS-causing fungus. Many tourist 
attractions are now requiring visitors to walk through boot cleaning stations prior to entering the caves, in an 
effort to prevent an accidental introduction of the harmful fungus (Frick et al. 2016).

ENDANGERED STATUS AND CONSERVATION
Although bats are seemingly everywhere, their numbers are also declining, often due to human actions. The 
International Union for the Conservation of Nature (IUCN) is an international environmental network of scientific 
experts that study the evidence available for each species to determine their level of threat and risk of extinction 
globally; this work is known as assessing a species. For each species assessed, the IUCN looks at criteria such 
as the population size and the rate population size decline, the size of the species geographic distribution (how 
widespread it is), and the degree of fragmentation of populations (whether they have been separated from 
each other) within that distribution. Based on these results, a species conservation status is determined. Of 
the approximately 1,300 bat species that have been assessed by the IUCN, almost a third are considered either 
threatened with extinction (i.e., given a conservation status of vulnerable, endangered, or critically endangered) 
or “data deficient” (meaning there is not enough data on the species to be able to accurately assess the level of 
threat to its existence) (BCI 2019d). 

Some conservationists argue that all bats species should be protected and conserved regardless of their IUCN 
conservation status (Taylor and Tuttle 2019). A bat species’ ecological value (or a species’ roles and relationships 
in an ecosystem as well as the services they provide) may might be reduced even before their population 
numbers are critically low (Taylor and Tuttle 2019). In addition to the IUCN criteria, we should know how bats 
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COMPREHENSION QUESTIONS
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function within their ecosystems and conservation efforts need to try to maintain these functions. Luckily, there 
are dedicated people out there studying bats, monitoring their numbers and health, teaching others about the 
benefits of bats, and coming up with both small steps and grand plans to protect bats and their ecosystems. If 
you’d like to learn more about how you can help bat species in your neighborhood, consider installing a bat house 
(Box 2)!

Bat houses (also known as bat boxes) are constructed or purchased 
wooden boxes that are designed to provide habitat for bats. These 
houses may be mounted on the sides of buildings, walls, or even poles. 
Especially in areas where roosting locations may be sparse, bat houses 
can provide a valuable resource for bats to rest during the day, raise 
young, and even hibernate in the winter! By installing bat houses, you 
could be making your local area more bat-friendly. 

Additionally, installing bat houses can also be a helpful way to get rid 
of unwanted bat roommates. Bats occasionally will roost inside human 
homes and are considered a nuisance. If you need to evict bats from 
your house, it’s best to seal up any small holes they might use to gain 
re-entry, but also consider build them their own house—become a bat 
landlord and mount a bat house nearby!

There are great resources to get instructions on how to build or where 
to buy, how to install, and how to monitor these houses. Check out Bat 
Conservation International’s website for a great place to start: 
www.batcon.org/resources/getting-involved/bat-houses. 

Box 2. Bat Houses: Become a Bat Landlord!

Photo credit: US Air Force photo/Samuel King Jr.

1. What are three new things you learned about bats from this essay and why did they interest you? 
2. What makes bats unique from other mammals? How are they similar to other mammals?
3. What are ecosystem services? Explain at least two ecosystem services that bats provide including why these 

services are important to humans.
4. Describe three threats to bats and what conservation actions people/organizations/governments do you 

think could help.
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ABSTRACT

INTRODUCTION 

WHAT’S A FIELD GUIDE?

Bats comprise over 20% of known mammal diversity and different species have evolved to fit in diverse 
environments and ecological niches. Bats are basically everywhere, with the exception of polar regions and some 
remote islands. In this exercise, students focus locally and are asked to research and present on bats in their 
region. Specifically, students search for information on the bats in their region, list which species they think could 
live in their neighborhood, and then find more information on one of those species. Students are then asked to 
create a “field guide” on that species.

As explained in the accompanying synthesis, Our Neighbors, Bats!, bats are pretty much everywhere. But…
what about where you live? How many species of bat live in your area? What species are they? What special 
characteristics do they have?

In this exercise, you will search for information on the bats in your region, list which species you think could 
live in your neighborhood, and then find more information on one of those species. You’ll make a “field guide” 
presentation on that species, which might be an informational poster, an oral or digital presentation, a blog, or 
some other type of medium. Your instructor may guide you or help you choose a specific format.

A field guide is traditionally a book that people bring out into the “field” (which basically just means outdoors) 
to help them identify and learn more about plants and animals in that environment. There are thousands 
of published field guides available on different regions and the different groups of species found there—on 
wildflowers, freshwater insects, coral reefs, birds, reptiles, mammals, you name it! Field guides are also available 
in digital formats: for example, apps like iNaturalist or Merlin Bird ID. 

The format of and information in these books and digital guides differs, but generally they include identifying and 
natural history information such as:
• the common name and scientific name of species—for example: common Vampire Bat (Desmodus rotundus);
• a photo or drawing of the species (sometimes with images of males and females and/or juveniles and adults if 

there are considerable differences between those groups);
• a written physical description of the species (such as size range or distinguishing characters like color 

patterns);
• a written description of the species’ biology and behavior (like whether or not they migrate, when and how 

often they mate, and other unique characteristics that they have);
• a written description of the species’ ecology—meaning how the species interacts with other species and the 

environment—which might include what they eat and what eats them, or how they create shelters or burrows;
• a large-scale map of where you can find them in the world (called a distribution map);
• the conservation status of the species (meaning whether or not is considered at risk for extinction), if it is 

common, rare, or even an estimated population size, and possibly a list of reasons why a particular species is 
threatened or flourishing; and

• other fun facts about the species that are interesting and/or unique (see Figure 1 for an example field guide 
entry).
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YOUR NEIGHBORHOOD BATS

Make a Field Guide! 

Descriptions often don’t include information on characteristics that are similar to other species in that group, but 
rather things that make this species different. For example, a field guide to birds of the world wouldn’t say “golden 
eagles fly,” but that same guide might mention that the Kiwi, a bird native to New Zealand, doesn’t fly (i.e., is 
flightless) because that makes it different from most other birds. A bird guide might also give details about how 
fast a bird flies, whether it has a unique flight motion (like soaring), or how old it is when it begins to fly.

1. First, collect information about what species of bats might be in your area. A good place to start could 
be doing an online search for “list of bats in _____” (with the blank space being your State, Province, or 
Country). Another good source might be finding out if your local government has a webpage dedicated to 
wildlife. For example, US state governments have wildlife departments that publish information about the 
wildlife in your state. Once you have narrowed down which species of bats might be in your area, compare 
your list with others in your class.

2. You will continue to search for more information to create your field guide entry for one of the bat species 
on the list. In addition to the information found in your initial online search, consider checking out the 
International Union for the Conservation of Nature (IUCN)’s webpage called the “Red List” (www.iucnredlist.

Figure 1. Example pages from a field guide of New Jersey beach habitats. Image credit: National Guard Training Center, Sea Girt, NJ, 
www.nj.gov/military/construction-facilities-management/environmental-management/documents/3307-booklet-FINAL.pdf. 

https://www.iucnredlist.org/
https://www.nj.gov/military/construction-facilities-management/environmental-management/documents/3307-booklet-FINAL.pdf
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org/) or the “Animal Diversity Web” (animaldiversity.org/) to help with basic information about the species, as 
well as its conservation status.

 Warning: Make sure you are not copying from sources word-for-word! Read at least three different sources of 
information about your species and then paraphrase the information you’ve read. In your end product, you’ll 
need to refer to where you got your information, so be sure to copy down the sources and any URLs.

3. Design a presentation/product (based on guidelines instructor gives you) that can be an educational tool for 
others to learn about and identify your species.

4. Share your product and read/see/hear about all the bat species in your region!

1. Were there any differences in content between what you presented in your field guide and that of other 
students? For instance, were there facts that didn’t match up, even though you were talking about the same 
species? Were there different types of or gaps in information provided by different students/groups? Explain.

2. Do you think that all the bat species in your field guide are found outside around your home or school? Could 
there be anything about the area where you live that makes it unlikely that certain bats are found nearby 
(even though they might be in your wider region)?

3. Field guides are great tools for helping identify the species around you. However, can you think of a reason 
why a visual description of bats might not be as helpful as a visual description of birds? What about a bat’s 
biology makes it harder for you and me to see them?

REFLECTION AND DISCUSSION QUESTIONS

https://www.iucnredlist.org/
https://animaldiversity.org/
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ABSTRACT

PART 1. “ARE THERE ACTUALLY BATS IN MY NEIGHBORHOOD?” 

1.1 NYC Biodiversity 

In this case study and accompanying exercise, students shadow a hypothetical high school student studying the 
acoustic monitoring of urban bats. Students are introduced to urban biodiversity in New York City, bats in urban 
areas, bat echolocations/vocalizations, and the monitoring of these species through analyzing acoustic recordings 
with Kaleidoscope, a specialized software. Students then complete a data analysis exercise where they will be 
directed on how to visualize the results of the software analysis and summarize the conclusions. Students end 
the exercise by brainstorming additional questions that may be possible to answer with the type of data they 
have, while also thinking about how the project could be expanded. This case study and exercise can be used in 
conjunction with “Our Neighbors, Bats!” and the exercise “A Field Guide to Bats in your Neighborhood," or as a 
stand-alone activity. 

Maya, a 9th grade student in New York City (NYC) taking the course Living Environment, asks herself this 
question. Her class has just finished reading an article on bats (“Our Neighbors, Bats!”) and completed an exercise 
to determine what species are likely to be in her area. She now knows that, according to the New York State 
Department of Conservation, nine species of bat are found in New York State; but, she wonders, how many of 
those are actually in NYC? Maya lives in the Bronx and has never seen a bat before! If bats are in NYC, what other 
wildlife might also be here?

Her teacher assigns a project where each student must pick a topic about bats and do further research. Maya 
decides to focus on bats in urban areas and to learn about wildlife in urban habitats more generally, especially in 
NYC. Her teacher suggests Maya reads a bit of background information on NYC nature and gives her this six-page 
excerpt from a report called: “Biodiversity Assessment Handbook for New York City” by Erik Kiviat and Elizabeth 
Johnson.

Read the excerpt on pages 68–73 below to see why Maya’s teacher thought it would be helpful.
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IntroductIon
B i o d i v e r s i t y  A s s e s s m e n t  H a n d b o o k  f o r  N e w  Yo r k  C i t y

Many people assume that biodiversity — nature — only exists in faraway places like tropical 
rainforests or the Adirondacks. But urban areas support much more than weedy plants like 
dandelions (Taraxacum) and adaptable animals like raccoons (Procyon lotor) and house 
sparrows (Passer domesticus).

In fact, a surprising array of uncommon and rare species is found in New York City. Did you know 
that the peregrine falcon (Falco peregrinus), an endangered bird in New York State, nests on 
high-rise buildings and bridges in the City? That New York City’s beaches harbor rare beach-
nesting birds like the piping plover (Charadrius melodus) and a federally protected plant, the 
seabeach amaranth (Amaranthus pumilus)? That its parks and greenways provide critical 
resting and feeding habitat for migrating songbirds en route to their northern nesting grounds 
each spring and returning to their overwintering sites in autumn? That one of only three locations 
for the New York State-endangered little bluet damselfly (Enallagma laterale) is found in 
Queens? That more than 230 species of bees pollinate crops in community gardens and plants 
in natural areas, pocket parks, and even window boxes and roof gardens? That beavers (Castor 
canadensis) are now living in the Bronx River, and river otters (Lontra canadensis) have recently 
been seen on Staten Island? Or that scientists recently discovered species entirely new to science 
in the City, including the dwarf centipede (Nannarrup hoffmani) in Central Park, the Gotham bee 
(Lasioglossum gotham) in Brooklyn Botanic Garden, and a new species of leopard frog in Staten 
Island?

The truth is that New York City is an important ecological crossroads where the presence of a 
variety of salt- and freshwater habitats, major migratory corridors, and the convergence of three 
ecological regions prove critical to the survival of many species of fish, birds, and other animals. 
Biodiversity provides services that are key to the City’s quality of life, from clean air, clean water, 
and flood control to natural beauty. Yet its diversity of plants, animals, and habitats is often 
underappreciated or ignored. As a consequence, during the past 400 years much of
New York City has been built on and paved over, with only a small fraction of its original habitats 
remaining.

Seabeach amaranth. Image credit: Stephen M. Young/
NY Natural Heritage Program.

Fortunately, the wealth of biodiversity that 
was once widespread in the City can still 
be found in resilient pockets of aquatic and 
terrestrial greenspace (by "greenspace" 
we mean areas that are not paved or 
built on, including parks, nature reserves, 
undeveloped lands, gardens, and vacant 
lots). Although much has been lost, far-
sighted New Yorkers have set aside many 
signficant greenspaces and even created 
semi-natural places, like Central Park, Van 
Cortlandt Park, and the Hudson River Park's 
Estuarine Sancturay, where nature can 
flourish.
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Urban Biodiversity
B i o d i v e r s i t y  A s s e s s m e n t  H a n d b o o k  f o r  N e w  Yo r k  C i t y

The classic definition of “biodiversity” is the variety of life at all its levels, from genes to 
ecosystems, and also the ecological and evolutionary processes that sustain life. For years, 
ecologists focused their efforts on managing areas apart from where most people live. Only 
recently have scientists begun to study the biodiversity of cities, the most human-dominated 
lands. Without the conservation of urban biodiversity, many habitats and species, and much 
variation within species would be lost (Noël and Lapointe 2010).

Conserving biodiversity is the key to long-term sustainability and the quality of life for all of us, 
even urbanites. Species and habitats in distant lands as well as those here in New York City 
all play an important role in maintaining the ecosystem services on which we depend, such 
as nutrient cycling and water filtration. Furthermore, cities are refuges for certain rare species 
that may even do better in urban areas than in the countryside. For example, peregrine falcons 
(Falco peregrinus), a state-protected species, have found a niche in the City, successfully using 
high-rise buildings, church steeples, and bridges for nesting (NYC Department of Environmental 
Protection 2012a), and American kestrels (Falco sparverius), small cavity-nesting raptors that 
are declining statewide, are holding their own in the City. Open disturbed habitats in cities often 
support rare plants, such as the eastern gammagrass (Tripsacum dactyloides) in Pelham Bay 
Park.

The world is rapidly becoming more urbanized. It is projected that by 2050 close to 70 percent 
of the world’s population will be living in urban areas — compared to 60 years ago when 
the reverse was true and 70 percent were living in rural areas (U.N. 2019). In recognition of 
this fact, researchers and others gathered in 2008 to explore the best ways to implement the 
recommendations from the 2002 Convention on Biological Diversity in towns and cities. The 
Erfurt Declaration, which was developed at this conference to promote the values of urban 
biodiversity, states in part:
 - Urban ecosystems have their own distinctive characteristics;
 - Urban areas are centers of evolution and adaptation;
 - Urban areas are complex hotspots... for regional biodiversity;

Peregrine falcon in New York City landscape. Image 
credit: Mike Feller

 - Urban biodiversity can contribute 
significantly to the quality of life in an 
increasingly urban global society;

 - Urban biodiversity is the only biodiversity 
that many people directly experience.

The Declaration further states: “Experiencing 
urban biodiversity will be the key to halting 
the loss of global biodiversity, because people 
are more likely to take action for biodiversity 
if they have direct contact with nature” 
(International Conference of the Competence 
Network Urban Ecology CONTUREC 2008). 
The ability to experience urban biodiversity 
will depend on sound research, conservation, 
and management of the plants, animals, 
fungi, microbes, and their habitats in cities.

https://www.fh-erfurt.de/urbio/httpdocs/content/ErfurtDeclaration_Eng.php
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The Value of Biodiversity
Diverse terrestrial and aquatic landscapes with a wide range of animals and plants provide 
natural benefits that are essential to daily life. Often, we have underestimated or even ignored 
their value when making decisions that affect the land and water, but they are the key to the 
environmental and economic health of cities as well as suburban and rural areas. And an 
increasing body of evidence indicates they are also essential to human health.

One effort to calculate the global value of landscapes with rich biodiversity estimated that every 
year they provide $33 trillion worth of natural services — nearly twice the global gross national 
product of $18 trillion (Costanza et al. 1997). This estimate, which was based on 1997 dollars, 
would be much higher today. Among the many benefits that biodiversity provides are:

• Food, medicine, wood, and other products 
Many medicines are derived from plants, including aspirin, which comes from the willow tree 
(Salix). Even New York City waters are habitat for fish important for both the commercial and 
sport fishing industries, such as striped bass (Morone saxatilis). 

• Cooler communities 
Trees and other plants provide cooling shade and help stabilize the global climate by 
removing carbon dioxide, the major greenhouse gas, from the atmosphere. Vegetation also 
cools the environment by transpiration (moving water from soils and surface waters through 
plants to the air). 

• Cleaner air and water 
Plants, through photosynthesis, provide us with the oxygen we breathe. The cooling effects of 
shade and transpiration, mentioned above, also reduce the production of ground-level ozone, 
a major urban pollutant that aggravates asthma and other respiratory illnesses. In coastal 
systems, Eastern oysters (Crassostrea virginica) and ribbed mussels (Geukensia demissa) 
cleanse the water by filtering out suspended sediments and excessive nutrients. 

B i o d i v e r s i t y  A s s e s s m e n t  H a n d b o o k  f o r  N e w  Yo r k  C i t y

Bumble bee on zinnia. Image credit: Elizabeth Johnson.

• Pollination 
Fully one-third of our food, including 
apples, tomatoes, and squash, depends 
on the services of a pollinator — a bee or 
other animal. As European honey bees 
(Apis mellifera) have been declining due 
to the affliction known as Colony Collapse 
Disorder, the value of a diverse community 
of native bees and other pollinators has 
become increasingly apparent, whether on 
rural farms or city rooftops. 
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• Stormwater control and natural water storage 
In healthy landscapes, stormwater is absorbed by plants and the soil, in the process removing 
pollutants and replenishing underground water supplies. In urban areas, where much of the 
natural landscape has been replaced by concrete and asphalt, contaminated stormwater 
runoff ends up in local waterways, accounting for 70 percent of water pollution (Loizeaux-
Bennett 1999). New York City’s combined sewer system compounds the problem, sending both 
stormwater runoff and untreated municipal sewage into waterways during heavy rainfalls. 

• Erosion control 
As we witnessed in October 2012 with Hurricane Sandy, the degradation and destruction of 
coastal ecosystems such as salt marshes and sand dunes, which serve as natural buffers, 
can lead to increased damage to coastal communities by storm surges (the rise of sea level 
associated with storms). Often, beaches are rebuilt to save homes and other structures, at an 
enormous economic cost to the public. 

• Waste decomposition and soil fertility 
Healthy soil transforms wastes into the nutrients necessary for sustaining life. Small organisms 
in the soil break down dead plants and animals, and in the process nutrients such as nitrogen 
and phosphorus are recycled to enrich the soil, enabling growth to continue. 

• Human health and well-being 
Our connection to nature sustains us physically and mentally. Research shows that encounters 
with everyday nature restore concentration, calm anxiety, and reduce aggression in adults and 
children (Louv 2008). Biodiversity can also reduce the risk of disease transmission to humans 
(Keesing et al. 2010). A more diverse small mammal community — one that includes different 
species of mice, eastern chipmunks (Tamias striatus), gray squirrels (Sciurus carolinensis) as 
well as predators such as red foxes (Vulpes vulpes), for example — reduces the spread of tick-
borne Lyme disease to humans in rural areas (Ostfeld et al. 2002). 

• A natural insurance policy 
Ecologists believe that biodiversity makes landscapes more resilient, acting as a kind of 
insurance policy to cushion them from shocks, such as climate change or new insect pests and 
diseases. A biologically impoverished world would be unable to support us as effectively, or for 
as long, as one rich in organisms, biological communities, and ecosystems. 

• A source of inspiration and ideas 
Scientists and engineers often turn to nature for ideas. The invention of Velcro, for example, 
was inspired by observation of plants like burdock (Arctium), whose seeds are dispersed by tiny 
hooks that grab onto animal fur (or clothing) (Gebeshuber and Drack 2008).

Perhaps most important, as environmental ethicists point out, biodiversity — species and 
ecosystems — have intrinsic value, which comes simply from the fact that they exist, not from 
some benefit they provide to humans or other species.

B i o d i v e r s i t y  A s s e s s m e n t  H a n d b o o k  f o r  N e w  Yo r k  C i t y
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New York City residents and visitors benefit from biodiversity in many ways. In 1992, for example, 
to avoid building a costly drinking water treatment plant, the City began acquiring thousands of 
acres of land in the New York City water supply watersheds and working with local communities 
to promote environmentally sensitive development and land management. According to City 
calculations, its planned investment of approximately $1.5 billion over the course of ten years 
saved it $4 billion to $6 billion in construction costs and an estimated $300 million per year in 
operational costs for the new water filtration plant that was no longer necessary (Chichilnisky 
and Heal 1998; Wilson 2002). The treatment plant would have doubled or tripled water bills; by 
contrast, the watershed protection plan increased the average New Yorker’s water bill by only $7 
per year.

According to a 2007 study by the Center for Urban Forest Research, New York City trees intercept 
almost 890 million gallons of rainwater each year, preventing it from entering storm sewers and 
saving the City an estimated $35 million annually in stormwater management costs. The cooling 
effect of all those trees also reduces energy consumption by a whopping $6.9 million (Peper et 
al. 2007).

Landscapes with a rich variety of habitats and organisms not only save the City money but make 
it more beautiful and livable. Imagine Manhattan without Central Park. Greenspaces provide an 
important connection with nature and opportunities for daily recreation for City residents and 
workers, and are ecotourism destinations for millions of nature-lovers and birders each year — 
all at “no charge.”

In fact, greenspaces actually generate dollars. According to the U.S. Fish and Wildlife Service’s 
2006 National Survey of Fishing, Hunting, and Wildlife Associated Recreation report, in New York 
State there are an estimated 3.8 million bird and other wildlife watchers who annually contribute 
an estimated $1.6 billion to the state economy, including $250 million in state sales tax revenue, 
and support thousands of jobs across the state, including New York City.

B i o d i v e r s i t y  A s s e s s m e n t  H a n d b o o k  f o r  N e w  Yo r k  C i t y
How Does Biodiversity Benefit New York City?

Birdwatchers at Jamaica Bay. Image credit: Adriana 
Palmer.

Ashokan Reservoir, part of the New York City water 
system. Image credit: Helen Forgione.

https://www.census.gov/prod/2008pubs/fhw06-ny.pdf
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New York City’s greenspaces also enhance property values. Studies show that homes situated 
near parks, public gardens, rail trails, etc., sell for significantly more money than those with no 
nearby greenspace (Crompton 2004).

In recognition of the importance of biodiversity, both species and habitats, New York City 
recently developed a Green Infrastructure Plan. The plan, developed by the Department of 
Environmental Protection, is a blueprint for stormwater management that complements the 
City’s PlaNYC sustainability initiatives. The goal is to manage runoff from 10 percent of the 
impervious surfaces in combined sewer watersheds through detention and infiltration over 
the next 20 years. The New York City Department of Parks and Recreation has been building 
“greenstreets” for stormwater capture (streets with vegetated median strips or other features 
that reduce stormwater runoff) for nearly five years. The Parks Department will be working 
with the New York City Department of Environmental Protection to promote a comprehensive 
approach to green infrastructure, which will transform neighborhoods from “gray” to “green” 
through greenstreets, bioswales (typically small landscape elements in which vegetation and 
soil absorb and treat stormwater runoff), green roofs, stream daylighting (uncovering previously 
buried streams and restoring natural flow), and natural areas restoration.

The aim of the Green Infrastructure Plan is to change the paradigm of planning in New York 
City from a site-specific to a landscape approach — strategically designed, engineered, and 
managed networks of natural and developed lands working in concert to conserve existing 
landscapes, retain stormwater, and enhance environmental benefits such as natural water 
filtration and carbon sequestration (the removal and storage of atmospheric carbon in 
carbon “sinks” such as forest vegetation and soils). While green infrastructure projects are not 
designed as biodiversity conservation per se, they do in fact protect biodiversity by creating and 
maintaining greenspace. And conserving biodiversity in turn maintains the City’s pool of species 
that potentially can be used for ecological engineering, such as different kinds of marsh plants 
for bioswale plantings, or varieties of trees and shrubs that survive with a minimum of care in 
parks or restored habitats.
Water infiltration swale at 
Oaktree Place (Bronx) captures 
stormwater runoff. Image 
credit: NYC Department of 
Parks and Recreation.
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1.2 Urban Bats
After reading the introduction to the biodiversity of New York City, Maya decides to start her own research. 
She finds some helpful websites, an eBook about bats with a chapter on bats and urbanization, and even some 
scientific articles about bats in cities. From her research, Maya writes her final report. 

Read her report on pages 74–77 to see what she found out. 
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MAYA’S REPORT ON URBAN BATS

I live in the largest city in the United States—New York City. In 2016, the human population of NYC was 
8.55 million people (World Population Review 2019); but what else lives in NYC? This report will discuss 
urban environments and the wildlife that lives in cities, with a special emphasis on bats.

On the whole, bats are threatened and declining because of urbanization, but certain bat species have 
been more able to adapt to urban environments. In the book “Bats in the Anthropocene: Conservation 
of Bats in a Changing World,” a couple of chapters focus on and summarize the scientific research 
on bats in urban areas (Jung and Threlfall 2016; Rowse et al. 2016). This section will summarize these 
findings. 

Currently, most of the research on urban bats has occurred in Europe and North America. These 
studies often focus on the response of bats to different aspects of cities, for instance: areas with lots of 
structures versus areas with few, old cities versus new cites, areas with lots of artificial lights versus dark 
areas, areas with and without parks, or areas with or without water availability. In general, these studies 
show that bats use urban habitat less than natural areas. Also, within a city, bats use areas differently—
more urbanized areas are used less than those that are moderately urbanized. There is relatively high 
bat activity and species richness (meaning the number of different bat species) in areas with more 
vegetation, such as areas with older apartment buildings, as well as around rivers and in parks. Species 

Cities are dominated by humans and human-made structures, such as buildings, roads, bridges, and 
parking lots. They are built to be where people live, work, play, and travel, so they are designed with the 
human population in mind. In comparison to people living in rural areas, individuals living within a dense 
city might have less impact on the environment because their housing takes up less land (high-rise 
apartments minimize land use per person) and they use public transit more frequently (i.e., less carbon 
emissions per person) (Florida 2012). Yet the cities themselves have quite an impact on their surrounding 
environment. The built environment and the high density of humans living within it leads to large 
continuous areas covered with buildings, concrete, or asphalt (known as impervious surfaces which keep 
water from being absorbed into the ground); increased pollution and waste/garbage generation; altered 
water systems; and increased artificial lighting and sound pollution (Jung and Threlfall 2016). Cities also 
change the local climate of an area, an impact called the urban heat island effect. Less radiation from 
the sun is reflected during the day because of the dry, impervious surfaces; the urban infrastructure is 
also slower to release heat in the night, compared to more vegetated areas (EPA 2019). This means cities 
are warmer than their rural surroundings; they are “islands” of heat.

Although the construction or expansion of cities leads to a loss of habitat and extirpation (local 
extinction) for many species that might have once lived in that area, other species remain and 
occasionally, thrive! Urban wildlife is a term used for species that live in cities. Although some species 
might struggle in the urban environment, other species can be quite successful because they don’t 
mind (or have adapted to) living with humans. Some even benefit from humans because humans often 
provide food sources, such as birdfeeders, garbage, or pet food (Urban Wildlife Working Group 2012). 
Urban wildlife tends to have more generalist tendencies, in terms of their diets and habitats (i.e., less 
strict, more likely to be omnivorous), and are more flexible with their behaviors (for example, shifting to 
becoming more active at night when fewer disturbances are present) (Urban Wildlife Working Group 
2012).

Bats in cities

Urban environments and wildlife
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Helping urban bats
Even though there are bats that have adapted to life in cities, they still face challenges and they might not 
do well enough to reproduce (Goldman 2015). One way to help bats is by creating green areas that could 
provide additional food sources, darker areas, and roosting habitat. For example, some research suggests 
that establishing networks of trees could help bats by providing benefits such as roosts; shelter from wind 
and predators; better foraging opportunities; and reducing the impact of light pollution (Langley 2019).

Another approach might be installing green roofs on the tops of buildings. Green roofs are vegetated 
spaces found on a building’s roof. Although not all wildlife can get up to a roof to use these spaces, bats 
can! In NYC, Kaitlyn Parkins and Alan Clark from Fordham University in the Bronx studied whether bats 
used green roofs more than normal “conventional” roofs (Parkins and Clark 2015). Instead of sitting on 
roofs and watching for bats, these researchers set up audio recorders that recorded the ultrasonic sounds 

might also use urban habitat differently throughout a year. For example, European bats (Eptesicus nilsonii) 
spend more time foraging for food in urban areas after the birth of pups (baby bats) compared to before 
any pups are born. Bats may also migrate through a city and use it for habitat only for a short time.

In one particular case in Chicago, more bats occurred in patches of habitats within the urban area 
compared to similar patches in rural areas! This might be because Chicago’s urban areas provide a 
different mix of structures and habitat (like buildings, bridges, and forested parks) that bats can use for 
roosting, while its surrounding rural areas—mainly agricultural lands—don’t have the same opportunities 
for roosting. Therefore, the built environment and large forested parks of Chicago actually help bats in 
the region.

Bats found in cities differ regionally but are mainly insectivorous (though fruit-eating bats have been 
observed in cities, especially in areas where residents plant fruit trees, like in Hong Kong). In general, bats 
that use city habitat most successfully have “high wing loading,” which means that their wing surface area 
is small relative to their body weight (mass). Additionally, these bats tend to have long and narrow wings. 
Why is this important? These wing characteristics allow the bats to fly fast and they can forage in open 
areas (areas with low tree cover) without worrying about predators like birds of prey. Slower bats (with 
different wing characteristics) may avoid open areas like these because of the threat of predation; these 
bats tend to prefer more covered habitat, like you’d find in a forest outside the city. 

Bats that prefer covered areas also tend to dislike lighted areas. Areas around streetlights are not only 
open, but also give predators the advantage of making it easier to see their prey. That’s bad news for 
slower moving bats, but good news for other bats that are fast enough to avoid predators: these bats 
can use artificial lights to assist in their own hunting! Insects such as moths are adapted to use moonlight 
for orientation while flying; when encountering a street lamp or other source of artificial light, they may 
get disoriented and circle or collide with the lamp. Other insects can be immobilized or stunned by 
the light (called the “dazzling effect”) and simply rest on the ground or a nearby structure, therefore 
becoming easy prey for a predator like a bat. Because of this resulting concentration of insects around 
lamps, some species of bats have used artificial lights found in cities as prime feeding grounds. However, 
light technologies are changing and not all bats respond the same way to different types of lights. For 
example, lights that give off ultraviolet (UV) light attract more insects and therefore more bats. Newer 
light-emitting diode (LED) lamps are increasingly popular because they reduce energy consumption and 
need to be replaced less frequently, but many species avoid these types of lights; some bats (Myotis and 
Rhinolophus bats) have been seen to avoid LED lamps even when the lights are dimmed.
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of bats’ echolocation calls during the night. These recordings were used to determine how often bats 
were active over these two types of roofs. Results showed that bats were indeed using green roofs more 
than normal roofs. Considering approximately 34% of NYC is composed of rooftops, installing more 
green roofs could be a great way to help bats and other wildlife (like butterflies and birds) that use them 
(Goldman 2015).

Bat houses, which are wooden box structures that can be attached to buildings to provide roosting 
locations for bats, are another way to help. On a larger scale, bat friendly architecture can be designed 
and built. For example, bridges built in Austin, Texas, are now designed to provide bat roosting habitat 
after an unintentional realization that certain bridges provide better roosting locations than others (PBS 
2019).

In terms of light pollution, there are efforts underway to do part-night lighting (meaning lights are 
turned off for certain portions of the night), light dimming, using lights that illuminate something directly 
rather than the whole area, and motion-activated lighting. These efforts may help reduce stresses on 
urban bats and other wildlife in cities.

REFLECTION QUESTIONS

PART 2. BATS IN THE BRONX!

1. In your opinion, what was the most surprising information in Maya’s report? 
2. The NYC Biodiversity Handbook excerpt didn’t have specific information about the value of bats with regard 

to ecosystem services. After reading Maya’s report, do you think that bats in the city can help people? In what 
way? (Refer to the synthesis “Our Neighbors, Bats!” if needed.) 

2.1 Learning More About Bioacoustics
Maya is excited—through her research she found out that bats are indeed in her area of NYC and that there are 
scientists studying them not far away! She decides to try and contact the research team at Fordham University to 
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Bats and Bioacoustics
Bats are the only mammals with self-powered flight. The largest bat species generally eat fruit and spend the 
day flying from tree to tree in their search for fruit. In contrast, most smaller, insectivorous bat species are 
active at night (nocturnal). Since both fruit and insectivorous bats have vision similar to that of humans, how 
do nocturnal bats manage to find their way around? The answer is that these bats have evolved an amazing 
approach to navigation and hunting: sonar and echolocation.
 
The word “sonar” is an acronym of the phrase “Sound Navigation and Ranging.” Sonar is a method of 
navigation that relies on the production of sound wave pulses and interpreting the echoes of these sound 
waves as they bounce off nearby objects. Submarines also use sonar, but to navigate through water rather 
than air. The type of sonar that bats use is called “echolocation.” Using unique morphological features 
(specially adapted body parts), bats produce a series of sound wave pulses and then listen to the echoes that 
bounce back. These echoes contain information on the location and size of objects around them—allowing 
these bats to fly and capture prey they cannot see.

Most echolocating bats produce sound waves through their larynx, the same structure humans use to speak. 
But bat echolocation calls are usually ultrasonic; that is, they are above the frequencyi range of human 
hearing. In other words, most bat echolocation calls are so high in pitch that we cannot hear them—they are 
“ultra” (above) “sonic” (sound). Most humans can hear sounds ranging from 0.20 to 20 kilohertz (kHz). Sound 
waves have a frequency (pitch) that can be measured by the number of oscillations, or cycles, per second, and 
a hertz is a unit of frequency defined as one cycle. So, a 10 kHz sound has 10,000 sound waves/cycles per 
second. Humans hear sounds best when they are in the 2 to 5 kHz range. Bats, however, can produce sounds 
ranging from 20 to 200 kHz! That’s why humans cannot usually hear echolocating bats.

Echolocating bats produce a single “pulse” of sound, a series of which make up a “call” or “pass.” They have 
two main types of ultrasonic vocalizations: 1) calls used primarily to travel, often called “navigation” or 
“search phase” calls; and 2) calls used to capture prey, usually called “feeding buzzes.” Navigation calls give 
bats a “picture” of their environment that allows them to avoid hitting objects as they fly in the dark. These 
navigation vocalizations can be used to identify species or species groups through analyzing the unique 
characteristics of individual pulses, including a pulse’s frequency range, how fast the frequency of a pulse’s 
pitch changes (frequency modulation), and a pulse’s “knee” (the point where frequency modulation is at its 
greatest) (Figure 1). However, the most common character that is used to classify a pulse by species or species 
group is its fundamental frequency—that is, the lowest frequency of an echolocation pulse (see Figure 1). We 
can “visualize” ultrasonic sounds through spectrograms, which provide a visual representation, or picture, of 

see if she might be able to volunteer with them. She would like to do a project monitoring bats in the Bronx and 
possibly enter the NYC Science Fair.

She finds Dr. Alan Clark on the Fordham University website and he connects Maya with Kaitlyn Parkins, the lead 
author of the study. Maya is in luck—the research group was actually looking for help! They decide that Maya can 
help with a project that monitors bat activity in the Bronx by installing an acoustic recording device (i.e., acoustic 
monitor) on her school roof, and thereby adding to the research group's data set. Dr. Clark asks Maya to do a bit 
more reading on how this type of passive recording and analysis works, and why it is a helpful way to study bats. 
He asks her to review this summary that he wrote for his students.

iThe term “frequency” can be confusing. In everyday use, “frequency” generally means how often. But in the field of bioacoustics, 
“frequency” refers to a sound’s pitch, i.e., how high or low the sound.
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a sound. In spectrograms, time is on the x-axis and frequency is on the y-axis. Spectrograms can also indicate 
where the most “power” or energy is found in a sound. 

Many animal species can be identified by their vocalizations. The most efficient way to determine which frog, 
cricket, or bird species is present is to simply listen for their vocalizations. Bat navigation pulses are often 
species-specific; consequently, we can document the presence of a particular bat species by “listening” to bat 
navigation pulses in much the same way that scientists and birdwatchers identify birds by their song alone 
(see Figure 2).

However, compared to most bird songs, bat navigation pulses are much more variable. Bats adjust their pulses 
to navigate most efficiently in different types of environments. For example, in cluttered environments (like 
a dense forest), all bat species produce pulses that are faster and cover a wider frequency range. Thus the 
echolocation pulses of two different bat species pursuing the same prey item in the same type of physical 
environment will start to look similar (converge), making them more difficult to attribute to a particular 
species. Consequently, only navigation pulses produced in open environments are used to identify bats to the 
species level.

A bat will often multitask while traveling, using echolocation calls for locating prey as well as for navigation. 
When a bat is searching for food, the characteristics of the ultrasonic pulses it produces will begin to 
change. To improve the chances of finding an insect, bats use pulses with a wider frequency range than the 
frequency range of navigation pulses and increase the rate they produce these pulses. When pulse echoes 
indicate potential prey, the bat narrows the frequency range of its pulses and increases the pulse rate even 
further until the bat narrows its search sufficiently to grab the insect using its wings or feet. A series of food-
seeking pulses is called a feeding buzz (see Figure 3). Bats of differing species often eat similarly sized prey 
items; consequently, the ultrasonic pulses they produce to find and capture those prey items can also be 
quite similar. Feeding buzzes are therefore not useful in identifying bats to the species level. Feeding buzzes, 

Figure 1. Spectrogram of bat 
echolocation pulse. Bat call 
identification is possible 
through acoustic software 
programs. Some programs 
measure multiple parameters 
of ultrasonic search phase or 
traveling pulses to identify 
pulses to the species level. For 
example, the software program 
Sonabat uses measurements 
such as high frequency (”Hi 
f”), the point of sharpest angle 
in the slope of the frequency 
(“knee”), and low frequency 
(“Lo f”). Other programs, such 
as Kaleidoscope, use both 
parameter measurements and 
an approach similar to that of 
facial recognition software to 
identify pulses to the species 
level.
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however, are useful indicators that bats are using the area for feeding and can provide information on the 
relative quality of an area as bat foraging habitat. Interestingly, some prey can sense feeding buzzes (pulses) 
and have evolved to respond to them. Read Box 1 for more information on this evolutionary phenomenon.

Figure 2. Spectrogram 
showing a typical ultrasonic 
navigational pulse for the 
nine bat species found in 
New York State. Image credit: 
Kathleen McDaniel of ERM, an 
environmental consulting firm. 

Figure 4. Spectogram of a feeding buzz. Feeding buzzes allow bats to “see” a variety of prey while in flight. When searching for 
food, such as moths and mosquitos, bats produce ultrasonic pulses that (1) cover a wider frequency range than their navigation 
pulses (2) are individually steeper, that is, are quicker, and (3) have a faster cadence, i.e., they are produced more rapidly. When 
the echoes suggest the location of potential prey, the pulses become even more rapid, but the frequency range narrows to that 
of the potential prey. When the bat is close enough, it grabs the prey with its wings, tail membrane, or feet and then eats the 
prey while continuing to fly.
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What is a co-evolutionary arms race? A frequently discussed example is the evolution of cheetahs and one of their preferred prey: 
the gazelle. Both run fast. Cheetahs that run faster are more likely to be successful in chasing down a gazelle and, therefore, more 
likely to live longer and leave more offspring. The trait of being faster would then be more common throughout the population. 
However, the fastest gazelles are more likely to escape from cheetahs; again, likely living longer and leaving more offspring with the 
trait of being faster. But if cheetahs then evolve that are even faster, only even faster gazelles could escape. This back and forth 
would continue in what is termed a co-evolutionary arms race.    

How does this co-evolutionary arms race apply to moths and bats? Moths—many bats’ preferred prey—are mostly nocturnal. Bats 
use their ability to echolocate to locate moths. However, moths would prefer not be become bat food. In response to bats’ ability to 
echolocate, some moth species have evolved behavioral traits that reduce the bats’ chance of hunting success. For example, several 
moth species have developed a tympanum, which is a sound sensitive structure that gives them the ability to hear in the ultrasonic 
range of pulses produced by bats. When “pinged” with an ultrasonic pulse (i.e., when they sense an ultrasonic pulse), some moths 
cease flying and fall to the ground while other moths undertake erratic flight patterns. Other moth species have a different response 
when pinged with an ultrasonic pulse: they produce their own ultrasonic sounds, effectively jamming the echolocation signals of the 
bat—making it difficult for the bat to pinpoint the moths’ location. All of these behaviors can increase a moth’s chance of survival 
and reproductive success.

In response, some bats have evolved countermeasures that include pulsing at frequencies outside the hearing range of most moths; 
changing the pattern and frequency of echolocation pulses during prey pursuit; and quiet, or “stealth,” echolocation pulses that the 
moths cannot detect. Thus you have an ongoing co-evolutionary arms race between bats and moths. If you’d like to learn more and 
see scientists in the field studying this race for survival and success, check out “Moth Mimicry: Using Ultrasound to Avoid Bats” a 
video by HHMI Biointeractive found at www.biointeractive.org/classroom-resources/moth-mimicry-using-ultrasound-avoid-bats.

Box 1. Bats vs. Moths: A Co-evolutionary Arms Race

Bat Ecology Research

Because humans do not see well at night, gaining insight into the ecology of bats is challenging. Even 
determining whether a particular species is present in a given location can be difficult! One tool bat biologists 
often use to determine which bat species are present is a mist net. These nets are made with fine filaments 
that are often undetected by flying bats until it’s too late and their flight momentum has carried them into 
the net, where their wings and feet become entangled. Researchers can then extract the bats from the net for 
study. When a bat is “in the hand,” knowledgeable researchers can readily identify its species. Catching a bat 
of a particular species in a mist net is proof that the species is, in fact, found at that location. However, some 
bats are not easily captured in mist nets, particularly species that tend to forage higher in the sky—i.e., above 
the top of standard bat mist nets. Consequently, you can’t conclude that a particular species doesn’t occur in 
an area just because you haven’t captured that species in your mist nets. While mist nets are important tools 
that many researchers use to survey local bat species, their limitations often require the use of additional 
survey methods. 

Acoustic surveys are the most common additional method researchers use to document the presence of 
different bat species. Because bat echolocation traveling pulses can provide species-specific information, 
researchers can deploy automated ultrasonic recorders to undertake an acoustic survey for bat species. These 
ultrasonic recorders can often document bat species that are difficult to capture in mist nets. In addition, 
unlike mist nets, acoustic surveys have no physical impact on bats or on their behavior.

Echolocating bats also produce a set of vocalizations termed “social calls,” which bats use to interact with 
each other, usually at their roost. Social calls are usually within the range of human hearing, and people 
fortunate (or misfortunate) to have bats roosting in their home’s attic can often hear these calls. Similar to bat 
feeding buzzes, social calls are not generally used to identify bats to the species level.

https://www.biointeractive.org/classroom-resources/moth-mimicry-using-ultrasound-avoid-bats
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While acoustic surveys are a valuable research tool, they also have limitations that are important for 
researchers to understand. Some similarly sized bat species produce highly similar echolocation travel pulses. 
For example, it is exceptionally difficult to tell the difference between a Little Brown Bat (Myotis lucifugus) 
and the closely related Indiana Bat (Myotis sodalis), particularly because their geographic ranges overlap 
(they can live in the same area). Because the Indiana Bat is an endangered species, researchers need certainty 
in determining where they still remain so that efforts to improve their conservation status can be most 
effective. Some bats species also produce pulses that are relatively quiet and difficult to pick up, even by 
sensitive microphones. Some other bat species fly relatively high and are less likely to be recorded than lower 
flying species.
 
Another major limitation of bat acoustic surveys is that they are not appropriate for determining population 
estimates. Acoustic recordings cannot tell a researcher how many bats are present at a particular location. For 
example, if a recording contains 100 audio files that contain bat echolocation traveling pulses, the researcher 
has an irresolvable conundrum: Are these 100 files evidence of 100 individual bats that passed by the 
microphone, or could they represent one single bat that flew by the microphone 100 times? Perhaps those 100 
files represent 20 bats that flew by 5 times each. Or 10 bats that flew by 10 times each. Given this uncertainty, 
bat acoustic surveys are more often used to simply document the presence of a particular species.
 
Although bat acoustic surveys are not useful for population counts, they can, nonetheless provide a very 
useful measure of how bat activity compares between two locations or between species. Researchers can use 
these measures of relative bat activity to explore which types of habitat a particular species of bat prefers. 
Acoustic surveys can also tell researchers how bat activity changes throughout the night and across the 
seasons.

DISCUSSION QUESTIONS
1. Why didn’t Maya ask how many bats are near her school, or how many individuals of each species are 

present? 
2. List other types of questions about bats that are not easily answered with acoustic monitoring. How might 

you study bats to answer these questions?

Now that Maya has a better understanding of how bats use sound and how acoustic monitoring works, she would 
like to know more about the bats flying near her high school. Maya meets with Dr. Clark and Kaitlyn to discuss 
the possibilities. As a team, they decide that Maya will investigate the following questions: what bat species 
are present near her high school? Which bat species are most active? How does bat activity change through the 
night?
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2.2 GETTING STARTED ON A BIOACOUSTICS MONITORING PROJECT
Right before school’s summer break, Maya is ready to get started. Dr. Clark has an extra acoustic monitor that is 
not currently being used (Figure 4) and Maya works with her teacher and school to get permission to put it on her 
school’s roof. The research team gets together on May 1st to set up the recorder and train her on how to check 
the batteries and download the digitally recorded sound data (Figure 5).

Maya checks on the unit with her teacher the day after installing it, to make sure it is working and recording 
bat calls. Once Maya and her teacher are confident that the unit is working, Maya will visit the unit each week 
to download the recording data. In addition, Maya charges the batteries every two weeks. By July 24th, Maya 
has all the data for her project downloaded. In August, she meets up with Dr. Clark and they work together to 
analyze the data. Recall that bat calls are not within the normal hearing range of people, so they can’t just play 
back the recordings and listen for bats. They have to use a software to help them identify what is a bat call and 
also what species it likely is coming from. In this case, Dr. Clark teaches Maya how to use an acoustic software 
program called Kaleidoscope, made by a company called Wildlife Acoustics, which specializes in analyzing bat 
acoustic data. Another widely used acoustic software program used to identify North American bat vocalizations 
is Sonabat (sonobat.com/).

Figure 4. The SM4Bat recorder and microphone made by 
Wildlife Acoustics. The recorder can be programmed to record at 
specific times. Bat researchers typically record from 30 minutes 
before sunset to 30 minutes after sunrise, when most bat 
species will forage for food.

Figure 5. A typical set up for the SM4 Bat recorder and 
microphone—here, on a high school in the Bronx, NY. The further 
the microphone is away from other structures, the better. Ideally, 
microphones should be set at least 3 meters above the ground 
or (seen here) above the roof to minimize clutter in recordings. 
Clutter is the reflection of pulses off nearby hard surfaces that 
can obfuscate, or "clutter" recordings—making them more difficult 
to interpret.

https://sonobat.com/
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2.2.1 How to Run Bat Recording Auto ID Analysis in Kaleidoscope
Note: You do not need to follow these Kaleidoscope instructions to complete this exercise. Instructions and 
details are here for you to understand how the software works and to learn more about bioacoustic analysis. 
Additionally, these instructions will be helpful if you will be working with Kaleidoscope in the future. In Part 2.2.2, 
you are provided instructions on visualizing the results of the analysis completed for you in Part 2.2.1.

To help prepare Maya for their meeting, Dr. Clark recommended that Maya watch the video tutorial on how to 
use Kaleidoscope to auto-ID bats provided by Wildlife Acoustics. To watch this video, Maya went online to the 
Wildlife Acoustics website: www.wildlifeacoustics.com/ and clicked on “Video Tutorials” under the “Resources” 
tab and then clicked on “Kaleidoscope Pro Software.” She then clicked on “Auto-ID For Bats” under “Kaleidoscope 
Pro Features” and watched the “Auto-ID For Bats Quickstart Tutorial.” (Maya could have gone directly to this web 
page to start watching the video tutorial: www.wildlifeacoustics.com/resources/video-tutorials/kaleidoscope-pro-
software/en/kaleidoscope-pro-software-auto-id-for-bats-quickstart-tutorial-english.) Sample bat recordings used 
in the tutorial and a PDF of the video transcript are also available in conjunction with this video tutorial.

After watching the video tutorial, Maya met with Dr. Clark who explained how software programs such as 
Kaleidoscope analyze bat echolocation pulses to make species identifications (IDs). Maya was surprised to learn 
that no software program can be 100% accurate in ascribing bat echolocation pulses to a particular species. 
Maya remembered that closely related bat species and bat species of similar sizes can produce highly similar 
vocalizations that even bat acoustic experts may not be able to accurately identify. While bat vocalization auto-
ID software programs continue to improve in their accuracy, these programs remain imperfect. Because of these 
limitations, Dr. Clark noted that he prefers to take a conservative approach to bat vocalization analysis. For any 
tricky or difficult to determine recordings, he would rather not assign a species ID to a particular vocalization than 
to risk misidentifying that vocalization.

Maya then followed the steps provided by Dr. Clark:

1. Open Kaleidoscope (see screenshot of software below to follow along with where these below selection are 
made).
a. At the upper left corner of screen, make sure that “Bat Analysis Mode” tab is selected and not “Non-bat 

Analysis Mode.”
b. At the upper right corner of screen, make sure that “Use 5/5 computer resources” tab is selected. Note: 

This option uses the maximum amount of available computer resources to analyze the bat recordings. 
If the computer was also running other programs that required substantial computer resources, fewer 
resources could be selected, but then the analysis requires more time.

2. Go to “Signal Params” tab.
a. Change the “Minimum number of pulses” to “3”. This option requires that a file must have a minimum of 

3 bat pulses before Kaleidoscope will try to identify which species produced a pulse. Note: This option is 
more conservative than leaving the minimum number of pulses at “2”. 

b. Leave all other default settings.

3. Go to “Auto ID for Bats” tab.
a. Select “Bats of North America 5.1.0” (or more recent version if one is available).
b. Select “+1 More Accurate (Conservative).” (Not shown in screenshot.) Note: Because auto-ID of bat pulses 

is not an exact science, Dr. Clark prefers that Kaleidoscope run in its Conservative mode. As a result, 
Kaleidoscope will positively ID fewer bat pulses, but the program will also make fewer misidentifications.

c. Select by Region (State): e.g., “New York.” (Not shown in screenshot.) Note: Kaleidoscope compares 

https://www.wildlifeacoustics.com/
https://www.wildlifeacoustics.com/resources/video-tutorials/kaleidoscope-pro-software/en/kaleidoscope-pro-software-auto-id-for-bats-quickstart-tutorial-english
https://www.wildlifeacoustics.com/resources/video-tutorials/kaleidoscope-pro-software/en/kaleidoscope-pro-software-auto-id-for-bats-quickstart-tutorial-english


CASE STUDY & EXERCISE84

LESSONS IN CONSERVATION VOLUME 10 JANUARY 2020

your recordings to recordings of local bat species it keeps in libraries for each species. If you don’t limit 
the potential bat species to only those found in your state (or region), Kaleidoscope is almost certain to 
misidentify many of your calls.  

4. Confirm these tabs are disabled: “Cluster Analysis,” “Cloud,” and “Db.” We will not be using these software 
capabilities. 

5. Go to “Batch” tab. 

6. For “INPUTS”:
a. Set input directory (use “Browse” to find the file where your recordings are located).
b. Check “Wav (and W4V) files” (Wav and W4V flies are different types of audio files that the unit recorded). 

7. For “OUTPUTS”:
a. First, you will need to create an output folder—this is the folder where the results of the auto-ID process 

will go. Caveat: this folder can’t be within the input folder. You may wish to give the output folder the 
same name as the input folder, but with additional text that separates from the input folder (e.g., input 
folder: “Bronx Zoo – July 2018,” and output folder: “Bronx Zoo – July 2018 – output”).

b. Set output directory (use “Browse” to find the output file you created).
c. Select “None” for “Create subdirectories.”
d. Change “Split to max duration, seconds” to “8”. (Not shown in screenshot.) Note: Individuals bat recording 

files can be as long as 15 seconds. To help standardize data analysis, Dr. Clark recommends using this 
function to keep maximum file length to 8 seconds, which is also the maximum duration other bat analysis 
software programs can analyze.
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e. Check “Wav (and W4V) files.” “Wav files are a full-spectrum recording format. You may be more familiar 
with MP3 or MP4 recording formats, which only include some components of a sound and are often used 
for digital music to reduce the amount of data space a full-spectrum recording would require. 

f. Select “None” for “Compression.” Sound recordings can be compressed. But here, we want the 
uncompressed recording to facilitate data analysis.

g. Select “1” for “Time expansion factor.” Wav files can be recorded in a “time expansion” format that allows 
data to be added to a recording. Here, Kaleidoscope is simply asking if the recordings were recorded with 
a time expansion factor. Wildlife Acoustic bat recorders do not use time expansion factors, so the setting 
here is simply “1”.

h. Select “Delete noise files.” So, what are these noise files? Many sounds contain ultrasonic elements. 
For example, if you snap your fingers, you will be producing sounds in both our hearing range and 
the ultrasonic range. Sirens, HVAC equipment, even some insects all produce sounds with ultrasonic 
components. Kaleidoscope is programmed to recognize sounds that, while in the ultrasonic range, are not 
bat calls. Those files are labelled “noise.” If you selected the “Delete noise files” option, those files will be 
automatically deleted and not considered when the bat recording data are analyzed. 

i. Select “Extract GPS Disabled.” If you were conducted an active survey, moving between locations while 
recording bats, you could enable the GPS function which automatically puts GPS location data on each 
recording so that you know both when and where the bat was recorded. 

8. Click the “Process Files” button at the bottom right.

Note 1: When Kaleidoscope finishes processing files, two new windows will pop up: a “viewer” file that shows a 
spectrogram of the first call in the output folder and a “results” file. These windows are used to manually review 
each call and its ID after Kaleidoscope runs. Dr. Clark noted that Maya would not be using those windows, so she 
should simply close them. 
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Note 2: Dr. Clark also mentioned that 2 gigabytes (GB) of recorded data usually takes about 2 minutes to process 
on his computer, but that the speed at which Kaleidoscope auto-IDs files run will vary greatly, depending on 
the capability of the computer on which Kaleidoscope is run. Kaleidoscope can also be run while in the “Cloud.” 
Instructions on how to run Kaleidoscope in the Cloud were provided to your teacher/supervisor, should they 
prefer that approach to identifying bat calls.

After Kaleidoscope finishes processing the files, the analyzed calls are placed in the folder you created for output. 
At the very bottom of that file are three CSV files: “id,” “id summary,” and “meta.” The primary file of interest is the 
“id” file.

Things for Further Consideration from Dr. Clark

2.2.2 Interpreting the Data and Visualizing the Results

Bat researchers using acoustic recorders to survey bats usually receive specialized training in how to identify bat species using 
acoustic recordings. Developing such expertise can take a considerable amount of time and effort. Such researchers usually use bat 
auto-ID software as a starting point for their analyses. After running a program such as Kaleidoscope, researchers carefully review 
many, if not all, individual recordings to confirm, correct, or supplement the program’s auto-ID selection. For example, a limitation of 
bat auto-ID programs is that they can only assign one ID to a recording file. However, a recording file can sometimes contain more 
than one bat species or more than one individual of the same species. A knowledgeable researcher can look at a recording, determine 
if it contains pulses of two or more bat species, and update to file’s information to reflect that situation using the windows described 
above in “Note 1.” 

However, Dr. Clark doesn’t expect his high school student researchers to become bat vocalization ID experts! Rather, he recommends 
that, since most student researchers do not have the expertise required to evaluate the accuracy of a software program’s auto-ID 
selections, students set the program’s parameters to its most conservative settings. Dr. Clark also notes that if Kaleidoscope auto-
IDed a few pulses in one or more of your recordings as coming from an unlikely or rare bat species, you should be highly skeptical of 
that ID. If possible, you might want to find a local bat vocalization expert and share those unlikely IDs for their expert opinion. 

Just because pulses cannot always be identified confidently to the species level doesn’t mean that those bat recordings don’t have 
important value. Unidentified ultrasonic bat pulses are evidence of bat activity. So, for instance, if a researcher wants to compare 
when at night bats are most active overall, their research can include both identified and unidentified pulses. Also, if a researcher is 
comparing overall bat activity between two sites, unidentified bat pulses can be included in the analyses. 

Maya is now ready to start exploring the data found in Kaleidoscope’s “id” file, but when she opens it, it is very 
hard to interpret. Here you’ll help Maya summarize and visualize the results from the “id” file and answer these 
five questions.

During June and July…
Question 1: What bat species are present near Maya’s high school?
Question 2: Which bat species is the most active?
Question 3: What is the average activity for the most active bat species?
Question 4: How does hourly average bat activity change throughout the night? 
Question 5: Do the two most active bat species have different patterns of activity through the night?

Instructions:
1. Open the “id” file produced by Kaleidoscope as a CSV file. CSV files are comma delimited files and can be 

opened in spreadsheet software, such as Microsoft Excel or Google Sheets. The instructions below are 
explained using Microsoft Excel for Mac (Office 365 Version 16.30), but similar capabilities are possible with 
other software. You may need to adjust the instructions to the needs of the spreadsheet software you are 
using.
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2. Once you have opened the spreadsheet, familiarize yourself with the data. Many of the columns will not be 
relevant for your analyses. In this case, we will only need the following columns: “Date-12,” “Hour-12,” and 
“AUTO ID." Note: most North American bats are nocturnal, so we tend to describe bat activity per night. 
However, because a “night” covers two different calendar days and because we use the same numbers to 
describe two different times of day (e.g., 1:00 am versus 1:00 pm) tracking and describing bat recording data 
can be very confusing. Therefore, we use “Date-12” and “Hour-12” to convert these data to formats that are 
easier to track and understand when thinking of “nights." To create a new worksheet in your spreadsheet with 
only these data:
a. Click the “+” tab at the bottom of the worksheet, next to the tab titled “id.”

b. In the original data sheet tab, highlight the column you are interested in by clicking on the letter above it 
(in this case, columns M, O, and P).

c. Once it is highlighted, right-click on the column and select “Copy,” or press “command-c.” (Note: on a 
Windows computer, press “ctrl” instead of “command.”) 

d. In your new worksheet, select the first open cell, right-click and select “Paste,” or press “command-v.”
e. Repeat b-d for the additional two columns.

• Tip: Alternatively, you can copy all three columns at once by holding the “command” key down while 
selecting each column and then selecting “Copy” or pressing “command-c.”

f. Your new worksheet should look like the screenshot below. You can also rename the new worksheet 
“Question 1 & 2” by right-clicking on the tab at the bottom and selecting “Rename.”

g. Then make three more blank worksheets (by clicking on “+” button) and rename them “Question 3,” 
“Question 4,” and “Question 5” for use in future steps. 
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h. Save your workbook with a new file name that includes your name or group name in it.

3. Question 1: What bat species are present near Maya’s High School?  
For Question 1, look at your third column, “AUTO ID.” Tip: You might want to use the “Filter” function under 
the “Data” menu to easily determine what the species/categories are in the AUTO ID column. 
What are the different IDs that appear?  
What species names do they correspond to? 
Tip: Do an Internet search for the bats of New York State and compare the list of scientific names to the 
abbreviation IDs. There is a pattern to the abbreviations, see if you can figure it out!

4. Question 2: Which bat species is most active?  
For Question 2, we recommend that you create a pie chart to compare the relative activity of each bat species. 
Note: data can be presented graphically in several formats (e.g., line graphs, bar graphs, pie charts, etc.), but 
a pie chart is a good way to look at this data set. To create a pie chart:
a. First, delete all rows that list “Noise” in the Auto-ID column.

• Tip: Select the first 3 columns (the data columns) on the worksheet (“DATE-12,” “HOUR-12,” and 
“AUTO-ID”) by holding shift while clicking the column letter headers. In the toolbar on the top, click the 
Data menu and then “Sort.” Under “Column,” select “AUTO ID” and press “OK.” 

• CAUTION: Make sure that you don’t sort only the “AUTO ID” column; all columns must be sorted 
together to make sure that the data in each row refers to the same data file.
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b. Your data should now be sorted by ID. Scroll down through your data to the entries with “Noise” as the 
“AUTO ID” category. Then select all rows with “Noise” as their ID and delete (click on the first row number 
and last that has “Noise” as the ID and then scroll to the last that has “Noise” and hold the Shift button 
while you select the last row that has “Noise” and then hit the delete button). 

c. Next to the data columns, make a new column heading in your Questions 1 & 2 worksheet called “Total 
Passes.”

d. Then, make a column heading for each variable (ID code) in the “AUTO ID” column (excluding the variable 
“Noise”). 
• Tip: You should have a total of 8 new columns.

e. Determine the total amount of activity by counting the total number of passes completed by all bats. This 
will be the total number of rows in your data set, including those identified as “No ID.” Put this number 
under “Total Passes.” 
• Tip: You can use the row number on the left side of the screen, but don’t forget to exclude the title row 

in your count!
f. Next, determine the amount of activity for each bat species by counting the total number of rows 

recorded for each species. Put this number under the column you’ve just made for the species IDs. 
• Tip: You can use the row number on the left side of the screen and do math to figure out how many 

rows for each ID, or use the Excel formula “COUNTIF” which counts a cell within a range of cells if it 
meets a criteria that you set. To use “COUNTIF”, enter “=COUNTIF( ”under the species column you 
are working on, select the entire “AUTO ID” column and then type a comma and the species ID code 
of interest in “ ” and end the formula with an end parentheses. For example: =COUNTIF(C:C, “NoID”) 
would get you a count of all of the instances of “NoID” in the “AUTO ID” column. 

• Tip: Check your work! Enter “=SUM(” into a blank cell, and select all your totals for each AUTO ID 
category. Press enter. This number should match the number under “Total Passes.”

g. To create a pie chart, highlight the column title and count number for each of your species, including 
“NoID.” Do not include “Total Passes.” In the toolbar on the top, select the “Insert” menu, then click on the 
image of a pie chart, and select the type of pie chart you want to create.
• Tip: you can edit your final pie chart’s colors, text, and layout using the “Chart Design” options that 

will appear when the chart is created.

h. Save your workbook.

What is the total number of passes? 

Why can we include “No ID” passes in this calculation for total bat activity?

Which bat species was the most active? (You will use this species to answer the next two questions.)

5. Question 3: What is the average activity for the most active bat species? For Question 3, we want to determine 
the average number of passes per night for the species that is most active. Tip: we recommend using a new 
tab (worksheet) for this analysis—copy and paste the three data columns from your Question 1 & 2 sheet into 
the worksheet you named Question 3.
a. First, we want to sort the data by date.

• Tip: See step 4a for a reminder on how to sort your data.
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b. Next, we want to only look at our most active species. Select the column “AUTO ID,” and in the “Data” 
menu, select “Filter.” A small black arrow should now appear next to the “AUTO ID” column. Click the 
arrow, and a box will pop up. Deselect “Select all” and then select only the species you are interested in. 
Click outside of the pop up box to exit the box.

c. Insert a column next to “AUTO ID” titled “# Passes per Night." In this column, use the “Count” formula to 
determine the number of rows (or passes) that occurred for each date. 
• Tip: To use “Count” formula, enter “=COUNT(” under “# Passes per Night” and next to your date of 

interest and select all the entries that are the same date in column A (“DATE-12”) and press enter (for 
example, highlight all of the 5/10/19 dates). Scroll to the next date and repeat this process (by using 
the “Count” formula in the # of Passes per Night column next to each new date for each of the dates 
with recordings). 

d. At the bottom of the # Passes per Night” column, enter “=SUBTOTAL(1, ” and select all of your data in the 
“# Passes per Night” column (can include blank cells) to determine the average number of passes per night 
for this species. Press enter. (See screenshot below.)
• Tip: Because we have filtered the data, we cannot use the “Average” function here. Instead, we use 

“Subtotal,” and we indicate a “1” to tell the function to take an average. In this formula, you could also 
use “9” to take a sum, or “2” for count. 

During your analysis, did you notice any dates that were missing?  What do you think the reasoning for this is?

What do you think this will do to our average calculation?
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e. Go back through the data and find any dates that are missing. If a date is missing, right-click (or two 
finger click on Mac touch pad) the row number below the missing date and click “Insert Row.” A blank row 
should now appear in your data set. Fill in the missing date under “DATE-12,” and indicate “0” for “# Passes 
per Night.” Complete this for all missing dates in the data set. Note: This step would not be taken if the 
recording unit was malfunctioning for any particular night, but in this case, Maya did not have any issue 
with her recording unit not working.

f. Save your workbook.

How did this change your average number of passes per night? 

6. Question 4: How does hourly average bat activity change throughout the night?  
For Question 4, we will create a line graph to show how bat activity changes over time. 
a. First, go to your Question 1 & 2 worksheet and copy three data columns and paste in your Question 4 

worksheet.
b. Sort the data by “HOUR-12” (see 4a above). Then, we will again filter “AUTO ID” for our most active species 

(see 5b above). 
c. For graphing purposes, make new column headings next to the data columns for each hour of the day. To 

the left of your new columns, label the top row “Hour-12.” Label the next row “[Species] Count” with the 
abbreviation for the most active species in brackets. 
• Tip: you should have 24 new columns labeled from “0” to “23,” plus an additional column with row 

labels.

d. Under each new column, use the “Count” formula to determine the number of rows that occurred for each 
hour (see 5c above). Be sure to indicate “0” below the column header if there are no passes recorded that 
hour.

e. Next, check your work by adding up all your count data in this row and comparing it to the total you had 
in the Question 1 & 2 worksheet. 
• Tip: You can use the “Sum” formula to add across the row. Type “=SUM(” and highlight the row of 

count data and press Enter. 
f. To create your graph, select all the cells with the count calculations you have created (do not include the 

column headings). In the toolbar on the top, click the “Insert” tab and then select the line chart icon and 
then select “Line with Markers” option.

g. Use the “Chart Design” tab (visible when chart is selected) to edit your graph, adding axis titles and a main 
title. You can also edit its color and layout. 

h. To make your graph more accessible, we suggest you edit the x-axis labels to reflect the 24-hour clock, 
rather than the HOUR-12 numbers. To do this you will first need to translate the HOUR-12 data to the 
corresponding hour on the 24-hour clock. 
• Scroll past your calculations and make a list of these numbers in an empty column (see screenshot). 

These numbers represent the 24-HOUR clock times that correspond to the HOUR-12 data. For 
example, hour 23 for the HOUR-12 data is equivalent to 11 am in the 24-hour clock and hour 12 for the 
HOUR-12 data is equivalent to 0 (or midnight) for the 24-hour clock.
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• Now click on your chart and the “Chart Design” tab will appear on the top tool bar. Select the “Select 
Data” button and a pop up box will appear.

• Navigate to the “Horizontal (Category) axis labels:” field and click on the icon on the right. 
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• The window will minimize and then you use your cursor to select your newly listed times, and the 
formula will automatically appear in the “Select Data Source” box.

• Hit “Enter” and then the full “Select Data Source” box will return and then you hit “OK.”

• You will now notice that the x-axis labels on your chart have changed to reflect the 24-hour clock 
times, with the first label starting with 12 (noon) and the last ending with 23 (11 pm). Following this 
procedure will ensure that the middle of your chart corresponds to the night-time hours (the hours the 
bats are active).

• Save your workbook.
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How does average bat activity change throughout the night? (Describe this species’ nightly activity trend shown in 
the graph.)

7. Question 5: Do the two most active bat species have different patterns of activity through the night? 
a. We recommend copying over the three columns of data from the Question 1 & 2 worksheet and pasting 

them your Question 5 worksheet for this analysis.
b. For Question 5, repeat steps 6a-h (Question 4), but filter “AUTO-ID” with the second most active bat (see 

Question 2). 

Compare this chart to the one completed in Question 4. How is average nightly bat activity different or the same 
for these two species?

c. Now we will copy over the count data from Question 4 because we’ll be graphing the activity for both of 
the most active bats on the same chart.

d. Navigate to your Question 4 worksheet and select the count data from Question 4 and copy it.
e. Under the first cell for your count data for Question 5, right-click the cell and select “Paste Special.” Under 

the section “Paste,” click “Values,” then hit “OK.” Be sure to include the row label. 
f. To create your graph, highlight both count calculations. In the toolbar on the top, click “Insert,” then select 

the line chart icon, and select “Lines with Marks.” 
g. Change the x-axis labels by repeating the step 6.g above.

• Tip: To get the “Select Data” pop up, you can also right-click the graph and select “Select Data.” After 
selecting your “Horizontal (Category) axis labels,” you can also edit your chart legend: Under “Series,” 
select the series whose name you want to change, and type the appropriate species name under 
“Name.” Repeat for the other series, then click “OK.” 

You’ll notice that the shape of the second species activity looks different now that it’s graphed with the activity of 
the first. Why is that?

h. To get a clearer picture of the patterns of activity between these two species, we can graph the percent of 
all passes that happen in each hour for each species. So if there were a total of 100 passes for species A 
and two of them happened in the 9 pm hour, then it’d be 2%. And if species B had a total of 1000 passes 
and 20 of them happened 9 pm hour, then it’d also be 2%. Looking at it this way, we can now say that 
relative to their total activity throughout the night, each species has a 2% of their activity in the 9pm hour. 
Let’s now try it with our data.

i. Scroll over to the end of your count data and make a new column headed “Total Passes.”
j. For your first row of count data, add up all of the passes for your second most active species. You can do 

the math in your head, or use the sum formula by typing in the cell under “Total Passes “=SUM(” and then 
highlighting the count data in the first row and hitting enter. 

k. Repeat this for the next row (the count data copied over from Question 4, your first most active species). 
You will now have to the total number of passes for each species.

l. Below the copied over count data from Question 4, you will start a new row that will calculate the 
percentage of passes per hour for your second most active species. Label this row “[Species] %” with the 
abbreviation of the second most active species in the brackets. In the first hour column (“0”), type “=”, and 
click the count data for that hour. Then type “/”, and click the number in your “Total Passes” column. Hit 
enter. Repeat for each hour.

m. In the next row down, repeat step 7.l for your most active species.
n. You can check your work to and make sure that your total percentage for each species equals 100 by 

using the “Sum” formula for the percentage rows under the “Total Passes” column.
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o. Repeat step 7.f-g to re-graph relative species activity but using the percentage data. 

Looking at relative activity (comparing percentages), does the second most active species demonstrate similar 
nightly activity patterns, or does it behave differently? If differently, how does it differ?

8. Please save your Excel workbook (confirm your name is incorporated in the file name) and submit your results 
as instructed by your teacher.

REFLECTION AND THINKING FORWARD

ACKNOWLEDGMENTS

1. Write up a brief summary of Maya’s findings.
2. Were there any results that surprised you or you found particularly interesting? What did you expect and 

what did you find?
3. Maya thinks these results will make an exciting science fair project, but she still has some time before it’s due. 

Help her brainstorm other questions she might be able to answer with her data set. If you were to expand the 
study, how would you do it? What would you need? What other questions might you ask? 

We would like to acknowledge Rachel Pak for her contributions to this exercise. Support for City Bats was 
generously provided by a grant from the Achelis & Bodman Foundation.
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Modeling Suitable Habitat for a Species of Conservation 
Concern: An Introduction to Spatial Analysis with QGIS
Peter J. Galante, Katherine Hade, Stefanie J. Siller, Nadav Gazit, and Suzanne K. Macey
Center for Biodiversity and Conservation, American Museum of Natural History, New York, NY, USA

ABSTRACT

LEARNING OBJECTIVES

INTRODUCTION

What is Spatial Analysis?

Spatial analysis has become a central practice in the field of conservation, allowing scientists to model and 
explore geographic questions on biodiversity and ecological systems. GIS (Geographic Information System) is an 
important integrative tool for mapping, analyzing, and creating data for spatial analyses. In this exercise, students 
use QGIS, a free open-source GIS program, to model suitable habitat for a cryptic mammal species. The exercise 
guides students through the process of: 1) organizing, cleaning, and clipping vector and raster data within 
QGIS; 2) analyzing climate, habitat, and additional geographic data along with species occurrence data; and 3) 
developing a map of suitable projected habitat for the species of interest. Students then apply their analyses to 
critically consider the implications for surveying and conservation action. 

After completing this exercise, students will be able to:
1. Use QGIS as a tool for overlay modeling and visualizing climate, habitat, geographic, and species occurrence 

data.
2. Apply spatial analysis results to make survey recommendations for a cryptic species of conservation concern.
3. Consider and discuss the potential uses and limitations of the data and the type of spatial analysis used in 

this exercise for making conservation decisions.

“The ultimate goal is to learn how to solve problems spatially.” 
 - Harder, C., and C. Brown. 2017. The ArcGIS Book: 10 Big Ideas About Applying the Science of Where. Esri Press, 
Redlands, CA, USA.

You’ve been asked to help a small non-profit conservation organization prioritize where they should survey for 
Treelopii in New York State. Treelopi (plural for Treelop) are medium-sized mammals that are rare and cryptic—
meaning they are not easily seen. Partially because Treelopi are elusive, we know very little about them, but what 
we do understand from past observations and studies is that Treelopi:
• have dense fur and prefer a specific temperature range,
• prefer natural areas (non-agricultural or built lands) that are forested and/or have plentiful woody vegetation, 

and
• prefer remote areas (Treelopi are shy and solitary animals and avoid major roads).

The New York State-based conservation organization you are consulting for would like to understand whether 
there should be more efforts to conserve this species at the state-level. Because they don’t have a firm 
understanding of how many Treelopi are in the state, they’d like to start a survey and monitoring project. Where 
should they start looking for Treelopi? You will be learning skills in spatial analysis to help answer this question 
and prioritize areas to survey in New York State. 

iTreelopi are an imaginary mammal species for the purposes of this exercise. Although this exercise focuses on this imaginary species, the 
skills used in this exercise are real examples of how one might use spatial analysis for conservation purposes.

“Spatial analysis is a process in which you model problems geographically, derive results by computer processing, 
and then explore and examine those results. This type of analysis has proven to be highly effective for evaluating 
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the geographic suitability of certain locations for specific purposes, estimating and predicting outcomes, 
interpreting and understanding change, detecting important patterns hidden in your information, and much 
more.”
 - Harder, C., and C. Brown. 2017. The ArcGIS Book: 10 Big Ideas About Applying the Science of Where. Esri Press, 
Redlands, CA, USA.

Spatial analysis offers a wide variety of tools, used in fields such as urban planning and geology. In the field of 
conservation, researchers use spatial analysis to help determine biodiversity hotspots and delineate protected 
areas, examine the effects of climate change on species or ecosystems, model the potential effects of the 
construction of dams, and more (Box 1).

In this exercise, we will be overlaying descriptive habitat layers in a type of spatial analysis that will aid in 
determining suitable areas to survey for a rare species (the Treelop) based on known environmental tolerances 
such as temperature, or available habitat parameters. Throughout the exercise, take time to reflect and respond 
to the questions and prompts provided before moving on; these will help you think critically through the process 
and also help for writing your final summary and recommendations.

Using spatial analysis to understand a species' 
current or potential geographic range is crucial 
for conservation action. The International Union 
for Conservation of Nature (IUCN) Red List uses 
two main measures of geographic criterion in 
evaluating the conservation status of a taxon: 
extent of occurrence and area of occupancy. 
Extent of occurrence refers to the smallest possible 
continuous boundary around all known or projected 
sites where the specific taxon occurs. This measure 
is useful for evaluating threats that may be present 
across a taxon's geographical distribution. Area of 
occupancy, on the other hand, is defined as the 
area within the extent of occurrence that is actually 
occupied by the taxon. This measure represents 
the amount of suitable habitat within the extent 
of occurrence. Figure 1 illustrates the differences 
between these two measurements. By estimating 
these spatial measures, conservationists can 
determine a taxon's conservation category and their 
extinction risk.

Image credit: IUCN. 2001. IUCN Red List 
Categories and Criteria: Version 3.1. Species 
Survival Commission. IUCN, Gland, Switzerland 
and Cambridge, UK. Available from www.iucn.
org/content/iucn-red-list-categories-and-criteria-
version-31. 

Figure 1. Two examples of the distinction between extent of occurrence 
and area of occupancy. (A) is the spatial distribution of known, inferred or 
projected sites of present occurrence. (B) shows one possible boundary to 
the extent of occurrence, which is the measured area within this boundary. 
(C) shows one measure of area of occupancy which can be achieved by the 
sum of the occupied grid squares.

Box 1: Spatial Analysis and the IUCN Red List

Question 1: 

• Based on your understanding of the Treelop, what kind of geographical/climate data might be useful in 
determining suitable habitats? From a management/logistical perspective, what other variables should we 
consider?

https://www.iucn.org/content/iucn-red-list-categories-and-criteria-version-31
https://www.iucn.org/content/iucn-red-list-categories-and-criteria-version-31
https://www.iucn.org/content/iucn-red-list-categories-and-criteria-version-31
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PART 1: DOWNLOADING QGIS AND ORGANIZING YOUR DATA
1.1 Downloading QGIS

1.2 Setting Up a Directory

1.3 Download the Data

QGIS is an open-source Geographic Information System (GIS) that offers professional level tools for mapping, 
analysis, and creation of spatial data. 

QGIS offers updated releases and bug fixes often. For the purpose of this exercise, we recommend that you 
download the latest Long Term Release (LTR) version, rather than the latest update. While the most up to date 
bug fixes and updates are available daily, these versions have gone through less scrutiny.

QGIS is available for Mac OS, Windows, and Linux distributions. We have provided screenshots and detailed steps 
using Mac OS and version 3.4 of QGIS. While these might differ a bit from what you will be using to complete this 
exercise, you should still be able to use the same functions. We only highlight the specific options for each step, 
and do not detail every option in the dialogue boxes unless necessary.

To download QGIS go to qgis.org/en/site/forusers/download.html. You may also be interested in learning more 
about the background of some of the concepts of GIS that go beyond the scope of this exercise; QGIS provides a 
helpful documentation called “Gentle Introduction to GIS:” docs.qgis.org/3.4/en/docs/gentle_gis_introduction/. 
Of particular relevance are the Introducing GIS, Coordinate Reference Systems, and Vector Spatial Analysis 
sections. Another great resource is the QGIS tutorial found at: www.qgistutorials.com/en/index.html.

When using a GIS, being organized is imperative. Being unorganized will cost you time and effort!

It is best to manage your data in a single directory or a series of directories, meaning a single folder or a group 
of nested folders. When you are naming files or folders, be sure to name them carefully, descriptively, and in a 
standard way so they are easily understood in the future or by other researchers. Additionally, don’t use spaces 
in file/folder names (for example, “file name.shp”) when naming, because some GIS software programs have 
trouble reading certain characters in file/folder names; using underscores “_” avoids this issue (“file_name.shp”). 
Similarly, avoid starting a name with a number or special character (*!@#, etc.) (e.g., “1_file_name.shp”). To avoid 
issues of this nature, we have suggested file names. 

To begin, create a new, empty directory (folder) on your computer called “Treelop_spatial_analysis” to act as your 
working directory. In this directory, we will save all of the data provided in Part 1.3 below, as well as all of the new 
GIS layers we will create during the rest of the exercise.

Finding appropriate data is not without challenges, such as: finding accurate and reliable sources; accounting for 
variation in data quality or resolution; calibrating for biases and gaps in the available data; or, if needed, finding 
data that is freely available and is not behind a paywall.

For your convenience, we have provided data that you will use to make recommendations for surveying for 
Treelopi. These are some of the data that could be helpful in the process; later on, we’ll ask you to reflect on what 
might be missing, or what next steps you would do after these initial spatial analyses.

Unzip “Treelop_data.zip,” as well as the compressed folders within, and put the Treelop_data folder in your 
“Treelop_spatial_analysis” directory. Inside the “Treelop_data” folder there are five types of data. See Table 1 for 
a list of the types of data including some metadata on the data and their sources. Note: if you are doing your 

https://qgis.org/en/site/forusers/download.html
https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/
http://www.qgistutorials.com/en/index.html
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Table 1. Provided data to determine Treelop survey locations.

FEATURE GEOGRAPHICAL 
EXTENT

SCALE/ 
RESOLUTION*

DIRECTORY/
FILENAME FOR 
THIS EXERCISE

INFORMATION/DATA SOURCE

Political 
Boundaries

United States of 
America

10 meter 
resolution

USA_states; 
USA.shp

Original name: ne_10m_admin_1_
states_provinces

https://www.
naturalearthdata.com/
downloads/10m-cultural-
vectors/10m-admin-1-
states-provinces/

Annual 
Mean 
Temperature

Northeastern 
United States of 
America

30 arc-seconds
resolution

NY_regional_
bio_1.tif

Original name: wc2.0_30s_tavg_01

Mean Annual Temperature in 
degrees Celsius. For this exercise, 
we’ve only included the New York 
regional data.

http://worldclim.org/
version2

Land cover New York 
State + Parts 
of Surrounding 
States

1:250,000 
scale

lancover; 
lulc250k.shp**

Collected by USGS and adapted by 
EPA. Cornell University Geospatial 
Information Repository (CUGIR) 
New York State land cover shapefile.

https://cugir.library.
cornell.edu/catalog/
cugir-008190

Major Roads Global 10 meter 
resolution

Roads; 
ne_10m_roads.
shp

Original name: ne_10m_roads

Interstate, Federal, and State roads

https://www.
naturalearthdata.com/
downloads/10m-cultural-
vectors/roads/

Treelop 
Occurrences

New York State Treelop_
sightings.csv

These were generated for this 
exercise.

https://ncep.amnh.org

*https://www.nrcan.gc.ca/maps-tools-publications/satellite-imagery-air-photos/remote-sensing-tutorials/satellites-sensors/spatial-
resolution-pixel-size-and-scale/9407
** “lulc” is widely known to stand for “land use/land cover” and the 250k represents the scale, which is “1:250,000.”

PART 2: GETTING STARTED

2.1 Create the Project

Reflection

Open QGIS and save your new project as “Treelop_spatial_analysis.qgz” in the working directory (the .qgz 
extension is the default extension for a QGIS project). 

2.2 Setting Up Your Workspace
To add some helpful toolbars, you can right click on the default toolbar that is on the top of your workspace and 
a menu will pop up. Select the “Manage Layers Toolbar” to add a new toolbar that will appear on the left side of 
your workspace.

own spatial analysis project, the listed data sources in Table 1 (e.g., naturalearthdata.com, worldclim.org) might 
be a good place to start your search for certain types of data. Additionally, these sites will normally provide a 
wealth of additional metadata, including how the data were collected, by whom, issues of data quality, as well as 
constraints and possible recommendations. 

Below, we will be walking you through the steps of some aspects of spatial analysis using QGIS. In addition 
to explicit instructions, we provide screenshots from version 3.4 of QGIS on a Mac OS. We highly suggest you 
use QGIS version 3.4 to avoid compatibility issues with our instructions and the software. Additionally, unless 
otherwise noted, we suggest that you do not modify the default settings that will populate a dialogue box when 
you run a tool.

Go back to your answer for Question 1. Compare these data to the variables you listed. What are the differences?

https://www.naturalearthdata.com/downloads/10m-cultural-vectors/10m-admin-1-states-provinces/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/10m-admin-1-states-provinces/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/10m-admin-1-states-provinces/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/10m-admin-1-states-provinces/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/10m-admin-1-states-provinces/
http://worldclim.org/version2
http://worldclim.org/version2
https://cugir.library.cornell.edu/catalog/cugir-008190
https://cugir.library.cornell.edu/catalog/cugir-008190
https://cugir.library.cornell.edu/catalog/cugir-008190
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/roads/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/roads/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/roads/
https://www.naturalearthdata.com/downloads/10m-cultural-vectors/roads/
https://ncep.amnh.org
https://www.nrcan.gc.ca/maps-tools-publications/satellite-imagery-air-photos/remote-sensing-tutorials/satellites-sensors/spatial-resolution-pixel-size-and-scale/9407
https://www.nrcan.gc.ca/maps-tools-publications/satellite-imagery-air-photos/remote-sensing-tutorials/satellites-sensors/spatial-resolution-pixel-size-and-scale/9407
http://naturalearthdata.com
http://worldclim.org
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2.3 Load the Data
Most aspects of spatial analysis can be represented through two types of data; vector1 and raster2. The vector 
data we will use in this exercise are shapefiles (saved as file_name.shp). These file types are standard in GIS 
and work across many GIS software (such as ArcGIS). Most vector data available online is in this file format. 
Vector data can represent point localities, lines, or polygons. Most raster data available online are in GeoTIFF 
format (file_name.tif), an image file that has geographic referencing embedded within it. Rasters can represent 
continuous gradients such as elevation, temperature, or ocean salinity. All the files in this module (other than .csv 
files) can be “dragged and dropped” from a folder into the Layers panel in QGIS. Alternatively, below are step by 
step instructions to add layers. 

1. Load political boundaries as a vector layer to your map.

Shapefiles are a vector format data storage file originally developed by ESRI (Environmental Systems Research 
Institute) for storing geometry3 and location information. These files are packaged with and linked to other files 
that are necessary to represent the geometry in GIS. For example, the file with the “.dbf” extension is the database 
file and contains the spreadsheet of information associated with each attribute. The “.shx” file is the index file, and 
the “.shp” file contains the shapefile geometry. These three files are necessary and need to be stored in the same 
directory for GIS to read the files, but only the file with the “.shp” extension needs to be loaded.

Navigate to the “Add Vector Layer” button. Alternatively, you can go to the Layer panel > Add Layer > Add 
Vector Layer. In the “Vector Dataset(s)” box under “Source,” click browse (the small ellipses button) and 
navigate to your working directory and then to the “USA_states” folder within “Treelop_data” directory and 
select “USA.shp”. Click “Add” and then “Close” in the “Data Source Manager” dialog box.
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2. Load mean annual temperature as a raster layer to your map.
Navigate to the “Add Raster Layer” button. Alternatively, you can go to the Layer panel > Add Layer > Add 
Raster Layer. In the “Raster Dataset(s)” box under “Source,” navigate to the “Treelop_data” folder and select 
“NY_regional_bio_1.tif”.
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3. Load land cover as a layer to your map. 
Add “lulc250k.shp” through one of the methods above. Consider that this file is a “.shp” file. Is it a raster or a 
vector?

If you click on the Information Tab in the Layer Properties dialog for this layer (double click on the layer name 
in the Layers panel), you might notice that the CRS (Coordinate Reference System) of this layer is different 
from the previously added layers. We will explain more about CRS later in the lesson, but these details are 
important to note.

4. Load major roads as a layer to your map.
Add “ne_10m_roads.shp” through one of the methods above, or try dragging it from your working directory 
and dropping into QGIS.

5. Load Treelop occurrences as a layer to your map.

Reminder: “.csv” files cannot be dragged and dropped.
Navigate to the “Add Delimited Text Layer” button. Alternatively, you can go to the Layer panel > Add Layer > 
Add Delimited Text Layer. In the “Data Source Manager” dialog box, under “File name,” navigate to “Treelop_
sightings.csv”. Note: This file is a comma-separated values file and was created in a format where periods 
represent decimal separators (instead of commas).

Under “Geometry Definition,” be sure to assign “Longitude” as the X field and “Latitude” as the Y field. (Just 
as on a typical graph with an X and Y axis, QGIS reads occurrence data based on these two axes: Longitude 
corresponds to the X axis, and Latitude corresponds with the Y axis.) Make sure that the Geometry CRS is set 
to “EPSG 4326 – WGS 84.” Click “Add” and then “Close” in the “Data Source Manager” dialog box. 
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SAVE your work. Click on the “Save Project” icon in the upper left of the toolbar, go to Project > Save, or press 
Command-S on a Mac.

PART 3: CLEANING UP THE DATA
Explore the data a bit. Using the “Pan Map” tool, click and drag to move around the map. If using a mouse with a 
scrolling wheel, scrolling up and down will zoom in and out on your map. You’ll notice that some of our data are 
global, national, or regional. Our task, however, is to highlight potential areas to survey in New York State only, 
and retaining large areas rich with information requires more computer memory and could slow down processing 
time. To focus our area of analysis and save processing time, we should crop the data down to just New York 
State. You’ll need to have your Layers panel active, which lists all of your loaded data (layers) on the left side like 
a table of contents of your map. If the Layers panel is not active, right click anywhere on the top default toolbar 
and select “Layers Panel” as you did for adding the “Manage Layers Toolbar.”

1. Begin with the states/provinces layer, “USA.”  In the Layers panel, hide all other layers by clicking on the check 
mark to the left of the layer to deactivate those layers.

2. Using the “Zoom Full” button, zoom to the extent of the shapefile “USA.” Note: The Zoom Full function will pan 
out, or in, to include the extent of all layers currently selected in the Layer panel. Alternatively, you can right 
click on the layer of interest in the Layers panel and select “Zoom to Layer.”

3. Create a new shapefile of New York:
a. An attribute table shows the data associated with geometry in the file. To open the Attribute Table, right-

click on the “USA” layer in the Layers panel. Select “Open Attribute Table.” Explore the Attribute Table. 
You will notice the wealth of information (attributes) available for each feature (each row) in the Attribute 
Table.
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b. Using an expression4 string, select the features of the “USA” layer that correspond with the attribute “New 
York.” In the Attribute Table, click on “Select features using an expression.” In the search bar, type “name” 
and double click on “name” in the window. It will appear in the Expression window. Click on the equals 
sign “=” above the Expression window. On the right side of the window is another search bar, “Values,” 
where you can search values within each field. Here, type in “New York,” then click “All Unique.” Double 
click on the field ‘New York’ and it should appear in the Expression window. Click “Select features.” On the 
map, New York State will be highlighted in yellow. Close the “Select by Expression” dialogue box.
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c. Back in the Attribute Table, in the lower left corner, change “Show All Features” to “Show Selected 
Features.” The row with data for New York State should be highlighted. 

d. Close the Attribute Table and inspect the map. New York should be highlighted. Right-click on the “USA” 
layer in the Layers panel and select “Zoom to Selection.” The map should jump to New York. 

e. To save the selection as its own layer, right-click on the layer in the Layers panel. Select “Export,” then 
“Save Selected Features As.” In “Format,” select “ESRI shapefile.” Navigate to the working directory by 
clicking on the ellipsis button next to the “File name” field. Name the file “NewYorkState” in the “Save As” 
field and hit “Save.” You will not need to change anything else in the dialogue box. Click “Ok” and the new 
layer will be added to the map. 
 
Tip: To avoid confusion with multiple similar layers, remove the “USA” layer by right-clicking on it and 
selecting “Remove Layer.” 
 
Note: You should always use the ellipses button to navigate to your working directory when creating a file 
and name the file in the “Browse” dialogue box to make sure your files are all located in one place.

SAVE the project

4. Next, we want to clip the land cover (“lulc250k”) and major roads (“ne_10m_roads”) layers to the extent 
of the New York State shapefile (we have already provided the “Treelop_sightings” data for New York State 
sightings only). To choose New York State in the USA shape file, we only had to use the Attribute Table 
because “States” was one of many attributes in the file. The other files, however, do not have an attribute that 
would allow us to choose them by state, and, therefore, we must use other tools in order to clip the data that 
we need.

a. Clip the land cover layer: Go to Vector > Geoprocessing Tools > Clip. Since we are interested in clipping 
the landcover layer (“lulc250k”), select it as the “Input layer,” and the “NewYorkState” shapefile as the 
“Overlay layer.” Under “Clipped,” click on the ellipsis button, and select “Save to File.” Name the new 
file “NY_landcover” and make sure that the file will be saved in your working directory (rather than the 
default output folder). Then make sure that you select “SHP files (*.shp)” instead of the default “GPKG files 
(*.gpkg)” in the dropdown menu at the bottom of the dialogue box (GeoPackage files are in a standard, 
non-proprietary file format that is compatible QGIS but may not be readable by other GIS software). Click 
“Save,” then “Run.” The clipped layer will automatically add to your Layers panel named as “Clipped.” Close 
the dialogue box and rename the “Clipped” layer to match the filename (“NY_landcover”) by right clicking 
on the layer in the Layers panel and selecting “Rename Layer.” 
 
Tip: if you add “.shp” to the filename it will automatically select shapefile as the output format. 
 
Note: If the “Vector” tab does not appear on the main toolbar, you will need to update all plugins. To 
update, go to Plugins > Manage and Install Plugins. Then click the button “Upgrade All.” The “Vector” tab 
should now be available.  
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b. Repeat the clip procedure for the major roads layer (“ne_10m_roads”), naming it “NY_roads”. 

c. After clipping the layers, select the check-boxes in the Layers panel to show only the newly clipped layers. 

SAVE the project

5. Crop the Mean Annual Temperature raster to the New York State shapefile. All previous files were in vector 
format (see glossary). The temperature data is in raster format, so we need to use a different tool in order to 
clip the layer. 

a. Go to Raster > Extraction > Clip Raster by Mask Layer. Set the “Input layer” to “NY_regional_bio_1” and 
the “Mask layer” to “NewYorkState.” Click the ellipses next to “Clipped (mask)” and then “Save to File” and 
set the file directory. Name this new raster file “NY_bio_1.” Save in .tif format. Click “Run” (Note: you may 
need to scroll down the dialog box to view all options.)

b. Close dialogue box and rename the “Clipped (mask)” layer on the Layers panel to match the new raster file 
name (“NY_bio_1”). 

c. Important: the newly clipped raster will draw on your map over the previous NY clipped layer. You can 
reorder the layers in your Layers panel so they draw on the map in a different order (allowing you to see 
them all clearly). Simply drag and drop the newly clipped layers in the Layers panel to your preferred 
order.
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Tip: To quickly find a tool by its name, you can activate the Processing Toolbox: go to View > Panels > Processing 
Toolbox Panel. Here you can type in a tool’s name and select.

SAVE the project

PART 4: ANALYZING THE DATA
Spatial Analysis
Now that we have layers that are specific to New York State, we can begin the analysis for our report. Until this 
point, we have been “cleaning up the data.” Now, we want to use spatial analysis to answer questions. 

In this part of the exercise, we will walk you through the spatial analyses steps, but if you were doing this on your 
own, you’d want to consider the following: how can you use these data to give an assessment of potential survey 
locations? Given what we know about Treelopi, what are some processes/tools you could use to analyze the data? 
How might the data interact and inform us about where we could find Treelopi? 

Brainstorm and write down your thoughts on these prompts. If there are other questions you have, what are they?

Let’s begin analyzing our data and create a visual output that can show us potential suitable habitats for Treelopi 
that match what we know about the species (refer to the first page of this exercise).

Reflection
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Steps:
4.1 Analyze climate data: Identify areas of New York State with suitable temperature for Treelopi.
4.2 Analyze habitat data: Identify areas of suitable habitat from land cover data.
4.3 Analyze road data: Determine areas of New York State that are not adjacent to major roads.
4.4 Identify the areas of overlap where there is suitable climate, habitat, and distance from roads. 

4.1 Analyze the Climate Data
1. We want to determine the areas with suitable mean annual temperatures for Treelopi. To do so requires 

several steps. We have sightings of Treelopi across New York State, and we can make the assumption that 
the mean annual temperatures associated with those locations are suitable for the species. Therefore, the 
first step is to reduce the raster of mean annual temperature to show only those areas that are within the 
temperature range in which Treelopi have been recorded.  
 
For this step, we’ll need to install a plugin. Plugins are a way for QGIS developers to increase the utility of the 
software past the base QGIS download. Go to Plugins > Manage and Install Plugins. In the “All” tab on the left, 
search for the “Point sampling tool” then click “Install plugin.” When the installation is over, close the dialogue 
box.

2. Next, we will extract the temperature values from “NY_bio_1” where Treelop has been seen. 

a. Select the “Treelop_sightings” layer in the Layers panel. Then, go to Plugins > Analyses > Point Sampling 
Tool. Select the “Treelop_sightings” layer for “Layer containing sampling points” (this should be selected 
by default). For “Layers with fields/bands to get values from,” select “NY_bio_1.” Make sure the “Add 
created layer to the map” box is checked. Navigate to your chosen file directory by clicking “Browse” next 
to “Output point vector layer.” Save the file as “NY_Treelop_temp” with the extension of a GeoPackage file 
(.gpkg). Again, GeoPackage files are in a standard, non-proprietary file format that is compatible QGIS, but 
may not be readable by other GIS software. Here, we will use it only for this step. Click “OK.” Once the new 
layer has shown up on the Layers panel, click “Close” to close the dialogue box. 
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b. Open the Attribute Table of “NY_Treelop_temp.” Examine the values of Mean Annual Temperature 
(“NY_bio_1” column) for each locality of a Treelop sighting. Tip: You can sort the values in ascending or 
descending order by clicking on the field (column) header.
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3. To determine what is the Treelop’s preferred temperature range, we are only interested in the minimum and 
maximum mean annual temperatures observed for Treelopi. Sort the observed mean annual temperatures 
by clicking on the header in the Attribute Table. Click once to sort by the lowest mean annual temperature 
associated with a Treelop sighting and click the header again to see the highest mean annual temperature for 
a Treelop sighting. Our assumption is that areas outside of this range of temperature values are not suitable 
for Treelop.  

a. Record the values. Round the minimum value down to the nearest full degree Celsius. Round the maximum 
value up to the nearest full degree Celsius. We will round down and up to ensure that all sighting points 
are included within the range while also erring toward a conservative estimate of suitable areas. 

b. We assume that only areas within this range are suitable for Treelopi; areas where we should be focusing 
our efforts. We will remove what we assume to be the unsuitable areas from the map by setting values 
below the minimum and above the maximum temperatures where we have Treelop occurrences to “nodata” 
(meaning there is no data associated with areas outside this range of mean temperatures). The rest of the 
values (within the minimum and maximum range) will be set to “1” to denote that it is “suitable.” This will 
leave all of the geographic areas with suitable temperature on the map, while removing areas not within 
the suitable temperature range.  

c. Using the Raster Calculator: Using a logic string and minimum and maximum values you observed in the 
Attribute Table from the step above, you will create a raster showing all areas of New York State that have 
suitable (1) and unsuitable (0) temperatures (a binary raster mask). Open the Raster Calculator by going 
to Raster > Raster Calculator. Enter in the formula below in the “Raster Calculator Expression” field, with 
“low” being the recorded minimum mean annual temperature and “high” being the maximum. DO NOT type 
in symbols; use the operator buttons and the items under “Raster Bands” whenever possible.  
(NY_bio_1@1 > low)*NY_bio_1@1 AND (NY_bio_1@1 < high)*NY_bio_1@1 
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d. Click the ellipsis button next to the “Output layer” field to select your working directory and name this file 
“NY_bio_1_suitable” and click “Save.” 

e. In the “Raster Calculator” dialogue box, make sure the “Output format” is in .tif format (“GeoTIFF”). Note: 
after filling out the expression, “Expression valid” should appear in bottom left corner of the calculator. If 
“Expression invalid” appears, you will not be able to perform the calculation. Click “OK” and view the areas 
of New York State that have unsuitable temperatures for Treelop (in black).

4. We now have, what we assume to be, the temperature-appropriate areas for Treelopi in raster format. The rest 
of our data (i.e., land cover, roads), however, are in vector format. To be able to perform the future steps of 
our analysis, we will convert this binary raster—with suitable areas as the value 1 and unsuitable areas as the 
value 0—into a shapefile (specifically into a polygon5, which is a vector data type). Note: we could clip a raster 
by a vector layer and omit these steps, but the computer processing time can be prohibitive, so we will do the 
conversion instead. 
 
For this new polygon, we want to focus on only the suitable areas (denoted by the value 1), therefore, for 
simplicity, we will delete all the areas with a value of 0. After we convert the raster into a polygon, we will 
delete the geometries (rows in the attribute table) showing the value 0 (unsuitable area) and save the edited 
polygon.  

a. Go to Raster > Conversion > Polygonize (Raster to Vector). Input the “NY_bio_1_suitable” layer for 
“Input layer.” Next to “Vectorized,” click the ellipsis button, “Save to File,” set file directory and name it 
“NY_bio_1_suitable_polygon.” Be sure to switch the file extension to a shapefile (.shp file) rather than a 
geopackage (.gpkg file). Click “Save” and then click “Run.”
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b. The layer will draw to your map and be automatically given the named “Vectorized” in the Layers panel. 
Rename it to match the file name (“NY_bio_1_suitable_polygon”). 

c. You will notice that this polygon does not look like the original raster of suitable areas. To fix this, delete 
polygons that are not equal to 1. Click on the polygon layer “NY_bio_1_suitable_polygon,” and view its 
Attribute Table. Click “Toggle editing mode.” Click on the “DN” field (column) header to sort. Select all rows 
with a DN value not equal to 1. Click “Delete selected features” to delete these entries. Click “Toggle editing 
mode” again, and save changes. 

d. It is not uncommon for GIS to have some issues when going through analyses (especially conversions). 
In this case, the software encounters a problem with the process of drawing the polygons that are on the 
edges and some of them are, therefore, considered “invalid.” There is a fix to this issue, which is forcing the 
software to redraw the polygons. To do this, we will make a new layer that takes the polygon and buffers 
the geometries by 0 (meaning no addition or subtraction). This will redraw the polygon with no invalid 
geometries.  

i. Go to the “Toolbox” on the right-hand side of the screen or alternatively go to Processing > Toolbox. 
In the search bar, type in “buffer” and under “Vector geoprocessing,” click on “Buffer vectors.” Select 
the correct “Input layer” (“NY_bio_1_suitable_polygon”), and set “Buffer distance” as 0. Save as a 
shapefile named “NY_bio_1_suitable_polygon_valid” by clicking on the ellipses next to “Buffer.” Click 
“Run.”

ii. Close the dialogue and rename the new layer “Buffer” to match the file name (“NY_bio_1_suitable_
polygon_valid”).

SAVE the project
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4.2 Analyze the Habitat Data
In the previous steps, we created a shapefile (vector format) layer of all the areas in New York State that have 
suitable temperature ranges for Treelopi. We also know, from the few natural history studies of this species, that 
Treelopi also prefer certain kinds of habitats. In this next step, we extract only those areas from our land cover 
layer that are preferred and create a new shapefile. To do so, we will use logical operators and expressions to 
select attributes that match what we know about Treelopi. Logical operators such as “and,” “or,” “not,” or “equal to” 
can be used to select attributed that fulfill our needs.

1. Navigate to the Attribute Table of the land cover layer, “NY_landcover.” Explore the Attribute Table, especially 
the column labeled “LUTEXT” (stands for “Land Use Text”). This column shows land cover type for each 
geometery (polygon feature) in New York State. Given what we know about Treelopi (e.g., prefer forested 
areas), which land cover types do you think we should include?

2. Click the “Select features using an expression” icon. Considering that Treelopi prefer natural areas (non-
agricultural lands), are forest generalists, and are often associated with woody vegetation, write an expression 
using “OR” that satisfies the conditions where the field “LUTEXT” is either “Deciduous forest land,” “Evergreen 
forest land,” “Forested wetland,” “Mixed forest land,” or “Shrub and brush rangeland.” Remember to use the 
search bar in the middle panel of the dialogue box to select your column of interest (double-click), use the 
search bar and “All Unique” button to select your variable of interest for that field, and use the expression 
buttons above the “Expression” box while writing your expression. Click “Select features.” Click “Close” to close 
the dialogue box. Notice these features are now selected on the map of land cover.

3. To create a new shapefile from this new selection, right-click on the “NY_landcover” layer in the Layers panel 
and select “Export,” then “Save Selected Features As.” Export as a new shapefile named “Treelop_preferable_
landcover” (be sure to save in your working directory). Note: Often in QGIS, processes have more than one 
solution. Exporting selected features in this way will result in the same outcome as deleting features that are 
NOT of interest (as in step 4.1.4). 
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What are some ways this important alternative might be useful to know?

SAVE the project

4.3 Analyze the Road Data
We often use latitude and longitude, a 3-dimensional spherical coordinate system, to define the location of points 
on the Earth (which is an oblate spheroid), but in many cases we transform, or project, these coordinates into 
a 2-dimensional grid so it is easier to process. QGIS uses a Coordinate Reference System (CRS)6 to define the 
coordinate system used for each layer. For cases when you display layers that have a different CRS than the one 
defined for your QGIS project, those layers will be “projected on the fly” to transform them so they overlay with 
the other layers in your project. For visualization, on the fly projections are quite helpful, but if you are going to 
do analyses—like measuring areas or distances between objects—it is better for you to choose an appropriate CRS 
that preserves spatial qualities such as shape, area, direction, and distance to meet the needs of your project.

In the following steps, you will convert the data into a CRS that preserves area because we will need to measure 
area in future steps. Because there are many Coordinate Reference Systems to choose from, we will tell you 
which CRS is best applicable to the data we have in the region we are studying. For more information about 
CRS, consider reviewing the Coordinate Reference Systems chapter of “A Gentle Introduction to GIS” (docs.qgis.
org/3.4/en/docs/gentle_gis_introduction/index.html).

1. First, we will need to convert your project from a spherical model (3-dimensional) to a planar model 
(2-dimensional). The Universal Transverse Mercator (UTM)7 projection is a planar model measured in meters, 
and QGIS will automatically convert the units. 

a. Go to Project > Properties. Navigate to the “CRS” tab in this window. In the “Filter” search field, type 
“NAD83 /” and then under “Coordinate reference systems of the world,” select “NAD83 / UTM zone 18N 
EPSG:26918” and then click “OK.”  
Note: NAD83 / UTM zone 18N stands for the North American Datum 1983 and Universal Transverse 
Mercator zone 18 North. See the region it covers in the small map on the right of the dialogue box.

Reflection

https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/index.html
https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/index.html
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Consider: We know that a Treelop is a shy, reclusive creature. What are some characteristics of roads that would 
make the area around them unsuitable? 

For this analysis, we have data for the locations of major roads and can use those data to narrow down our 
potential survey locations by omitting sub-optimal areas. We chose a 3 km distance from roads because other 
(fictional) studies on this species showed that the negative effects of roads extended into natural areas up to that 
distance. Note: Although Treelopi are not likely to be near busy roads, they have been observed near these roads 
(although rarely). If you were doing a similar analysis on your own question, you may similarly find references or 
expert opinion on what distance threshold to use.  

2. In GIS, a common tool to create an area that surrounds a feature (e.g., road) by a certain distance is to create 
a buffer. To do this for our analysis, we will start by making a new polygon layer showing a 3 km buffer around 
the roads layer.  
 
Consider: How is this step different from the previous ones (how is the data different)?

a. First, because we will be doing analysis that requires measurement of distance in km, we will need 
to project the “NY_roads” layer to the same CRS that we set to the project before. In the “Toolbox” 
(Processing > Toolbox), type in “project” and under “Vector general,” double-click on “Reproject layer.” 
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Add “NY_roads” as the “Input layer” and the same CRS above (“NAD83 / UTM zone 18N EPSG:26918”) for 
“Target CRS.” Under “Reprojected,” save this layer as a shapefile named “NY_roads_NAD83_UTM18N” in 
your working directory. Hit “Run,” and then rename the layer in the Layers panel to match the file name.

b. To buffer the new “NY_roads_NAD83_UTM18N” layer, navigate to Vector > Geoprocessing Tools > Buffer. 
Read the right sidebar to learn more about the “buffer” function. Select the correct “Input layer,” and 
under “Distance,” select 3, and make sure the unit next to the distance text box is “kilometers,” Under 
“Segments,” select 1. Under “Buffered,” save this as a shapefile named “NY_roads_buffered,” hit “Run,” and 
rename the new layer to match the file name in the Layers panel.

4.4. Identify the Areas Where the Layers Overlap
1. Take some time to clean up your Layers panel. Drag the “NY_roads_buffered,” “Treelop_preferable_

landcover,” and “NY_bio_1_suitable_polygon_valid” to the top of the Layers panel.

We now have our discrete data layers, each adapted to reflect where Treelopi might appear or not based on what 
we know about their behavior and needs. Our next step in our analysis, then, would be to see how all of these 
data combined can help us create a map of potential hotspots where Treelopi might be found: areas of New York 

SAVE the project
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State that have suitable temperature, adequate land cover types, and are far enough from roads. For each of 
the steps below, be sure to read the description of the tool, which will appear on the right side panel within the 
dialogue box.

2. Calculate the intersection between the suitable land cover and suitable temperatures. Go to Vector > 
Geoprocessing Tools > Intersection. As the “Input layer,” use the vector of suitable temperature (“NY_
bio_1_suitable_polygon_valid”), and set the “Overlay layer” as preferable land cover (“Treelop_preferable_
landcover”). Under “Intersection,” select your working directory and save as a shapefile named “LC_temp_
intersection.” Click “Save” and then click “Run.” 
 
Close the dialogue box and rename the “Intersection” layer to match the file name.

SAVE the project

3. Remove areas near roads using the “Difference” tool. Go to Vector > Geoprocessing Tools > Difference. Use 
the “LC_temp_intersection” layer as the “Input layer,” and use the “NY_roads_buffered” as the “Overlay 
layer.” Under “Difference,” save as a shapefile named “LC_temp_roads_difference” in your working directory. 
Remember to rename the layer in the Layers panel.

SAVE the project

If you look at the Attribute Table of this layer, you’ll notice that all of the original landscape geometries remain. 
We are interested in the total suitable area in New York State, so we need to dissolve these geometries into one. 
Go to Vector >  Geoprocessing Tools > Dissolve. Read the right sidebar to learn more about the “dissolve” function. 
Use the most recent layer (“LC_temp_roads_difference”) as the “Input layer.” Under “Dissolved,” save this layer 
as a shapefile “Treelop_habitat_NY” in the working directory. Click “Save” and then click “Run.” This process will 
take a few minutes. Once complete, rename the layer and check the Attribute Table; there should only be one row. 
Please note that the attribute table for this output will show data from the first row only and does not represent 
the attributes of the layer anymore. 

4. Your instructor may ask you to take a screenshot of the map of your “Dissolved” Layer (all other layers not 
selected) or to make a printable map (one with a title, scale bar, legend, compass arrow, data source, author, 
date, etc.). These steps are not included here but may be provided by your instructor. 

SAVE the project

PART 5: APPLY YOUR UNDERSTANDING OF THE RESULTS TO A CONSERVATION QUESTION
5.1 Consider Your Results and the Data

You have completed a preliminary map from your analysis. Congratulations! Now, let’s think through what this 
map means for your assignment to prioritize where the small non-profit conservation organization should survey 
for Treelopi in New York State.

• If the organization was going to survey all of the land on this map, how many square kilometers would they 
have to survey?

 
To calculate the area of habitable land in New York State, open the Attribute Table of “Treelop_habitat_NY.” 
Click on the “Toggle editing mode” to make the layer editable. Then, click “Open field calculator.” Create a 
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new field with “Output field name” as “area_sqkm.” The expression for calculating the area of every row in an 
attribute table is simple: under the Search text box, select Geometry-> $area. However, this will calculate the 
area in map units. Since we are using the Universal Transverse Mercator projection, the units are currently in 
meters. Since we want kilometers, we need to multiply the area by 0.000001. This will show the total area (in 
km2) of habitable land in New York State that is suitable for Treelopi.

• What is the total area of our estimated “optimal” habitable land for Treelopi? 

• Examine the results of your analysis (i.e., map and calculated area). What do you think some limitations would 
be for surveying for Treelopi?

• Given these limitaitons, would you feel comfortable recommending a priority area to survey? Why or why not? 

• What do you think are some ways to further narrow down priority areas for surveys? Go back to your response 
to Question 1. Were there data types listed there that might help you? What else would you like to know that 
could alter your priority areas for surveys?

• Based on the assumption that all of the habitat on your map is suitable and your understanding that this 
species is considered rare, do you think that Treelopi are limited by suitable habitat? Hypothesize what else 
might be limiting their numbers.

• A brand-new study is published on Treelopi. The results suggest that Treelopi need large contiguous habitat 
(at least 20 sq km) for breeding. How can we use this new information to better understand their suitable 
habitats? Explain how you might further refine your map through spatial analysis to incorporate this 
information. (Do not list step by step instructions of how you would accomplish this with the software rather a 
summary of what those steps would accomplish.)

• Have you considered the limitations of the provided data? Let’s review the data listed in Table 1.

Political boundaries are mainly stable and because we are focused on New York State, this data doesn’t appear 
to have a limitation but rather defines our scope. 

Temperature data in this exercise is only provided as mean annual temperature. How might mean annual 
temperature mask variation in temperatures throughout the year? What other measures of temperature (or 
other climate variables) might be important? Why?

If you navigated to the source of the data (worldclim.org), you’d see that the mean annual temperature is 
calculated from a 30-year period (from 1970–2000). What might have changed since then? (Note: averages for 
climate data are normally obtained by looking at a 30-year interval of years.)

Likewise, if you look at the metadata associated with the land use/land cover dataset, you’d notice that it 
is from 1990. How might things have changed in the past ~30 years? How could updated data source help 
narrow down your survey area? (Note: up to date data layers may or may not be available. Sometimes more 
recent data are only available after a fee is paid. Depending on your project needs and budget, it might be 
worthwhile to spend money on more up to date datasets.)

Roads data is updated to 2018, but only contains Interstates, State, and Federal roads. If you thought that 
Treelopi were averse to all types of roads, you might want to find a data source that included county, town, and 
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private roads.

Treelopi sightings data has no metadata associated with it. Unfortunately, it is common that some data sources 
will not provide helpful information beyond the spatial information (e.g., only GPS coordinates). What sort of 
data do you wish you knew about these sightings? How would it be helpful for supporting your analysis and 
recommendations?

5.2 Reporting Back to the Conservation Organization
Based on your work and responses above, write out a brief overview of what you did to get the preliminary map 
(don’t list steps, rather summarize the final output). Explain your recommendation for where to do surveys, and/
or what other steps should happen before a final survey recommendation is set.

Glossary terms are derived from: QGIS Development Team. 2019. QGIS Geographic Information System. Open 
Source Geospatial Foundation Project qgis.osgeo.org. See “A Gentle Introduction to GIS” docs.qgis.org/3.4/en/
docs/gentle_gis_introduction/ for more helpful background information.

1. Vector: a type of spatial data made up of vertices and paths which uses geometry to represent real-world 
features in GIS. Vector data are presented as points, lines, and polygons (areas).

2. Raster: a type of spatial data made up of grids of pixels (cells), often used for data that is continuous across 
an area and cannot easily be divided into vector features, e.g., the backdrop behind vector data. 

3. Geometries: points, lines, and polygons that represent a spatial feature.
4. Expression: a way to manipulate attribute value, geometry, and variables in QGIS to perform functions like 

changing the geometry style, the position of the label, the height of a layout item, etc.
5. Polygon: a closed-shape vector object defined by X and Y coordinate pairs. 
6. Coordinate Reference System (CRS): uses coordinates to define how a two-dimensional GIS map is related 

to real places on the three-dimensional earth. Deciding on which map projection and CRS to use depends on 
many factors, including the regional extent of the area you want to work in, the analysis you want to do, and 
the availability of data.

7. Universal Transverse Mercator (UTM): a global map projection which assigns coordinates to locations on 
the surface of the Earth. The UTM CRS divides the globe into 60 equal zones (numbered 1 to 60) starting at 
the international date line. Each 6 degrees wide in longitude. Each zone is further divided into zones north 
and south of the equator. 

GLOSSARY

http://qgis.osgeo.org
https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/
https://docs.qgis.org/3.4/en/docs/gentle_gis_introduction/
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